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Welcome to This Guide

This guide describes how you set up My BAC so that users can view

HP Business Availability Center reports, external feeds, and customized
Service Reports based on data from data sources from different applications,
as portlets in their own personalized portals.

This chapter includes:

» How This Guide Is Organized on page 7
» Who Should Read This Guide on page 8

> Getting More Information on page 8

How This Guide Is Organized

Part |

Part Il

The guide contains the following parts:

My BAC

Describes how to define modules of portlets that can be accessed by your
users through their My BAC portal, how to import and export the portlets
that are included in the modules, and how a user can personalize and use
the My BAC portal.

Service Report

Describes how to create custom reports that display selected data from the
data sources of Service Level Management, Dashboard, or other
applications, as a Service Report portlet in My BAC or as a report in Report
Manager.



Welcome to This Guide

Who Should Read This Guide

This guide is intended for the following users of HP Business Availability
Center:

» HP Business Availability Center administrators
» HP Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using
enterprise applications, and be familiar with HP Business Availability Center
and enterprise monitoring and management concepts.

Getting More Information

For a complete list of all online documentation included with HP Business
Availability Center, additional online resources, information on acquiring
documentation updates, and typographical conventions used in this guide,
see the the HP Business Availability Center Deployment Guide PDF.
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My BAC

This chapter includes the main concepts, tasks, and reference information
for My BAC.
This chapter includes:
Concepts
» My BAC Portal Overview on page 12
» My BAC Administration on page 13
» My BAC Application on page 14
» Java and WSRP Portlets on page 14
» Module/Page Tree on page 16
» Default Module on page 17
Tasks
» Administrator Tasks — Workflow on page 19
» Set Up a Module on page 23
» Set Up CMDB Portlets on page 30
» Use a Non-Authenticated or an Authenticated WSRP URL on page 32
» Deploy External Custom Java Portlets on page 33
» Personalize Your My BAC Portal — Workflow on page 39
» Use an HTML Portlet on page 43
Reference
» My BAC User Interface on page 44

Troubleshooting and Limitations on page 124

11
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& My BAC Portal Overview

12

The My BAC portal is a view into HP Business Availability Center. The portal
includes pages and portlets.

Portlets are reusable Web components that display relevant information to
portal users. Pages are collections of several portlets displayed together.

Portlets display information relevant to users’ business tasks, for example,
HP Business Availability Center reports, stock market prices, and more.
Portlets can display reports or views from Dashboard, Service Level
Management, SOA, End User Management, System Availability
Management, UCMDB, HP Business Process Insight, and

HP TransactionVision applications, and general portlets like RSS, Status
Snapshot, and others.

The My BAC administrator sets up My BAC portals that include reports and
real-time views that are of interest to specific users or groups of users. The
administrator creates modules, adds pages and portlets to the modules, and
shares the modules with selected users or security groups. Modules are
packages of preconfigured pages that display portlets.

Users can only view modules, pages, and portlets to which the administrator
has given them access rights. Users can also personalize their own portal by
adding pages to the portal, adding portlets to pages, removing pages or
portlets, rearranging existing pages and portlets, setting an automatic page
rotation, and editing a portlet preferences to filter what is displayed in the
portlet. Users can also, in some of the portlets, use context menu options to
drill down to other reports. For details on the context menu options
available for each portlet, see the documentation for each portlet. For
details, see “Select Portlets to Add Area” on page 46.

My BAC displays the user’s main portal page either when the user logs in to
HP Business Availability Center or when the user clicks the My BAC tab. This
is the page that the My BAC administrator has set up for the user. You can
change the default page for a specific user by clicking SITE MAP > Change
the Default Page > Personal Settings > Menu Customization.
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HP Business Availability Center includes portlets written and supported by
HP. In addition, My BAC administrators and advanced users at customer
sites can write their own portlets (Service Report and Status Snapshot).
Portlets written by industry-standard portlet providers can be imported into
the system, provided they use the JSR168 standard.

& My BAC Administration
To access the My BAC administration pages, select Admin > My BAC.
My BAC administration includes the following tabs:

» Manage Modules. From this tab, you can:

» Create Modules. You create modules, their pages, and the portlets in the
pages. You can give sharing access to those modules, add comments, and
edit the portlets and their layouts. For details, see “Create Module Page”
on page 66.

» Configure Modules. You can search for a module you want to modify or
configure a module you created. For details, see “Configure Modules
Dialog Box” on page 50.

» Manage Portlet Definitions. From this tab, you can:

> Import Portlet Definition. You import portlet definitions so that the
portlets are available for inclusion in a page. For details, see “Import
Portlet Definition Wizard” on page 87.

» Configure Portlet Definition. You can edit, copy, or delete portlet
definitions. For details, see “Configure Portlet Definitions Dialog Box” on
page 59.

> Export Portlets and Modules. You can export portlet definitions and
modules for importing into another HP Business Availability Center
instance. For details, see “Export My BAC Objects Dialog Box” on
page 84.

13
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> Import Portlets and Modules. You can import portlet definitions and
modules, for example, when moving data from a test to a production
environment. For details, see “Import My BAC Objects Dialog Box” on
page 86.

» Create WSRP URL. You can create a WSRP URL when you want to export
portlets from My BAC to a remote portal. For details, see “Create WSRP
URL Dialog Box” on page 67.

& My BAC Application

To access the My BAC application pages, select My BAC in the main
navigation bar.

My BAC application displays the pages set up for you by the Administrator.
The application enables you view the contents of the page portlets. You can
also add pages and portlets, and personalize custom pages. For details, see
“My BAC Page” on page 98.

& Java and WSRP Portlets

14

You can import Java and WSRP portlets:

Java Portlets. Java portlets are portlets written in Java and imported into
My BAC. Java portlets include a portlet definition file and Java code.

WSRP Portlets. Web Services for Remote Portlets (WSRP) are defined by a
producer Web service. HP Business Availability Center can consume WSRP
portlets from multiple sources:

» Imported portlets using the WSRP producer URL. When you use such
portlets, make sure the producer Web URL is available.

» Imported portlets from portals supported by HP (for example,
WebSphere, WebLogic, and HP products). When you use such portlets,
ensure that HP Business Availability Center is running before you access
the HP Business Availability Center WSRP portlets.
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In addition, you can export WSRP portlets to other HP products. Export to
third-party portals is limited to certain environments. For more
information, see
http://h20230.www2.hp.com/selfsolve/document/KM202754.

Portlet Definitions

My BAC supports JSR 168 and WSRP standards-compliant portlets. This
support is based on the Apache Reference implementations of two
specifications: Pluto and WSRP4]J. However, the specifications may not be
complete in all areas or may be open to interpretation. HP has made design
decisions to cover these areas.

JSR 168 represents the Java Portlet Specification V1.0 that was developed
under the Java Community Process. The Java Portlet Specification defines a
contract between the portlet container and portlets and provides a
programming model for portlet developers.

Web Services for Remote Portlets (WSRP) is a standard for content
aggregators, such as Web portals, to access and display content sources
(portlets) that are hosted on a remote server. WSRP is a protocol designed for
accessing remote Portlets in a standard manner. The WSRP specification
defines a web-service interface for interacting with interactive presentation-
oriented web services.

WSRP portlets include a portlet definition file (in XML format) referencing
the HTTP location of the WSRP portlet. Portlet definitions are XML files that
define the look and feel of a portlet. Portlet definitions include such
information as the type of portlet, user and security group access rights to
the portlet, and filter definitions.

15
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& Module/Page Tree

16

In My BAC Admin, the tree of modules displays the modules, pages, and
portlets created by the administrator in the Shared Pages pane, and your
private pages and portlets in the Private Pages pane. All the pages that you
see in both panes of the tree of pages are listed in the Switch to Page menu
in My BAC.

The administrator uses the module tree to:

» Configure modules and pages
» Optionally, add user-defined pages to the modules
» Add portlets to pages

For details about the tree of modules, see “Configure <module_name> Page”
on page 52.

The user uses the page tree to:

Create private pages and add portlets to those pages, in the Private Pages
pane.

Copy modules or pages from the Shared Pages pane where the administrator
module pages are displayed, to the Private Pages pane and edit them,
depending on the type of access specified by the administrator.

Create groups of pages in the Private Pages pane.

You can edit any element in the module or page tree by double-clicking it.
You can use the buttons above the tree to add modules, pages, or portlets,
clone modules or pages, and more.

For details about the tree of pages, see “Edit Page Dialog Box” on page 71.

Note: If you have permission to display a portlet, and the portlet is included
in a page or module for which you do not have permission, you can still
display the portlet in the page or module. Other portlets on the page or
module display an error message.
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My BAC provides a default out-of-the-box module and a UCMDB default

module.

Default Module

The default module includes the following pages and portlets:

Page Portlets
Dashboard » Top View
» Filters

» Welcome to My BAC Applet

Dashboard Reports

» KPIs Trend
» KPIs Summary
» KPIs Distribution Over Time

Service Level Management

» Worst Performing SLAs - Previous Periods Portlets
» Worst Performing SLAs - Current Periods Portlets

End User Management

» End User - Least Available Locations
» End User - Least Available Transactions

Business Processes

» Business Process Summary Portlet

» Top View with the Business Processes view
automatically selected

» Dashboard Status Snapshot with the Business
Processes view automatically selected. The
administrator must specify the CIs to display in
the portlet or you can copy the portlet to your
private pages and edit it.

17
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Page Portlets

Business Transactions » Business Transaction Summary Portlet

» Top View with the Business Transactions view
automatically selected

» Dashboard Status Snapshot with the Business
Transactions view automatically selected. The
administrator must specify the CIs to display in
the portlet or you can copy the portlet to your
private pages and edit it.

SOA » Web Service/Operation With Slowest Number of
Calls

» Slowest Web Service/Operation

» Least Active Web Service/Operation

» Least Available Web Service/Operation

» Most Active Web Service/Operation

» Web Service/Operation With Most SOAP Faults

UCMDB Default Module
The UCMDB default module that includes the following pages and portlets:

Page Portlets

CMDB » CMDB Utilization
» Delete Candidates

» Discovery Job Statistics Report

» Discovery Job Errors Report

» Host O/S Breakdown

» Database Breakdown

» Major Application Type Breakdown
» Network Device Breakdown

Change » Number of Changes
» Changed View
» Changed Applications

For more details about the portlets, see “Portlet Categories” on page 103.

18
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Note: A user cannot edit the Default Module and the default UCMDB
module in My BAC. A user with administrative permissions can edit the
default modules in My BAC Administration.

* Administrator Tasks - Workflow

Y Y Y Y Y Y Y Y

Y Y Y VY Y

This section lists the steps performed by the administrator to create modules
and their page and portlets components, to import or export modules or
portlets, and to manage portlets, pages, and modules.

This task includes the following steps:

“Set Up Licenses” on page 20

“Create a Pre-Authenticated WSRP URLs — Optional” on page 20
“Import Portlet Definitions — Optional” on page 20

“Set Up CMDB Portlets — Optional” on page 20

“Use an Authenticated WSRP URL - Optional” on page 21

“Use an HTML Portlet — Optional” on page 21

“Deploy External Custom Java Portlets — Optional” on page 21

“Use WSRP Portlets on Solaris with an IPlanet Web Server — Optional” on
page 21

“Configure a Portlet Definition — Optional” on page 21
“Manage Portlet Categories — Optional” on page 21
“Set Up a Module — Optional” on page 22

“Export Portlets and Modules — Optional” on page 22
“Change the Status Alert Sound — Optional” on page 23

19
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20

1

>

Set Up Licenses

To access specific data source portlets you must make sure you have the
appropriate licenses. The data sources are: Service Level Management, End
User Management, Dashboard, CMDB, HP Business Process Insight,

HP TransactionVision, and SOA. For details, see “License Management
Overview” in Platform Administration.

Create a Pre-Authenticated WSRP URLs - Optional

You can create a pre-authenticated WSRP URL to access My BAC portlets
from another portal.

For details, see “Create WSRP URL Dialog Box” on page 67.

Import Portlet Definitions - Optional
Import portlet definitions using one of the following methods:

One by one. Use the Import Portlet Definition wizard to select an existing
Java or WSRP portlet, enter portlet information, and configure access to the
portlet.

For details about Java or WSRP portlets, see “Java and WSRP Portlets” on
page 14.

More than one portlet at a time or together with module definitions. You
import portlet definitions and modules in separate files or in one file. You
would probably import a portlet definition or module when upgrading the
HP Business Availability Center version, or when moving data from a test to
a production environment. For details, see “Import My BAC Objects Dialog
Box” on page 86.

For details about importing portlet definitions, see “Import Portlet
Definition Wizard” on page 87.

Set Up CMDB Portlets - Optional

During discovery, HP Business Availability Center maps all IPs in the system.
You can attach physical location attributes (country, state, or city) to these
IPs to enable information to be broken down in the CMDB portlets by
location. For details, see “Set Up CMDB Portlets” on page 30.
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5 Use an Authenticated WSRP URL - Optional

When a consumer wants to use HP Business Availability Center as a
producer for a WSRP portlet, the consumer can use the WSRP URL of the
portlet to access the portlet without authentication or with authentication.
For details, see “Use a Non-Authenticated or an Authenticated WSRP URL”
on page 32.

6 Use an HTML Portlet - Optional

You can use the HTML portlet to enter your own HTML code that you want
to display in a portlet in My BAC. For details, see “Use an HTML Portlet” on
page 43.

7 Deploy External Custom Java Portlets — Optional

You can import Java portlets that comply with the Java Portlet Specification.
For details, see “Deploy External Custom Java Portlets” on page 33.

8 Use WSRP Portlets on Solaris with an IPlanet Web Server -
Optional

If you are using WSRP portlets and HP Business Availability Center is
running on Solaris with an IPlanet Web Server, in the IPlanet obj.contf file
under the line NameTrans fn="assign-name"
from="/<HP_BAC_web_application_context_name (usually
topaz)>/dashboard/*" name=")2FRedirect", add the following line:
NameTrans fn="assign-name" from="/dashboard/*" name="J2FRedirect"

9 Configure a Portlet Definition - Optional

After you import a portlet definition, you can edit the portlet definition and
its access type. For details, see “Configure Portlet Definitions Dialog Box” on
page 59.

10 Manage Portlet Categories - Optional

During the procedures for importing or configuring a portlet definition, you
select portlet categories that enable users to more easily find a specific
portlet to add to their portal. My BAC has pre-defined categories. You can
add, remove, or change the name of user-defined categories. For details, see
“Manage Categories Dialog Box” on page 95.

21
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11

Set Up a Module - Optional
Setting up a module includes:

» Creating users and groups.

» Creating a module (a module includes pages that contain portlets).

» Sharing the module to make it available for copy and personalization, to the

allowed users (if the module is not shared, the allowed users view the
module in read-only mode).

Add pages and portlets to the pages.

» Import user-defined pages.

12

Note: My BAC has two default modules. For details, see “Default Module”
on page 17.

For details about setting up a module, see “Set Up a Module” on page 23.

Export Portlets and Modules - Optional

You can export one or more portlets and one or more modules in one file, or
you can export each portlet or module separately in its own file. You can
then save the resulting XML files and import them into another HP Business
Availability Center instance. You would probably export a portlet definition
or module when upgrading the HP Business Availability Center version, or
when moving data from a test to a production environment.

For details on exporting objects, see “Export My BAC Objects Dialog Box”
on page 84.
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13 Change the Status Alert Sound - Optional

If you want to use a different alert sound and you are a user with
administrative permissions, access <HP Business Availability Center server
root directory>\AppServer\webapps\site.war\bam\

pages\sounds and replace the ding.wav file with your own WAV file (you
must rename your file ding.wav).

The change takes effect immediately.

P Set Up a Module

Y Y Y Y Y Y Y VY VY Y

Setting up a module includes creating users and groups, creating a module (a
module includes pages that contain portlets), sharing the module to make it
available for copy and personalization to the allowed users (if the module is
not shared, the allowed users view the module in read-only mode), add
pages and portlets to the pages, and import user-defined pages.

This task includes the following steps:

“Create Users and Groups” on page 24

“Create a Module” on page 24

“Configure Access to the Module” on page 27

“Add Pages or User Pages to a Module” on page 27
“Change the Order of the Pages in a Module” on page 28
“Add Portlets to a Page” on page 28

“Edit/Customize a Portlet” on page 29

“Customize the Portlets in a Page” on page 29

“Filter a Portlet Display” on page 30

“Modify the Display Refresh Rate” on page 30

23
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1 Create Users and Groups

Create the users and groups that use My BAC. For details, see “User
Management — Overview” in Platform Administration.

2 Create a Module

You create a module by:

» Creating a new module. Define it by giving it a name and a description, and
specifying if it is enabled or disabled. For details, see “Configure
<module_name> Page” on page 52.

» Cloning an existing module. You clone a module from the module tree.

Cloning a module saves time when you want to create slightly different
modules. For example, you want to have a module present specific
information for the past week and another module present the same
information for the last month. You would create the module with the
portlets presenting the information for the past week, then clone the
module, and for each portlet, redefine the time period to the past month.
For details, see “Edit Page Dialog Box” on page 71.

24
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Example - Create a New Module

This example shows how to create a new module, enter administrator’s
comments, and select the type of access to the module.

a Access the Configure: New Module screen and enter information as
follows:

Configure: New Module

Save

@ Header
Created By:  adminiztrator

Last Modified By:  adminiztrator  Last Modification Date: Dec 23, 2006

*Module Hame: ITra\’e' Agent

Description: ICrea{ed for the Travel Agent

Enabled: (% ves " No

@ Administrator Comments

Comments enables the administrator to share information about changes in the module with the module recipients.

Thiz is the main travel agent module | ;I ¥iew Comments
=

Add Comment:

@ Configure Access

Save

b Expand Configure Access and select Allow access to all users in the User
Access area.

@ Configure Access

User Access
The follovving usersizecurity-groups will have read-only access to thiz module

W Allowy access to all users

Mo Users

IUser LII

[~ Enable users to copy this module pages to their private dashiboard

25
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¢ Click Save.

The result is as follows:

Gl x| o] ol=| || ‘
Successfully Saved at 12:11:30 &M PST
=F Madules Configure: Travel Agent
l_D ravel Agen

1__1 Mew Page

(& Header
Created By:  administrator

Last Modified By: administrator  Last Modification Date: Dec 24, 2006

*Module Hame: |Trave| Agert

Description: |Created for the Travel Agent

Enabled: (% ves Mo

@ Administrator Comments

@ Configure Access

d You can now add/modify comments or configure/modify access to the
module. For details, see “Configure Access to the Module” on page 27.

Example - Clone a Module
For example, you created the Travel Agent module and you want to create a
clone of the module.

a In the Modules tree, select the Travel Agent module, and click the Clone
0=0 button.

=FH O modules
I
—HO e
l__1 Mew Page

b The Modules tree displays the cloned module.

“FH O Modules
I
—HO A
l__1 Mew Page

+H Copy of Travel Agent

26
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3 Configure Access to the Module
After you create a module, you must configure it. To configure a module:

» Add comments (optional).

» Specify the type of access: read-only, modity, or self-service.

For details about configuring the module, see “Configure <module_name>
Page” on page 52.

4 Add Pages or User Pages to a Module
You can add blank pages or user pages to a module.

For details about adding an existing page to a module, see “Edit Page Dialog
Box"” on page 71.

For details about adding a user page to a module, see “Add a User’s Pages to
Module Dialog Box” on page 47.

Example - Editing a Page
This example shows how to edit a page that is added in the module creation
process.

a Right-click New Page and select Edit.

“H I Modules

L

“FH D Travel Agent
0

+H Copy of

X

Delata

P

Copy

Paste

Edit

View

Up

« » 8 3@

Down

27
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b Enter the name of the page.

Edit page

Mote: The number of portlets per page is limited to 6.

*Page Name: ICruise 1]

- Automatically refresh this page every I minutes

Add PorHets

¢ You can then add portlets to the page. For details, see “Add Portlets to
<page_name>/Add Portlets Dialog Box” on page 45.

5 Change the Order of the Pages in a Module

You can change the order of the pages in a module from the Modules tree.
For details, see “Edit Page Dialog Box” on page 71.

6 Add Portlets to a Page

You can add portlets to a page you are creating or to an existing page. For
details, see “Add Portlets to <page_name>/Add Portlets Dialog Box” on
page 45.

Note: If a portlet is added to a page, and is then disabled, the portlet is
removed from the page. If you re-enable the portlet it remains removed
from the page and you must add it again to the page.

» Set Up CMDB Portlets

Before you add a CMDB portlet to a page you must set it up by adding the IP
addresses to a file listing the latitudes and longitudes of all countries. For
details on setting up CMDB portlets, see “Set Up CMDB Portlets” on

page 30.
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Add an RSS Portlet to a Page

Adding an RSS portlet to a page is done using a different procedure. For
details on setting up RSS portlets, see “RSS Area” on page 83.

Edit/Customize a Portlet
You can:

Change the portlet’s name.

Modify the portlet category.

Define the portlet display (narrow or wide).
Specify if the portlet is enabled or not.
Specify the portlet’s type of access.

For details, see “Configure Portlet Definitions Dialog Box” on page 59.

Customize the Portlets in a Page

You can customize the appearance of the portlets in a page. You can:

Change the default number (6) of portlets that can be assigned to a page.
Select Admin > Platform > Setup and Maintenance > Infrastructure Settings,
click Applications, select My BAC, locate the Maximum Number of Portlets
Per Page entry in the My BAC - My BAC table, and set the new maximum
number of portlets. System performance might be affected if this value is
larger than six. This setting is defined per HP Software-as-a-Service customer.

Standardize the height of portlets per customer. Select Admin > Platform >
Setup and Maintenance > Infrastructure Settings, click Applications, select
My BAC, locate the Maximum height in pixels entry in the My BAC - My
BAC table, and set the maximum height (in pixels) for the portlet. The
minimum recommended height for a portlet is 300 pixels. If you do not
specify a value (default), each portlet uses the height that it needs.
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9

10

Filter a Portlet Display

Depending on the type of portlet, you can select the type of information
displayed in the portlet; for example, select a view, and specific CIs and Key
Performance Indicator (KPIs). You can also select the type of display you
want to use for the portlet; for example, displaying the View as Graph tab or
the View as Table tab.

For details, see “Edit Preferences <portlet_name> Dialog Box” on page 75.

Modify the Display Refresh Rate

If you want to modify the default display refresh rate (30 seconds), select
Admin > Platform > Setup and Maintenance > Infrastructure Settings,
choose Applications, select Dashboard Application, and modify the value of
the Ul Refresh Rate entry in the Dashboard Application - Refreshers table.
Note that the change affects all display refresh rates in Dashboard and

My BAC.

The change takes effect immediately.

T Set Up CMDB Portlets

30

During discovery, HP Business Availability Center maps all IPs in the system.
You can attach physical location attributes (country, state, or city) to these
IPs to enable information to be broken down in the CMDB portlets by
location. For example, by linking IP addresses to certain locations, you can
view the distribution across servers for operating systems, applications,
network devices, and databases.

Set up the CMDB portlets by adding the IP addresses to the ip2location.csv
file that lists the latitudes and longitudes of all countries.

For details on discovery, see “Discovery and Dependency Mapping —
Overview” in Discovery and Dependency Mapping Guide.

To attach location attributes to IPs:

Open the following file: <HP Business Availability Center root
directory>mam_lib\ collectors\probeManager\ip2location.csv.
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2 Find the country, state, and city where the IP is located.
3 Add the IP address to the Rangel cell.

You can add IP addresses in three formats:

» Single IP, for example, 192.168.82.100

» IP range, for example, 192.168.82.50-192.168.82.90
» Multi-IP range, for example, 192.168.*.*

You can add more than one IP address to the same location. Add the second
IP address to the Range2 column, the third IP address to Range3, and so on.
See the following figure for examples of ranges linked to locations:

A B[ c ] D | E | F | G
1 |GLO_ID GLO_COUNGLO_STAT GLO_CITY GLO_LATITUDE GLO_LOMGITUDE Rangel
3870 69583 United Kingdam Hereford 52.06 -2.708
3871 7302 United Kingdom Hertford 51,705 -0.078
5703 United Kingdom High “Wycomhbe 51.633 -0,75 192,168.82.*
3873 11485 United Kingdaom Hoddesdon 51.758 -0.022/192.168.82.48
3874 7128 United Kingdom Holyhead £3.31 -4.635 192,168.82.10-192,168.82.90
3875 11150/ United Kinadam Hornchurch E£1.5E56 0.214

Note: You cannot use this file to exclude ranges.

4 Save the file and restart the DDM Probe: close the DDM Probe DOS
command window and restart the DDM Probe (Programs > Business
Availability Center > Administration > DDM Discovery Probe).

Several hosts are running a J2EE application. During discovery, HP Business
Availability Center checks ip2location.csv and finds ranges that cover the
discovered host IP addresses.

HP Business Availability Center updates the country, state, and city
attributes of each host IP CI. This process corresponds to the Group by
process performed in Group by dialog box accessed from the View Node
Definition dialog box in View Manager. For details, see “Group By Dialog
Box"” in Model Management.
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P Use a Non-Authenticated or an Authenticated WSRP URL

32

A consumer can use HP Business Availability Center as a producer for a
WSRP portlet. To access the portlet, the consumer can use the WSRP URL of
the portlet without authentication or with authentication.

If the consumer creates the URL without credentials, when the user accesses
the portlet, the HP Business Availability Center login page is displayed (if
the user has Single Sign On this step is skipped), and then the portlet is
displayed.

If the consumer creates the URL with credentials, when the user accesses the
portlet, he is automatically logged in with the credentials included in the
URL.

Note: If the consumer portal is using LW-SSO (like HP ServiceCenter or
My BAC), use the non-authenticated WSRP URL. For details about LW-SSO,
see “Lightweight Single Sign-On Authentication” in Platform Administration.

This task includes the following steps:

> “Use a Non-Authenticated URL - Optional” on page 32
» “Use an Automatically Authenticated URL — Optional” on page 33

Use a Non-Authenticated URL - Optional

Select Admin > Platform > Users and Permissions, and create a new user in
the Create New User dialog box. Enter the same user name for the consumer
user (in User Name) and for the HP Business Availability Center login (in
Login Name). Passwords are not necessary. Access the WSRP URL page, select
Authenticate with user from WSRP consumer, and click Create. Click Copy
to copy the string where needed. For details, see “Create WSRP URL Dialog
Box” on page 67.
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When the consumer accesses the WSRP portlet, the authentication of the
consumer user name is automatically performed in HP Business Availability
Center using the user specified in the Create New User dialog box. The
consumer is then presented with the HP Business Availability Center login

page.

When using this method, consumer users can login to HP Business
Availability Center as separate users, but each user is presented with the
login page to HP Business Availability Center.

2 Use an Automatically Authenticated URL - Optional

Access the Create WSRP URL page, select Automatically authenticate with
the following credentials, enter the consumer user name in the User Name
box and the password in the Password box, and click Create. The user name
and password are added to the WSRP URL string. Click Copy to copy the
string where needed. For details, see “Create WSRP URL Dialog Box” on
page 67.

After login to the consumer site, the user accesses the WSRP portlet directly
without authentication.

When using this method, the user is not presented with the login page to
HP Business Availability Center, but all users login to HP Business
Availability Center with the same consumer user.

T Deploy External Custom Java Portlets

Note: This section is for advanced users or administrators.

Java portlets that comply with the Java Portlet Specification can be imported
and used in Dashboard. This section describes the processes used to deploy
external Java portlets.
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This task includes the following steps:

“Implement the Portlet” on page 34
“Create a Web Archive for the Portlet” on page 34
“Create the MyPortletClass.class File” on page 35

“Make the portlet-wrapper.jar File Available to your Web Archive” on
page 35

“Add the Portlet Section to the portlet.xml file” on page 35

“Add a Servlet Mapping to Your HP Business Availability Center Descriptor
File: web.xml” on page 37

» “PortletWrapperUtils API” on page 38

> “Import the New Portlet Definition” on page 38

» “Troubleshoot the Deployment of External Custom Java Portlets” on

page 38

Implement the Portlet

Portlets must be coded according to the Java Portlet Specification (JSR 168 -
see_http://www.jcp.org/en/jst/detail?id=168).

Example

You have coded a Java portlet called my.package.MyPortletClass, which is a
subclass of javax.portlet.GenericPortlet.

Create a Web Archive for the Portlet

To separate standard Dashboard/Center code and custom portlet code,
deploy your custom Java portlet in a separate web archive in the new
directory myWebArchive.jar created in the deploy area of the Application
Server for your archive located at:

<HP Business Availability Center root directory>\AppServer\webapps\
site.war\WEB-INF\lib.
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Note: Because myWebArchive.jar is deployed as part of HP Business
Availability Center deployment, it may have an impact on the deployment
of HP Business Availability Center.

Create the MyPortletClass.class File

In the Application Server, create the MyPortletClass.class class in
myWebArchive.jar.

Make the portlet-wrapper.jar File Available to your Web
Archive

For Dashboard to correctly process your portlet, make the
portlet-wrapper.jar file available to your web archive located in the
Dashboard distribution lib directory.

Place any other prepackaged Java libraries needed by your portlet in the
<HP Business Availability Center root directory>\AppServer\webapps\
site.war\WEB-INF\lib subdirectory, along with portlet-wrapper.jar files.

Add the Portlet Section to the portlet.xml file
This descriptor file defines the meta information needed by the portlet
container to run your portlet.

Modify the descriptor file in the
<HP Business Availability Center root directory>\AppServer\webapps\
site.war\WEB-INF\ portlet.xml file.
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Your portlet.xml should have the following structure:

<?xml version="1.0" encoding="UTF-8"?>
<portlet-app
xmins="http://java.sun.com/xml/ns/portlet/portlet-app_1_0.xsd"
version="1.0"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemal.ocation=
"http://java.sun.com/xml/ns/portlet/portlet-app_1_0.xsd
http://java.sun.com/xml/ns/portlet/portlet-app_1_0.xsd">
<portlet>
<I-- Specify a name you use to refer to this portlet. -->
<portlet-name>MyPortlet</portlet-name>
<portlet-class>my.package.MyPortletClass</portlet-class>
<l-- Specify initialization parameters. Insert as many "init-param" tags as needed. -->
<init-param>
<name>param1Name</name>
<value>param1Value</value>
<[init-param>
<l-- Specify how long (seconds) the portlet container should cache this portlet's content. -->
<expiration-cache>0</expiration-cache>
<I-- Specify the modes available for this portlet. Available modes are "VIEW", "EDIT", and "HELP".
"VIEW" mode is not required by the portlet spec, but is an architectural requirement needed to
display the portlet. -->
<supports>
<mime-type>text/html</mime-type>
<portlet-mode>VIEW</portlet-mode>
<portlet-mode>EDIT</portlet-mode>
<portlet-mode>HELP</portlet-mode>
</supports>
<l-- Specify the set of preferences (if any) for this portlet, and default values.
Insert as many "preference" tags as necessary. -->
<portlet-preferences>
<preference>
<name>preferencelName</name>
<value>preferencelDefault</value>
</preference>
<preference>
<name>preference2Name</name>
<value>preference2Default</value>
</preference>
</portlet-preferences>
</portlet>
</portlet-app>
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6 Add a Servlet Mapping to Your HP Business Availability Center
Descriptor File: web.xml

Hook up your portlet to our central portlet-handling servlet in the main web
configuration file web.xml.

Modify the <HP Business Availability Center root
directory>\AppServer\webapps\site.war\WEB-INF\web.xml file as follows:

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE web-app PUBLIC "-//Sun Microsystems, Inc.//DTD Web Application
2.3//EN" "http://java.sun.com/dtd/web-app_2_3.dtd">
<web-app>
<display-name>My Portlet</display-name>
<servlet>
<servlet-name>MyPortletServiet</servlet-name>
<display-name>My Portlet</display-name>
<description>My Portlet Wrapper</description>
<l-- This is the servlet used for all Dashboard portlet processing, and must be
specified exactly as follows. -->
<servlet-class>
com.mercury.dashboard.app.portal.PortletWrapperServlet
</servlet-class>
<init-param>
<param-name>portlet-class</param-name>
<param-value>my.package.MyPortletClass</param-value>
</init-param>
</servlet>

<servlet-mapping>
<servlet-name>MyPortletServlet</servlet-name>
<url-pattern>/MyPortletServletPath/*</url-pattern>
</servlet-mapping>
</web-app>
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7 PortletWrapperUtils API

Add portlet-wrapper.jar to your class-path to allow you (as the portlet
developer) to use its Dashboard Foundation-proprietary API. This API
provides several tools you can use while developing portlets and help you be
more aware of the portal environment. For example, you can use:

public static String getUserld(PortletRequest request) to get the user ID for
for the user who is invoking the portlet.

public static String getCustomerld(PortletRequest request) to get the
customer ID for the user who is invoking the portlet.

public static String getUniquePortletld(PortletRequest request) to
distinguish this portlet on the client (can be used as an HTML element id).

public static HttpServletRequest getHttpServletRequest(PortletRequest
request) to get the HttpServletRequest from the PortletRequest.

Import the New Portlet Definition

To import, use the portlet import wizard Ul In the HTML interface, select
Administration > Portlet Definitions > Import a Portlet Definition, select to
import a Java Portlet, and follow the wizard instructions to choose your new
portlet and import it. For details, see “Import Portlet Definition Wizard” on
page 87.

After you finish importing a new portlet definition, you can add the portlet
to a page or a module.

Troubleshoot the Deployment of External Custom Java Portlets

For details, see “Troubleshoot the Deployment of External Custom Java
Portlets” on page 125.
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T Personalize Your My BAC Portal - Workflow

Y Y Y Y Y

Your portal has been set up by the My BAC administrator and includes pages
that are of interest to you. You can personalize your My BAC portal by
creating groups of pages, creating private pages, adding portlets to pages,
copying and moving pages, copying and moving portlets, specifying and
running the pages rotation, and more.

This task includes the following steps:

“Add Pages to Your Portal” on page 39

“Manage the Pages in Your Portal” on page 40

“Create a Group of Pages and Add Pages to the Group” on page 40
“Manage the Portlets in Your Portal” on page 40

“Use an HTML Portlet” on page 43

Add Pages to Your Portal

To add pages to your portal, you can:

Add an empty page to your portal. For details, see “Edit Page Dialog Box”
on page 71.

Add shared pages. Shared pages are either provided by HP or configured by
your My BAC administrator. After you add a shared page to your portal, you
can edit the page to meet your specific requirements. For details on adding a
preconfigured page, see “Add a User’s Pages to Module Dialog Box” on

page 47.
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2 Manage the Pages in Your Portal

You can manage your portal pages in the following ways:

Change the name of a page. Click Personalize to open the Private Page tree,
click the page to open the Edit page dialog box. For details, see “Edit Page
Dialog Box” on page 71.

Change the order of the pages. Click Personalize to open the Private Page
tree. Select the page you want to move and use the Up or Down buttons. For
details, see “Edit Page Dialog Box” on page 71 (see the Up/Down section).

Specify and run the page rotation. In My BAC, select the page and click
Page Rotation. For details, see “My BAC Page” on page 98.

Create a Group of Pages and Add Pages to the Group

You can organize your pages into logical groups according to how you want
to use them. For example, if you want to monitor the same service for
different time periods (past week and past month), create a group of pages
that includes the monitoring portlets and set them up for the Past Week
time period, and create another group of pages that includes the same
monitoring portlets set up for the Past Month time period.

You can create standalone pages, with copies within groups, or pages can
exist only within a group.

For details on creating or editing a group, see “Edit Group Dialog Box” on
page 70.

Manage the Portlets in Your Portal
You can manage the portlets in your portal pages in the following ways:

Add portlets to a page. You add portlets to a page you are creating a page or
to an existing page.

For details on adding a preconfigured page, see “Add a User’s Pages to
Module Dialog Box” on page 47.

For details on adding a user or group preconfigured page, see “Users or
Groups Dialog Box” on page 123.



Chapter 1 « My BAC

Note:

» If a portlet is added to a page, and is then disabled, the portlet is removed
from the page. If you re-enable the portlet it remains removed from the
page and you must add it again to the page.

» Before you add a CMDB portlet ensure that it has been set up properly.
For details, see “Set Up CMDB Portlets” on page 30.

» The procedure you use to add an RSS portlet is different from the regular
procedure. For details on setting up RSS portlets, see “RSS Area” on
page 83.

Modify a portlet, change its location on the page, and more. You change
the portlet location on the page, expand the portlet or shrink it, edit the
portlet preferences, change the portlet title, copy/paste a portlet to the same
page or move it to another page, or delete portlet information. For details on
adding a portlet to a page, see “Add Portlets to <page_name>/Add Portlets
Dialog Box” on page 4S5.

Edit/customize a portlet. You edit a portlet by:

» Changing the portlet title. Click the Change Title button and change the
title in the Change Portlet Title dialog box.

» Modifying the portlet preferences. Each portlet has different preferences.
For details about portlet preferences, see “Edit Preferences
<portlet_name> Dialog Box” on page 75.

» Modifying an SLM portlet advanced defaults. For details about portlet
preferences, see “Advanced Options Dialog Box” in Using Service Level
Management.
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Example - Clone a Portlet

Clone a portlet if you want to show the same report but for a different time
range. To clone the portlet, copy and paste it in the tree of pages/modules. A
copy of the portlet is added to the bottom of the page.

Filters ﬂ ﬂ ﬂ
KPls Over Time ﬂ ﬂ ﬂ
Top View ﬂ ﬂ ﬂ
Copy of KPls Over Time ﬂ ﬂ ﬂ

Example - Change a Portlet Title

Change the current title of the portlet in your portal page from Top View to
End Users Monitor View. Edit the Top View portlet and click Change Title to
open the Change Portlet Title dialog box. Enter the new title.

Change Portlet Title

+Title: Ii]'gp WiEny

Change Cancel

The Edit Preferences page of the portlet displays the new title and the
default title included in brackets.

Edit Preferences: End Users Monitor View (Top View)

| |
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The new portlet title displayed in the portal is:

(Z End Users Monitor ¥iew =zl g

5 Use an HTML Portlet

You can use the HTML portlet to enter your own HTML code in a portlet in
My BAC. For details, see “Use an HTML Portlet” on page 43.

T Use an HTML Portlet

Use the HTML portlet to enter your own HTML code that you want to
display in a portlet in My BAC. You can then use the portlet like the other
portlets. The code is not verified.

Use regular HTML code.

Note: The iframe tag used to host a site inside the portlet is not supported.
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@ My BAC User Interface

This section describes:

Add Portlets to <page_name>/Add Portlets Dialog Box on page 45
Add a User’s Pages to Module Dialog Box on page 47
Add/Edit WSRP Producer Dialog Box on page 48
Business Process Diagram Portlet on page 49
Configure Modules Dialog Box on page 50
Configure <module_name> Page on page 52
Configure Portlet Definitions Dialog Box on page 59
Create Module Page on page 66

Create WSRP URL Dialog Box on page 67

Discovery Job Errors Report on page 69

Discovery Job Statistics Report on page 70

Edit Group Dialog Box on page 70

Edit Page Dialog Box on page 71

Edit Preferences <portlet_name> Dialog Box on page 75
Export My BAC Obijects Dialog Box on page 84
Import My BAC Obijects Dialog Box on page 86
Import Portlet Definition Wizard on page 87
Manage Categories Dialog Box on page 95

Manage Favorites Page on page 96

Manage WSRP Producers Page on page 97

My BAC Page on page 98

Page Rotation Dialog Box on page 102

Portlet Categories on page 103

Y Y Y Y Y Y Y Y Y Y Y VY VY VY Y Y Y Y VY VY VY VY Y Y

Portlet Privilege Dialog Box on page 116
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> RSS Portlet on page 117
» Status Snapshot Portlet on page 118
» Users or Groups Dialog Box on page 123

» Welcome to My BAC Application Portlet on page 124

@ Add Portlets to <page_name>/Add Portlets Dialog Box

Description Enables you to add portlets to a page.
To Access:

» Select My BAC, display the page to which you want
to add the portlet, and click Add Portlets to open
the Add Portlets to Page dialog box.

» In My BAC Admin, in the Edit page dialog box, click
Add Portlets.

Included in Tasks » “Add Portlets to a Page” on page 28
» “Manage the Portlets in Your Portal” on page 40.

Search for Portlets to Add Area

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Category Enter the portlet category.

For a list of the categories and the portlets they include,
see “Portlet Categories” on page 103.

Default: All.

Find Portlets Click to list the portlets answering the query (and for
which you have access rights).

Portlet Name Enter the portlet name. Leave the boxes empty to find
all portlets.
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Select Portlets to Add Area

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description
ﬂ Click to access the online help for the corresponding
- report in the application.

<check box> Click to select the portlet to be added to the page.

Add Click to add the selected portlet to the page.

Category The portlet category. For a list of the categories and the
portlets they include, see “Portlet Categories” on
page 103.

Click the column header to display the sorting arrow.
Click the arrow to sort the column in alphabetical
order.

Description The description of the portlet.

Click the column header to display the sorting arrow.
Click the arrow to sort the column in alphabetical
order.

Find Portlets Click to list the portlets answering the query (and for
which you have access rights).

Portlet Name The name of the portlet.

Click the column header to display the sorting arrow.
Click the arrow to sort the column in alphabetical
order.
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@ Add a User’s Pages to Module Dialog Box

Description

Enables you to add the pages created by another user to
the module.

To Access: Click Add a User’s Pages in the Create
Module page or click icon in tree.

Included in Tasks

“Add Pages or User Pages to a Module” on page 27

The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

al

Click to choose the users with self-service access to the
module. For details, see “Users or Groups Dialog Box”
on page 123.

Click to choose the groups of users with self-service

EH access to the module. For details, see “Users or Groups
Dialog Box” on page 123.
Add Click to save the changes.
Pages Select the user’s pages.

Replace pages in
module with
matching names

Select to overwrite the existing pages in the module
with the user’s pages that have the same name.

Clear the check box to add the selected page without
replacing existing pages.

User

Select the user.
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@ Add/Edit WSRP Producer Dialog Box

Description Enables you to add or edit a WSRP producer information.

To access: Click Add in the Manage WSRP Producers
dialog box.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Description The description of the WSRP producer.

Is producer available | Click to verify that the URL of the WSRP producer is
available.

Name The name of the WSRP producer.

WSRP Producer URL The URL of the WSRP producer.
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@ Business Process Diagram Portlet
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Description

Displays the process diagram of a BPI business process
that corresponds to the selected CI. The information is
obtained from the HP Business Process Insight
application. For more information about the different
elements displayed in the portlet, see HP Business
Process Insight documentation.

To Access: Add the portlet to a page or a module.

Important
Information

The Business Process Diagram portlet is included in the
HP Business Process Insight category. Other portlets
included in that category display HP Business Process
Insight data in Dashboard reports.

For additional information about viewing HP Business
Process Insight data in HP Business Availability Center,
see “HP Business Process Insight Data in HP Business
Availability Center” in Using Dashboard.

Included in Tasks

“Administrator Tasks — Workflow” on page 19

“Personalize Your My BAC Portal - Workflow” on
page 39
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@ Configure Modules Dialog Box

Description Enables you to search for an existing module whose
pages, portlets, access, and layout, you want to modify.

To Access: In My BAC Administration, click the
Manage Modules tab, and select Configure Modules.

Important See limitations in “Troubleshooting and Limitations”
Information on page 124.
Included in Tasks “Create a Module” on page 24

Search for a Module to Configure Area

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

ﬂ Click to display the list of all the users and select from
the list. For details, see “Users or Groups Dialog Box”
on page 123.

E Click to display a calendar and select a date.

ﬂ Click to display the list of all the users and select from
the list. For details, see “Users or Groups Dialog Box”
on page 123.

Click to display the list of all the groups or users and

& select from the list. For details, see “Users or Groups
Dialog Box” on page 123.

Ascending/ Select the type of sorting.
Descending
Available to Users... Enter the name of users or groups of users who are
Groups allowed to use the module.
Created By Enter the name of the user who created the module.
Last Updated From.. Enter the date from when to start the search and when
To to end it.
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GUI Element (A-Z) Description

Name starts with Enter the first letters of the module name.

Keep the box empty and click Search if you want to list
all the existing modules.

Reset Form Click to empty all the fields in the form.

Results Displayed Per | Enter the number of results to display per page.

Page Note: The limit is the number of portlets that have

been imported into My BAC.

Search When you click the button, a list of the modules
matching the search criteria is displayed in the Select a
Module to Configure area.

Sort By Select by which criteria to list the modules matching
the search criteria: Name, Last Updated On, or Status.

Status Enter the status of the module.

Select a Module to Configure Area

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description
Click the button corresponding to the module you
d |
want to remove from the list.
All Click to select all the modules.
Configure Modules Select modules and press the button to open the

Configure <module_name> dialog box where you can
configure the module.

Description The description of the module.
Last Updated On The date when the module was last updated.
Name The name of the module.
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GUI Element (A-Z)

Description

None

Click to clear the module selection.

Status

Displays Enabled if the module is available to users or
Disabled if the module is not available to users.

@ Configure <module_name> Page

52

Description

Enables you to create a new module, configure a
module, add comments, and configure access to the
module.

To Access: Double-click the appropriate module in the
Configure Module page.

Important
Information

The page is split into two main panes: the tree of
modules and the dialog box. For details, see
“Module/Page Tree” on page 16.

Note: When a new user is added to a group, the
modules assigned to the group and their permissions
are automatically passed on to the new user.

Included in Tasks

“Create a Module” on page 24
“Configure Access to the Module” on page 27

Tree of Pages Area

The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

1

Click to close or open the tree.

<context menu
options from the

elements in the tree>

Right-click an element in the left-pane tree to display
the context menu options. For details, see “Context
Menu Options and Toolbar Icons” on page 53.
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GUI Element (A-Z) Description

<toolbar icons> Select an element in the left-pane tree and click the
appropriate toolbar icon. For details, see “Context
Menu Options and Toolbar Icons” on page 53.

portlets.

<tree of module> Displays the currently selected module, its pages, and

Context Menu Options and Toolbar Icons

The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z) Description
| To add a new page or a user page to the module, right-
L+ ™ click a module, select the option or select a module,
click the icon and select:
Add
» New Page to add a blank page. For details, see
“Edit Page Dialog Box” on page 71.
» Add User Page to add a user page. For details, see
“Add a User’s Pages to Module Dialog Box” on
page 47.
- Click to return to the Create Module page.
Back
. To clone a module, right-click the module and select
0=0 . . .
the option, or select a module in the tree and click the
button. A copy of the module is pasted in the tree and
Clone the original module is disabled.
= To copy a page, right-click the page and select the
option or select the page in the tree and click the
P pag
button.
Copy
To copy a portlet, right-click the portlet and select the
option or select the page in the tree and click the
button.
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GUI Element (A-Z)

Description

¥

Cut

To cut a page before pasting it, right-click the page and
select the option or select the page in the tree and click
the button.

To cut a portlet before pasting it, right-click the portlet
and select the option or select the portlet in the tree
and click the button.

X

Delete

To delete a module, right-click the module and select
the option, or select the module in the tree, and click
the button. You must also confirm the deletion.

To delete a page in the tree, right-click the page and
select Delete, or select the page, and click the button.
You must also confirm the deletion.

To delete a portlet in the tree, right-click the portlet
and select Delete, or select the portlet, and click the
button. You must also confirm the deletion.

Edit

To edit a module, right-click the module and select the
option. For details, see “Configure <module_name>
Page” on page 52.

To edit a page, right-click the page and select the
option. For details, see “Edit Page Dialog Box” on
page 71. You can then add portlets to the page or delete
them from the page. To edit a portlet, right-click the
portlet and select the option. For details, see “Edit
Preferences <portlet_name> Dialog Box” on page 75.

Paste

After you have selected a page and copied/cut it, right-
click the module where you want to paste the page and
select Paste, or click the module where you want to
paste the page, and click the button.

After you have selected a portlet and copied/cut it,
right-click the page where you want to paste it and
select Paste, or click the page where you want to paste
the portlet, and click the button.
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GUI Element (A-Z) Description

To reorder the pages of a module, right-click the page
and select Up or Down, or select a page in the module,
and use the Up and Down buttons.

Up/Down
ﬂ To display a preview of the page that includes real data,
right-click the page and select View or select a page and
. click the button.
View

To display a preview of the portlet that includes real
data, right-click the portlet and select View or select a
portlet and click the button.

Header Area

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Created By The name of the user who created the module.
Description Enter a brief description of the module.
Enabled To enable the module, select Yes.

To disable the module, select No.

Default value: Yes. The module is available for adding
to users’ portals.

Note: If you disable a module after it has been made
available, the module is removed from the users shared
area and a warning message is issued. The module
pages are not removed from the users private area.

Last Modification
Date

The date the module was last modified.

Last Modified By

The name of the user who last modified the module.

Module Name

Enter the name of the module. This name must be
unique.
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Administrator Comments Area

Description Enables you to add administrator comments to the
module.

To Access: Expand the Administrator Comments.

Important The comments are displayed in the <module_name>
Information Comments page. If you add a comment to the module,
it counts as a change and the orange square indicating
a change is displayed in the Switch to page menu.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Add Comment Enter the comments.

View Comments Click to display the Module Comments page with the
comments you entered.

Configure Access Area

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

Description Enables you to configure read-only access for the
selected users/groups. For details, see “Read-Only Area”
on page 57.
To Access: Expand the Administrator Comments.
Important For details about the type of access to the module, see
Information “Troubleshooting and Limitations” on page 124.
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The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

&)

module. For details, see “Users or Groups Dialog Box”
on page 123.

The selected users are automatically added to the list of
users.

Click to choose the users with read-only access to the

access to the module. For details, see “Users or Groups

The selected groups of users are automatically added to
the list of users.

Click to choose the groups of users with read-only

Dialog Box” on page 123.

Allow access to all
users

Select to provide read-only access to the module to all
the users.

Enable users to copy
this module pages to

Select to enable the users selected above in the User
Access area to copy the module pages to their private

their private My BAC dashboards.

dashboard

Name Displays the name of the user or group of users.
Type Displays the type (users or groups of users).
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Types of Access

Depending on the access definitions provided by the administrator at the
module, page, or portlet level, the user can have read-only access or can
copy pages from the Shared Pages area to the user Private Pages area and can
be edited there.

Type of Access What the Selected User/Security Group Can Do

Read-only access The selected users/security groups have read-only
access to the module or pages.

The user can view the module pages in My BAC
page but cannot modify those pages or the portlets
in those pages.

Enable users to copy this The selected users/security groups can copy the
module pages to their module pages to their private My BAC area.

private dashboard The user can view the module pages in My BAC

page and can modify those pages and the portlets in
the pages depending on the permissions for the
portlets.

Note: In My BAC Dashboard, you see the private pages you created in My
BAC, the pages that you are allowed to copy and modity, and the read-only
pages prepared by the administrator, filtered by the permissions defined for
the modules and portlet definitions in Platform Administration. For
example, you see the pages of the module and the portlets for which you
have permissions; the other portlets in the page do not display data and
include an error message that indicates that you do not have permission to
view the portlet. For details about the permissions defined in Platform
Administration, see “User Management — Overview” in Platform
Administration.
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@ Configure Portlet Definitions Dialog Box

Description Enables you to edit, copy, or delete portlet definitions.

To Access: Select Admin > My BAC > Manage Portlet
Definitions > Configure Portlet Definition, and click
Configure Portlet Definition.

Included in Tasks “Configure a Portlet Definition — Optional” on page 21

Search for a Portlet Definition to Configure Area

Description Enables you to search for the portlet definition you
want to edit, copy, or delete.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Click to select the category.
IE?|
s | Click to select the user.

Ascending/ Select the sort order for results as ascending or

Descending descending. The default is ascending.

Category Select a category to find only those portlet definitions
that belong to that category. For a list of the categories
and the portlets they include, see “Portlet Categories”
on page 103.

Created By Enter the name of the user who created the portlet
definition.

Enabled Select:
> Yes (the default) to enable the portlet to be added to

a page.
» No. To prevent the portlet to be added to a page. You
might use this option in a testing environment.
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GUI Element (A-Z)

Description

Name starts with

Enter all or part of a portlet definition’s name. Typing
part of a name yields all matching results.

Reset Form

Click this button to clear all the fields and display
default criteria.

Results Displayed Per
Page

Enter the number of search results to display on every
page. The default is 50. This field is mandatory.

Search Click to start the search.

Sort By To sort results, select either Name, Type, Category, or
Enabled.

Type Select the type of portlet: Java or WSRP.

Configure Portlet

Definition Area (List of Portlets)

Description Displays the list of portlets that correspond to the
search criteria. You can then select the portlets you
want to configure.

Important Click the name of a portlet to open its configuration

Information details.

The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

x|

Click the button to delete the selected portlet.

Category The portlet category. For a list of the categories and the
portlets they include, see “Portlet Categories” on
page 103.

Description The description of the portlet.
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GUI Element (A-Z) Description

Enabled Select:

» Yes if the portlet is enabled to be added to a page.

» No if the portlet is not available to be added to a
page.

Name The name of the portlet.

Click the name of the portlet to open the Configure
Portlet Definition page for the selected portlet.

Prev/Next Click to navigate the search results.

Type The type of portlet: Java or WSRP.

Configure Portlet Definition: <portlet_name>Area

Description Enables you to change the name of the portlet, its
category, its display mode, and to enable or disable it.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Category The portlet category. A category helps users find the
portlets they need. For a list of the categories and the
portlets they include, see “Portlet Categories” on
page 103.

Copy To create a new portlet definition with similar
properties as the current portlet definition.

Click to open the Copy Portlet Definition page. The
page is the same as the Configure Portlet Definition
area. Make the changes. For details, see “Configure

Portlet Definition: <portlet_name>Area” on page 61.

Created By The name of the user who created the portlet.

Default Width Select Wide or Narrow default portlet width. System
default is Narrow.
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GUI Element (A-Z)

Description

Delete Click to delete the portlet definition and confirm the
deletion.

Description The description of the portlet.

Enabled Select:

» Yes if the portlet is enabled to be added to a page.
» No if the portlet is not available to be added to a
page.

Last Modification
Date

The date the portlet definition was last modified.

Last Modified By

The name of the user who last modified the portlet
definition.

Manage Categories

Click the Manage Categories button to add or delete
portlet categories. For details, see “Manage Categories
Dialog Box” on page 95.

Name

Enter the name of the portlet.

Portlet Display Name

The name of the portlet that is displayed in the page.

Portlet Type

The type of portlet: Java or WSRP.

Prev/Next

To navigate the search results.

View Usage

Displays a list of the users, modules, or hyperlinks that
reference the portlet. This is information that you want
to take into consideration when you want to disable a
portlet or to modify its definition.
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Portlet Communication Area

Description This tab is for future use.

To Access: Click the Portlet Communication tab.

Access Area

Description Enables you to configure access to the portlet:

» Selected users/groups can add the portlet to their
pages. For details, see “User Access Area” on page 64.

» Selected users/groups have modify access to this
portlet. For details, see “Administrator Access Area”
on page 63.

» WSRP consumers can consume the portlet from a
remote portal. For details, see “WSRP Access Area”
on page 63.

To Access: Click the Access tab.

Important For details about the type of access to the module, see
Information “Troubleshooting and Limitations” on page 124.
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User Access Area

Description Enables you to specify the users or groups who can add
the portlet to their private My BAC dashboards.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

» Click the icon close to the Require users to have one
of these privileges box to select the appropriate
privilege. For details, see “Portlet Privilege Dialog
Box” on page 116.

o

» Click the icon close to the Give access to box to
choose the groups with user access to the module.
For details, see “Users or Groups Dialog Box” on
page 123.

Note: You must select at least one user or one group.

ﬂ Click to choose the users with user access to the
module. For details, see “Users or Groups Dialog Box”
on page 123.

Note: You must select at least one user or one group.

Allow access to only Displays the selected users and groups.
the following users
and groups

Give access to Select User or Group.

Require users to have | Displays the name of the privilege needed to add the
one of these portlet to private pages.
privileges
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Administrator Access Area

Description Enables you to select the users or groups who can
modify the portlet definition.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

ﬂ Click to choose the users with administrator access to
the portlet. For details, see “Users or Groups Dialog
Box” on page 123.

Note: You must select at least one user or group.

Click to choose the groups with administrator access to

& the portlet. For details, see “Users or Groups Dialog
Box” on page 123.
Note: You must select at least one user or group.
Add Click to add the selected users or groups of users.
Give access to Select User or Group.
Name Displays the name of the user or group of users.
Type Displays the type (users or groups of users).

WSRP Access Area

Description Enables you to select to make the portlet available to
WSRP consumers. This means that the portlet can be
consumed from a remote portal.
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The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Make Portlet Select to make the portlet available to WSRP

Available to WSRP consumers.

Consumers Default value: Make Portlet available to WSRP
Consumers is set for all Dashboard portlets.

@ Create Module Page

Description Enables you to create a module, its pages, and the
portlets in the pages, directly from the module tree.
You can give sharing access to that module, add
comments, and edit the portlets and their layouts.

To Access: In My BAC Administration, select Create
Modules in the Manage Modules tab.

Included in Tasks “Create a Module” on page 24

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Create Click to open the Create <module_name> dialog box
where you can add details about the module.

Description Enter the description of the module.
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GUI Element (A-Z)

Description

Enable

To enable the module, select Yes.
To disable the module, select No.

Default value: Yes. The module is available for adding
to users’ portals.

Note: If you disable a module after it has been made
available, the module is removed from the users shared
area and a warning message is issued. The module
pages of the disabled module are not removed from the
users private area.

Module Name

Enter the name of the module.

@ Create WSRP URL Dialog Box

Description Enables you to create a WSRP URL when you want to
export portlets from My BAC to a remote portal.
To Access: Select Admin > My BAC > Manage Portlet
Definitions > Create WSRP URL.

Important The URL can be used with or without user credentials.

Information For details, see “Use a Non-Authenticated or an

Authenticated WSRP URL” on page 32.

Note to HP Software-as-a-Service customers: Pre-
authenticated WSRP URL are supported in

HP Software-as-a-Service, and customers can have their
own producers. The logon user name, and password
must be embedded in the URL. The customer ID is
automatically embedded in the URL. The portlet
definitions are those of the specific customer ID. When
reentering the portlet, the user is logged on
automatically.

Included in Tasks

“Administrator Tasks — Workflow” on page 19
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The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

Authenticate with
user from WSRP
consumer

Select to use a non-authenticated URL to access the
WSRP portlet. You must define a consumer user as one
of the users in HP Business Availability Center. For
details, see “Use a Non-Authenticated or an
Authenticated WSRP URL” on page 32.

Automatically
authenticate with the
following credentials

Select to use an automatically authenticated URL to
access the WSRP portlet. For details, see “Use a Non-
Authenticated or an Authenticated WSRP URL” on
page 32.

Copy

Click to highlight the contents of the Use this URL for
WSRP box and to automatically copy this information
to the clipboard. You can then copy the URL where
needed.

Note: In Mozilla Firefox, you must manually copy the
contents to the clipboard.

Create

Enter a user name and password, and then click to
create the URL. The default URL in the Use this URL for
WSRP box is modified to include the user name and
password, as follows:

http://<server_name>/dashboard/wsrp4jproducer.wsd|?
dsh_username=<user_name>&dsh_password=
<password>&dsh_customer=<dsh_customer>

Copy the URL to access a My BAC portlet from another
portal or to import a portlet from another My BAC
machine, with authentication.

Note:

» <user_name> and <password> are encrypted.

» <dsh_customer> is automatically inserted. It is not
encrypted and represents your Customer ID. Do not
modify it!
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GUI Element (A-Z)

Description

Password

Enter the logon password if you are using an
automatically authenticated URL.

For details, see “Use a Non-Authenticated or an
Authenticated WSRP URL” on page 32.

WSRP

Use this URL for

The box displays the default URL or the URL you
created by clicking the Create button.

User name

Enter the logon user name. if you have selected to use
an automatically authenticated URL.

For details, see “Use a Non-Authenticated or an
Authenticated WSRP URL” on page 32.
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Discovery Job
Description Enables you to view the ten Discovery jobs that have
the highest number of errors.
To Access: Add the portlet to a page or a module.
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@ Discovery Job Statistics Report
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Discovery Job

Description Enables you to view statistics for the ten most active
Discovery jobs (that is, those with the most created,
removed, or updated operations).

To Access: Add the portlet to a page or a module.

@ Edit Group Dialog Box

Description Enables you to group pages. You can then add pages to
the group.

To Access: Select the Private Pages root and click the
New Group button in the user’s modules tree.

Important You cannot create a group of pages under another
Information group of pages.
Included in Tasks “Create Users and Groups” on page 24
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The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description
Description The description of the group of pages.
Group name The name of the group of pages.

@ Edit Page Dialog Box

Description Enables you to manage pages, portlets, and user pages.
To Access:

» In My BAC, click the Personalize E button.

» In My BAC Admin, in the Configure Module page:

» Select the module in the tree and click the New
Page [ |button.

» Right-click the module in the tree and select New

Page.
» Right-click a page in the tree and select Edit.
Important The page is split into two main panes: the tree of pages
Information and the dialog box. The left pane is split into the

Private Pages area and the Shared Pages area. For
details, see “Module/Page Tree” on page 16.

Note: When a new user is added to a group, the
modules assigned to the group and their permissions
are automatically passed on to the new user.

Included in Tasks “Personalize Your My BAC Portal - Workflow” on
page 39
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Tree of Pages Area

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description
O Click to expand or collapse the left pane.
i This icon appears in the Shared Pages area of the tree

in My BAC for modules or pages that can only be
viewed (you cannot copy them or modify them).

<context menu Right-click an element in the left pane to display the
options from the context menu options. For details, see “Context Menu
elements in the tree> | Options and Toolbar Icons” on page 53.

<toolbar icons> Select an element in the left pane and click the
appropriate toolbar icon. For details, see “Context
Menu Options and Toolbar Icons” on page 53.

<tree of pages> Displays the following hierarchies:

» The Private Pages root and, as children of the root,
the pages and portlets of the user added, by the user,
to the Private Pages.

» The Shared Pages root and, as children of the root,
the pages and portlets of the modules created by the
administrator.

» The built-in Default Module. For details, see “Java
and WSRP Portlets” on page 14.

Double-click a portlet in the tree to open the Edit

Preferences dialog box for the portlet.
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Context Menu Options or Toolbar Icons

GUI Element (A-Z)

Description

To add a new page or a user page to the Private Pages
area, right-click Private Pages, select the option or
select a module, click the icon and select:

» New Page to add a blank page. For details, see
“Edit Page Dialog Box” on page 71.

» New Group to add a group. For details, see “Edit
Group Dialog Box” on page 70.

Click to return to the Create Module page.

Back
= To copy a page, right-click the page and select the
option or select the page in the tree and click the
button.
Copy

To copy a portlet, right-click the portlet and select the
option or select the page in the tree and click the
button.

Cut

To cut a page before pasting it, right-click the page and
select the option or select the page in the tree and click
the button.

To cut a portlet before pasting it, right-click the portlet
and select the option or select the portlet in the tree
and click the button.

This capability is not supported for shared pages.

Delete

To delete a page in the tree, right-click the page and
select Delete, or select the page, and click the button.
You must also confirm the deletion.

To delete a portlet in the tree, right-click the portlet
and select Delete, or select the portlet, and click the
button. You must also confirm the deletion.
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GUI Element (A-Z)

Description

Edit

To edit a page, right-click the page and select the
option. For details, see “Edit Page Dialog Box” on
page 71. You can then add portlets to the page or delete
them from the page.To edit a portlet, right-click the
portlet and select the option. For details, see “Edit
Preferences <portlet_name> Dialog Box” on page 75.

Paste

After you select a page and copy/cut it, right-click
Private Pages and select Paste, or click Private Pages,
and click the button.

After you select a portlet and copy/cut it, right-click the
page where you want to paste it and select Paste, or
click the page where you want to paste the portlet, and
click the button.

To reorder the pages in the Private Pages area, right-
click the page and select Up or Down, or select a page
in the module, and use the Up and Down buttons.

You can also rearrange the modules in the Shared Pages
area; this change affects only the modules in your
Shared Pages area.

View

To display a preview of the page with real data, right-
click the page and select View or select a page and click
the button.

To display a preview of the portlet with real data, right-
click the portlet and select View or select a portlet and
click the button.
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Edit Page Area

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

<portlets> Each portlet in the page is represented by a box. For
more details, see “My BAC Page” on page 98.

Note: If the user does not have the appropriate
permissions to view the portlet, an error message is
displayed inside the portlet box.

Double-click a portlet to open the Edit Preferences
dialog box for the portlet.

Add Portlets Click to add portlets to the page. For details, see “Add
Portlets to <page_name>/Add Portlets Dialog Box” on
page 45.

Page Name Enter the name of the page.

Preview Click to preview the page. The page is displayed with
real data.

@ Edit Preferences <portlet_name> Dialog Box

Description Enables you to edit a portlet.

To Access: Click the Edit button in the portlet frame.

Important The page displays different elements depending on the
Information selected portlet. For details, see below.
Included in Tasks “Edit/Customize a Portlet” on page 29

“Manage the Portlets in Your Portal” on page 40
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The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

<areas> The areas displayed in the page depend on the selected
portlet. The areas are (listed alphabetically):
“Advanced Settings Area” on page 76

“Filter Area” on page 77

“KPI Selection Area” on page 78

“Options Area” on page 81

“RSS Area” on page 83

YYVYVYVYY

“View Selection Area” on page 84

Change Title Click to change the title of the portlet.

Preview Click to display a preview of the portlet with real data.

Advanced Settings Area

The area includes a subset of the following elements:

GUI Element (A-Z) Description

Breakdown with pie Select to display the portlet information in pie chart
chart format.

Breakdown with pie Select to display the portlet information in pie chart

chart and table and table formats.

Breakdown with Select to display the portlet information in table

table format.

Graph Select to display the portlet information in chart
format.

Refresh rate Choose how often to update the report: never (No

Refresh), hourly (1 Hour), or every two hours (2 Hours).
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GUI Element (A-Z) Description

Show only the Select the check box to display the CI and its subtree.

selected subtree Clear the check box to display all CIs included in the
view. The selected CI is marked.

Table Select to display the portlet information in table
format.

Filter Area

Important The Filter area is displayed for some of the portlets. It
Information includes different elements depending on the portlet.

When editing the Service Report portlet, click Launch
Service Report Builder to open the Service Report
Builder wizard. For details, see “Service Report Builder
Wizard” on page 162.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Advanced Options Displays a subset of the description options that you
want to add to reports to appear below the report data.
Select the required options and click OK to save the
changes.

The link is available only for Service Level
Management portlets.

For details about the available options, see “Advanced
Options Dialog Box” in Using Service Level Management.

Configuration Items Displayed for some of the Dashboard portlets.

Displays a subset of the ClIs you can select to display in
the portlet.

For details, see “Configuration Items Dialog Box” in
Using Dashboard.
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GUI Element (A-Z)

Description

KPIs Displayed for some of the Dashboard portlets.
Select a subset of the KPIs attached to the Cls you
selected.
For details, see “KPIs Dialog Box” in Using Dashboard.
Raw data Select the option to view raw data in the report.

This option appears only for the Cross-Performance
Report. For details, see “Cross-Performance Report” in
Using System Availability Management.

Select Measurements

Opens the Select Measurements dialog box.

This option appears only for the Cross-Performance
Report.

For details about the dialog box, see “Cross-
Performance Report” in Using System Availability
Management.

Statuses

Displayed for some of the Dashboard portlets.
Select a subset of the statuses of the selected KPIs.

For details, see “Statuses Dialog Box” in Using
Dashboard.

Time Range and
Granularity Bar

Select the option to view aggregated data in the report.

For details, see “Common Report Elements” in Reports.

KPI Selection Area

Important
Information

The KPIs are listed according to the following logic:

» The first three KPIs in the list are: Availability,
Performance, and System.

» The other KPIs are separated by an blank row from

the important KPIs. Those KPIs are listed in
alphabetical order.

By default, all the KPIs are selected.
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The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Business A star in the column indicates that the corresponding
KPI has been defined as a Business KPI or as a Business
and Operations KPI. For details, see “KPIs for User
Modes” in Using Dashboard.

Include in Portlet Clear the option to ensure that the KPI is not displayed
in the portlet and in the tooltips, and that it is not
included in the CIs generic status when the CI status is
calculated by including all the CI's KPIs (like in Top
View, Custom Map, Geographical Map, and Topology
Map portlets).

Select to include the KPI in the portlet display.

Note: In My BAC, each KPI that was assigned the
Include in View option in the KPIs page in Dashboard
Admin is assigned the Include in portlet option. You
can deselect the Include in portlet option for additional
KPIs. You cannot select the Include in portlet option
for KPIs whose Include in View option in the KPIs page
is cleared in Dashboard Admin. For details, see “KPIs
Page” in Using Dashboard.
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GUI Element (A-Z)

Description

Include in CI Status

Clear the option to ensure that the KPI is displayed in
the portlet and in the tooltips, but that it is not
included in the CIs generic status when the CI status is
calculated by including all the CI's KPIs (like in Top
View, Custom Map, Geographical Map, and Topology
Map portlets).

Default value: The option is selected.

Note: The Include in CI Status option is automatically
cleared when the Include in Portlet option is cleared.

Note: In My BAC, each KPI that was assigned the
Include in Cl Status option in the KPIs page in
Dashboard Admin is assigned the Include in Cl Status
option. You can deselect the Include in Cl Status option
for additional KPIs. You cannot select the Include in CI
Status option for KPIs whose Include in Cl Status
option in the KPIs page is cleared in Dashboard Admin.
For details, see “KPIs Page” in Using Dashboard.

KPI Use this area to select the KPIs you want to display in
the portlet. The listed KPIs correspond to the view and
the view’s ClIs that you selected in the View Selection
area.

Operation A star in the column indicates that the corresponding

KPI has been defined as an Operations KPI or as a
Business and Operations KPI. For details, see “KPIs for
User Modes” in Using Dashboard.
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Options Area

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

Preference Description

Active Filters Displayed for the Filters portlet.

Select from the list to create filters that filter CIs, to
focus on a specific view, on specific CI types or statuses,
or on problematic areas. For an explanation of the
filters, see “Defining/Editing Filters Dialog Box” in

Using Dashboard.

Map Style Choose the style of the map to be displayed. For
details, see “Geographical Map Page” in Using
Dashboard.

Play Status Alert When selected, a sound alert is played when the portlet

Sound is currently displayed and a CI's KPI changes status to

Critical (red). The Critical status icon flashes until the
next screen refresh.

Note:

» If a Cl in a hidden part of the view changes to
Critical but does not change the status of any of the
CIs in the currently displayed branches, no sound is
played.

» The first time a view loads, no sound is played for
the CI's KPIs that are loaded at Critical status.

The alert sound is a .wav file downloaded by the
browser.

Note: If you are using Mozilla, you must download a
plug-in for playing .wav files.

For details, see “Change the Status Alert Sound -
Optional” on page 23.

Show When selected, My BAC displays the acknowledgement
Acknowledgement icon in the portlet. For details, see “Acknowledge
Performance Problems” in Using Dashboard.
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Preference

Description

Show only the
selected subtree

Displayed for the Top View portlet.

Select the check box to display the CI and its subtree.
Clear the check box to display all CIs included in the
view. The selected CI is marked.

Tree Mode initial
state

This option is available only for the Console portlets.
Select one of the following options:

» Collapsed. Select to display the portlet with all the
subtrees collapsed. For example:

) Console 2| 2]=al

T

Performance Availability Volume Ack |+

End User Monitors View

(X5 Qe - 8
@2 D42 - =]
:-:):i BrOrZ ¥ ‘- .- - =]

» Expanded. Select to display the portlet with all the
subtrees expanded. For example:

# Console Elel=gl
End User Maonitors View Jﬂﬂﬂ
Name Performance Awvailability Yolume Acls
B cuet g pom g v Qe @22 - -
...... i te 10w * @+° &
...... ] e 15 ¥ @2 &9 [
""" :-; tx 1 failed * - ';]>'<¢: &
""" :-; tx 7 failed * - ';]>'<¢: [
...... 7 b T [ T4 E
B oot 1 pem 11 v Gt @42 &
...... ] e 10w 13 9 e
...... " J. @2 Q. &
""" o] tx 1 failed « - Qe &~
L] »

Last Update - 06:12:05 AM

For additional information about the Console page, see
“Console Page” in Using Dashboard.
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The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

Host

Enter the name of the proxy or gateway server.

Maximum number of
items to display

Enter the number of items in an RSS feed to display in
the portlet. For example, 5 means that My BAC
displays the first 5 entries in a feed from a particular
source. If you leave this field empty, My BAC displays
all items in a feed.

Port Enter the number of the port used by the proxy or
gateway server to receive requests.
Default value: 80

Protocol Enter the protocol used to send requests to the proxy

or gateway server.

Default value: http

Refresh rate

Select the refresh rate, in minutes, from the list.

Select No Refresh if you want to manually refresh the
RSS feed display.

RSS URL Enter the full URL that returns an XML file in RSS
format.
Use proxy Select to specify the proxy or gateway server used to

access the RSS feed.
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View Selection Area

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

<view explorer> This pane displays View Explorer. Select the view and
the CIs on which you want to focus the portlet. For
details about View Explorer, see “View Explorer” in
Model Management.

@ Export My BAC Objects Dialog Box

Description Enables you to export portlet definitions or modules.
You save the resulting XML file and import it into
another HP Business Availability Center instance.

You would probably export a portlet definition or
module when upgrading the HP Business Availability
Center version, or when moving data from a test to a
production environment. For details on importing
portlet definitions or modules, see “Import Portlet
Definitions — Optional” on page 20.

To Access: Select Admin > My BAC > Manage Portlet
Definitions > Export Objects.

Important You can export one or more portlets and one or more
Information modules in one file, or you can export each portlet or
module in its own file.

Included in Tasks “Export Portlets and Modules — Optional” on page 22
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The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

o

Click the icon near the Export Portlet Definitions box
and select the portlets to be exported. If you select
several portlets, they are exported together in one file.

Click the Export Modules box to choose the modules
to be exported and select the modules to be exported.
If you select several modules, they are exported
together in one file.

Note: You can select to export both portlets and
modules in one file.

Export

Click to open the XML file corresponding to the
selected object, select all the lines in the file, and copy
them to an external application. In the page that
opens, click:

» Open to display the XML file in the Web browser
(not recommended).

» Save to open the Save As dialog box, navigate to the
folder in which you want to save the file, enter a
name for the file or accept the default name, and
click Save. The selected portlet definitions and
modules are exported to an XML file in the location
you selected.

» Cancel to return to the Export My BAC Objects page
without saving the file.

Export Modules

Enter the name of the module.

Export Portlet
Definitions

Enter the name of the portlet definition.
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@ Import My BAC Objects Dialog Box

Description Enables you to import portlet definitions and modules.
You would probably import a portlet definition or
module when upgrading the HP Business Availability
Center version, or when moving data from a test
environment to a production environment.

To Access: Select Admin > My BAC > Manage Portlet
Definitions > Import Portlets and Modules.

Included in Tasks “Import Portlet Definitions — Optional” on page 20

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Browse Click to locate the folder where the XML file is located.
Select the file and click Open to return to the Import
My BAC Obijects page.

Import Click to import the selected object.

My BAC displays a window with the import status for
the portlet definitions and modules in the XML file.

Import from File Enter the name of the file.
Replace same Select to replace a module with the data in the XML
Modules file.

Note: If both check boxes are cleared, My BAC skips
any portlet definitions or modules in the file, whose ID
(for example, <uuid>) is the same as in My BAC.

Replace same Portlet | Select to replace a portlet definition by the imported
Definitions one.

Note: If both check boxes are cleared, My BAC skips
any portlet definitions or modules in the file, whose ID
(for example, <uuid>) is the same as in My BAC.
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@ Import Portlet Definition Wizard

Description Enables you to import a portlet definition to make it
available to be added to a page in My BAC.
To Access: Select Admin > My BAC > Manage Portlet
Definitions > Import Portlet Definition.

Important Only one portlet can be selected at a time.

Information

Included in Tasks

“Import Portlet Definitions — Optional” on page 20

Wizard Map

Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access Page
> Confirm a Successful Import Page

Choosing Portlet Type Page

Description Enables you to select the type of portlet you want to
import.

Important For important information, see “Import Portlet

Information Definition Wizard” on page 87.

Wizard Map Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access Page
> Confirm a Successful Import Page
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The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description
Java Portlet Select the type of portlet you want to importing: Java
or WSRP.

WSRP Portlet
For details about the types of portlets, see “Java and
WSRP Portlets” on page 14.

Next Click to open the next wizard page. For details, see
“Select from Available Portlets Page” on page 90 if you
have selected Java Portlet or see “Define Producer Web
Service Page” on page 88 if you have selected WSRP
Portlet.

Define Producer Web Service Page

Description Enables you to enter the WSRP Producer URL from
which you want to import portlets. This page is
displayed when you have selected WSRP Portlet in the
previous page of the wizard.

Important For important information, see “Import Portlet
Information Definition Wizard” on page 87.
Wizard Map Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access Page
> Confirm a Successful Import Page
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The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

Click to open the list of existing producer URLs where

o
you can select the required URL.
Manage WSRP Click to open the Manager WSRP Producers page where
Producers you can manage WSRP producers.
Next Click to open the next wizard page. For details, see

“Select from Available Portlets Page” on page 90.

Predefined Producer
URL

Enter the name of a predefined producer URL.

WSRP Producer URL

Enter the URL of a Web service that provides portlets
through the WSRP protocol. If your consumer is:

» Another My BAC user. Enter a URL with the
following format:
http://<server_name>/dashboard/wsrp4jproducer.
wsdl

» An external portal. Enter the appropriate URL.

My BAC contacts the Web service to determine which
portlets are available and displays them in the next
page.

Note: If you import a portlet from another My BAC
machine, you can use a URL that includes the

authentication information. For details, see “Create
WSRP URL Dialog Box” on page 67.
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Select from Available Portlets Page

Description Enables you to select the portlet to be imported.
To Access:

» Select Java Portlet in the Choose Portlet Type page
and click Next.

» Click Next in the Define Producer Web Service page.

Important In the Select from Available Portlets page, you can
Information select only one portlet at a time.

For important information, see “Import Portlet
Definition Wizard” on page 87.

Wizard Map Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access Page
> Confirm a Successful Import Page

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

<Java Portlet> Select a Java portlet.

A red check mark next to a portlet signifies that it has
been imported previously.

For details, see “Java and WSRP Portlets” on page 14.

Finish Click to perform other actions, such as importing
another portlet definition. For details, see “Confirm a
Successful Import Page” on page 95.

Next Click to open the next wizard page.
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Enter Portlet Information Page

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

Description Enables you to change the portlet information, such as
the name or category.

Important For important information, see “Import Portlet
Information Definition Wizard” on page 87.
Wizard Map Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access
Page > Confirm a Successful Import Page

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Category Select one or more categories that characterize the
portlet. A category helps users find the portlets they
need. Click the Manage Categories button to add or
delete portlet categories. For details, see “Manage
Categories Dialog Box” on page 95.

For a list of the categories and the portlets they include,
see “Portlet Categories” on page 103.

Default Width Select Wide or Narrow default portlet width. System
default is Narrow.

Description To aid users, enter a description of the portlet. The
maximum length of the description is 1800 characters.

Enabled Choose Yes (default) to enable the portlet to be added
to a page. (You would probably choose No in a testing
environment.)

Finish Click to perform other actions, such as importing
another portlet definition. For details, see “Confirm a
Successful Import Page” on page 95.
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GUI Element (A-Z)

Description

Name Enter a new name for the portlet.
Note: The name of the portlet must be unique. The
maximum length of the name is 80 characters. This
field is mandatory.

Next Click to open the next wizard page. For details, see

“Configure Access Page” on page 92.

If a portlet definition with the same name already
exists, My BAC displays a message. Return to the
Import Portlet Definition page and change the name.

Configure Access Page

Description

Enables you to configure access rights to the portlet, for
users, groups of users, and administrators.

Note: Access to a portlet definition is given, by default,
to all users and all administrators. If you assign access
rights to specific users or groups of users, or to specific
administrators, My BAC removes the All Users or All
Portlet Definition Administrators types from the list
and replaces them with the user, group of users, or
administrator you selected.

Important
Information

In this page, decide whether users need a special
license to access the portlet.

Note: To configure a portlet definition, the user must
have the permission to configure a portlet definition.
Select Platform > Admin > Users and Permissions, select
the My BAC context, select Portlet Definitions, and
assign the permissions.

For important information, see “Import Portlet
Definition Wizard” on page 87.

Wizard Map

Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access
Page > Confirm a Successful Import Page
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Description

Enables you to select the users or groups who can add
the portlet to their private My BAC dashboard.

The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

o

Click the icon near the Require users to have one of
these privileges box to choose a privilege.

Click the icon near the Give Access to box to choose
the groups with read-only access to the module.

For details, see “Users or Groups Dialog Box” on
page 123.

4

Click to choose the users with read-only access to the
module. For details, see “Users or Groups Dialog Box”
on page 123.

Give Access to

Select User or Group.

Note: You must select at least one user or one group.

Name

The name of the selected user or group of users.

Require users to have
one of these

Enter the name of the application for which you have a
license.

privileges Note: A user without the correct license for the
application on which the portlet is based, cannot
access the portlet.

Type Displays the type (users or groups of users).
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Administrator Access Area

Description Enables you to select the users or groups who can
modify the portlet definition and who can also add the
portlet to their private pages.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

ﬂ Click to choose the users with read-only access to the
module. For details, see “Users or Groups Dialog Box”
on page 123.

Note: You must select at least one user or one group.

Click to choose the groups with read-only access to the

= module. For details, see “Users or Groups Dialog Box”
on page 123.
Note: You must select at least one user or one group.
Give Access to Select User or Group.
Note: You must select at least one user or one group.
Name The name of the selected user or group of users.
Type Displays the type (users or groups of users).

Make Portlet Available to WSRP Consumers

Description Enables you to make the WSRP portlet available for
Web service clients.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Make Portlet Select to make the WSRP portlet available for Web
available to WSRP service clients.

Consumers
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Confirm a Successful Import Page

Description The last stage of the procedure is to confirm that the
portlet has been successfully imported. My BAC
displays a message confirming a successful import.

Important For important information, see “Import Portlet
Information Definition Wizard” on page 87.
Wizard Map Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access Page
> Confirm a Successful Import Page

® Manage Categories Dialog Box

Description During the procedures for importing or configuring a
portlet definition, you can select portlet categories that
enable users to more easily find a specific portlet to add
to their portal. My BAC categories include the

HP Business Availability Center applications, such as
Service Level Management, Dashboard, and End User
Management. You can add categories to the list.

To Access: In the Import Portlet Definitions or
Configure Portlet Definitions page, click the Manage
Categories button to open the Manage Categories

page.

Included in Tasks “Manage Portlet Categories — Optional” on page 21
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The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

ﬁ Click to delete the appropriate user-defined category.

Note: You cannot delete built-in categories: Dashboard,
General, CMDB, End User Management, and SLM.

New Category Enter the name of a new category and click Add. For a
list of the existing categories and the portlets they
include, see “Portlet Categories” on page 103.

@ Manage Favorites Page

Description Enables you to add or remove pages from the favorite’s
list.

To access: Click the Favorites |5.¢ ¥ button and select
the Manage Favorites %= option in My BAC main

page.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description
L‘I Select a favorite page in the Private and Shared pages
boxes and click the button to make the page a favorite
page.
ﬂ J Select a favorite page in the right box and click the
¥ appropriate button to change the order of the pages in

the favorite’s list.

Edit Select a favorite page and click the button to open the
Edit Favorite dialog box where you can modify the
favorite page title and description. The description is
displayed in a tooltip in My BAC page.
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GUI Element (A-Z)

Description

New Click to open the New Favorite dialog box where you
can specify a title and a description for the new favorite
page, and add a URL. The icon for such a favorite page
is as follows: LaHF Page

Remove Select a page in the list of favorite pages and click

remove to remove it from the favorites menu bar.

® Manage WSRP Producers Page

Description

Enables you to manage WSRP producers.

To access: Click the Manager WSRP Producer button in
the Import Portlet Definition (WSRP) dialog box.

The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

2

Opens the Edit WSRP Producer dialog box where you can
edit the WSRP produced definition.

x|

Deletes the corresponding WSRP producer entry.

Description The description of the WSRP producer.
Name The name of the WSRP producer.
Status Displays:
> & If the WSRP Producer URL is available.
> @ If the WSRP Producer URL is unavailable.
URL The URL of the WSRP producer.
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@ My BAC Page

Description Displays the pages set up for you by the Administrator.
Enables you to personalize pages, to add new pages to
the dashboard, and to add portlets to pages.

To Access: Select My BAC in the Business Availability
Center menu bar.

Important If a portlet contains no data, My BAC displays only the
Information portlet’s title bar.

You can set the cursor on a portlet’s title bar and drag
and drop the portlet in another location on the page.

Included in Tasks “Add Pages to Your Portal” on page 39

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

. The icon in the left top corner of the page indicates
e fh that the current page is a Shared page (icon with the
lock) or a private page (icon without the lock).

Click to display th i th t .
p . ick to display the previous page or the next page

Click the button, and select a page or a portlet to
display in the menu that opens.

Note:

Switch to page... *

» If you have not yet viewed a page, an orange box
appears to the left of the page name in the menu.

» My BAC remembers the last visited page, per
session, so when you display a specific page in
My BAC and access another application, the specific
page is redisplayed when you return to My BAC.
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GUI Element (A-Z) Description

<favorites toolbar> A toolbar to the right of the Switch to page and the
right-button.

L Filter page [ 2Change [ 3HP Page

The toolbar lists the pages that you have defined as
favorites using the Favorite button. The blank page
icon indicates a private page, the page with a lock icon
indicates a shared page, and the page with a globe icon
indicates a URL page created in the Manage Favorites
dialog box.

An orange box in the Switch to page menu indicates a
page or a portlet that you have not yet viewed since its
creation or since a change has been made to its
definition.

If a portlet definition has changed, the pages that
include the portlet are also assigned the orange box.

Note: The symbol disappears as soon as you open the
page for the first time.

A check mark indicates the current page in the Switch
to page menu.

Click to view the My BAC administrator’s comments
for the module in the <module-name> Module
Comments page.

The administrator uses the module comments to
inform users of changes to pages or portlets in the
module.

Click to open the Page Rotation dialog box, where you
can specify the rotation time and if you want the pages
to be displayed in pop-up mode. For details, see “Page

Rotation Dialog Box” on page 102.

Click to personalize your My BAC portal. For details,
see “Edit Page Dialog Box” on page 71.

Click to stop the rotation. For details, see above.

2 ([
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GUI Element (A-Z)

Description

=

When you want to add a portlet directly in the My BAC
page, click the button to open the Add Portlets dialog
box. This button is available only in private pages.

Click to select the following options:
> iiL:". Add to favorite. The page is added to the
tavorite’s shortcuts.
_4Change [ Filter page [ 3Discovery [ Mews
Click any icon in the favorite’s list to display the
corresponding page.

» Note: When you select more favorites than can fit in
the list, the additional favorites are listed below the
Favorites menu.

ﬁ_ Add To Favorites
'ﬁ' Manage Favorites
Lf Change

L] Mews

> 1% Manage favorites. Opens the Manage Favorites
page.

Shared Page

Indicates that the administrator has set the page’s
access status to Allow access to all users but did not set
Enable users to copy this module pages to their private
dashboard. For details, see “Configure Modules Dialog
Box” on page 50.

Stop

Appears in a page that is rotating.
Click to stop the rotation.
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Portlet Frame

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description
ﬂ Click to display help about a specific portlet.
Click to edit the portlet preferences. The portlet
ﬂ preferences are configured in HP Business Availability

Center. For details on a particular portlet’s preferences,
see “Troubleshooting and Limitations” on page 124.

ﬂ Click to open the edit portlet menu. Select one of the
following options:

» Edit. Select to open the Edit Preferences dialog box
where you can edit the portlet preferences.

> Edit Portlet Title. Select to open the Change Portlet
Title dialog box where you can edit the portlet title.

» Delete. Select to remove the portlet from the My
BAC page.

Click to maximize the portlet, so that My BAC displays
ol
the portlet across the two columns.

P Click to minimize the portlet, so that only the portlet’s
title bar is displayed. Click the button again to
redisplay the portlet.

Move the mouse over the button to display the filters
defined for the HP Business Availability Center report.

" Indicates that the trend of the calculated measurement
is up. For details, see “Create Measurement Dialog Box”
on page 207.

Indicates that the trend of the calculated measurement
is down. For details, see “Create Measurement Dialog
Box"” on page 207.

Indicates that the trend of the calculated measurement
is the same (no change). For details, see “Create
Measurement Dialog Box” on page 207.
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GUI Element (A-Z) Description
<context menu In some of the portlets, use the context menu options
options> to access other reports. For details on the context menu

options in Dashboard portlets, see “Customize
Dashboard Display and Refresh Rate” or “Top View
Menu Options” (for the Top View portlet) in Using
Dashboard.

Back Click to return the portlet to its original size (across
one column) after you have maximized it.

@ Page Rotation Dialog Box

Description Enables you to specify the rotation rate of the pages in
your My BAC application, and whether you want to
display the pages in popup mode.

=
To Access: In My BAC page, click @

Important A page that is rotated is automatically refreshed before
Information it is displayed. It is not refreshed during the period of
time it is displayed.

Included in Tasks “Personalize Your My BAC Portal - Workflow” on
page 39

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Full Screen Optionally, select Full screen to display each page of
My BAC in a pop-up page.

Interval Enter the page rotation time. For example, if you enter
15 seconds, each page defined in My BAC is displayed,
one after the other, every 15 seconds.
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@ Portlet Categories

Y Y Y Y Y Y Y Y VY Y

Different categories of portlets displaying different applications can be
added to My BAC pages and modules.

This different categories are:

“HP Business Process Insight Reports Portlets” on page 103
“CMDB” on page 104

“Dashboard” on page 106

“End User Management” on page 107

“General” on page 111

“HP TransactionVision Reports Portlets” on page 112
“Report Builders” on page 112

“SLM” on page 112

“SOA” on page 114

“System Availability Management” on page 116

HP Business Process Insight Reports Portlets

Portlet Name Description

Business Flow Thresholds This portlet is deprecated for version 7.50.

To display the same information as the Business
Flow Threshold portlet, use the Status Snapshot
portlet. For details, see “Status Snapshot Portlet” on

page 118.
BPI Monitors Over Time Displays two graphs for each selected BPI Duration
Portlet Monitor CI or BPI Custom/Value Monitor CI. One
graph display the

average/minimum/maximum/weighted value or
duration of the selected CI over time. The other
graph display the violated instances of the CI over
time. For details, see “BPI Monitors Over Time

Report” in Using Dashboard.
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Portlet Name

Description

BPI Process Diagram

Displays the process diagram of a BPI business
process that corresponds to the selected CI. For
details, see “Business Process Diagram Portlet” on
page 49.

Business Process Over
Time Portlet

Displays over time information about the volume,
backlog, and health of the selected Business Process
CI. For details, see “Business Process Over Time
Report” in Using Dashboard.

Business Process Summary
Portlet

Displays summary data for the selected Business
Process Cls. For details, see “Business Process
Summary Report” in Using Dashboard.

CMDB

Portlet Name

Description

Changed Applications

Displays the number of detected changes in
applications within a defined period. For details, see
“Changed Applications Report” in Model
Management.

Changed Views

Displays a bar graph showing the number of
changes that occurred in a specific view within a
defined period. For details, see “Changed Views
Report” in Model Management.

CMDB Overview

Displays general CMDB statistics. For details, see
“CMDB Utilization Report” in Model Management.

Database Breakdown

Displays a pie chart showing the breakdown of
database types and versions. For details, see
“Database Breakdown Report” in Model
Management.

Delete Candidates

Displays a bar graph showing the Cls and
relationships that were deleted within a defined
period and the ones that are about to be deleted.
For details, see “Delete Candidates Overview
Report” in Model Management.
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Portlet Name

Description

Discovery Job Statistics
Report

View the ten Discovery jobs that have the highest
number of errors. For details, see “Discovery Job
Statistics Report” on page 70.

Discovery Job Errors
Report

View statistics for the ten most active Discovery
jobs (that is, those with the most created, removed,
or updated operations). Click a job to drill down to
view statistics on the job’s CIT. For details, see
“Discovery Job Errors Report” on page 69.

Host O/S Breakdown

Displays a breakdown of operating systems. You can
view all deployed operating systems or you can
view data for operating systems at a certain location
or running on a certain subnet. For details, see
“Host OS Breakdown Report” in Model Management.

Major Application Type
Breakdown

Displays a breakdown of major applications and
their versions. You can view all applications
deployed in the system or you can view data for
applications at a certain location. For details, see
“Major Application Type Breakdown Report” in
Model Management.

Network Device

Displays a breakdown of network devices and their

Breakdown manufacturers. You can view all network devices
deployed in the system or at a certain location. For
details, see “Network Device Breakdown Report” in
Model Management.

Number of Changes Displays a bar graph showing the number of

detected changes in a CIT within a defined period.
You can also view the breakdown of the types of
changes that occurred for the CIT and its
descendants. For details, see “Number of Changes
Report” in Model Management.
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Dashboard

Portlet Name Description

Console Displays the components of the active Dashboard
view organized into the same hierarchy tree format
that you defined for the Cls in Dashboard
Administration. For details, see “Console Page” in
Using Dashboard.

Custom Map Displays a map for the selected view with the view's
CIs represented by real-time status indicators and a
background custom image that describes the real
world that your view represents. For details, see
“Custom Map Page” in Using Dashboard.

Filters

Displays, in a flat non-hierarchical way, the CIs that
match the following criteria: they belong to the
selected view, and at least one of their KPIs has the
status specified in the active filter. For details, see
“Filters Page” in Using Dashboard.

Geographical Map

Displays, on a geographical map, real-time status
indicators at the geographical location assigned to
the view's CIs. The status indicator shows the worst
status of the CIs at the geographical location. For
details, see “Geographical Map Page” in Using
Dashboard.

KPIs Distribution Over
Time

Displays the distribution over time of the status of
selected CIs and KPIs. For details, see “KPIs
Distribution Over Time Report” in Using Dashboard.

KPIs Over Time

Displays the status or value, over time, of selected
CIs and KPIs. For details, see “KPIs Over Time
Report” in Using Dashboard.

KPls Summary

Displays the statuses summary of selected ClIs and
KPIs accessible from the Dashboard application. For
details, see “KPIs Summary Report” in Using
Dashboard
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Portlet Name

Description

KPIs Trend

Displays the statuses trend of selected CIs and KPIs
accessible from the Dashboard application. For
details, see “KPIs Trend Report” in Using Dashboard.

Status Snapshot

Displays gauges that indicate the operational status
of business components. For details, see “Status
Snapshot Portlet” on page 118.

Top View

Displays CI bars that represent real-time IT
performance metrics mapped onto business
applications, linked by lines that represent
relationships between CIs. For details, see “Top View
Page” in Using Dashboard.

Topology Map

Displays a topology map that represents a pattern or
an instance view (defined in View Manager) with
the view's CIs and relationships. For details, see
“Topology Map Page” in Using Dashboard.

End User Management

Portlet Name

Description

End User - Least Available
Locations

Displays least available locations for Business
Process Monitor across all profiles, for the last day.
This portlet displays one graph from the End User
Management Status Snapshot. For details, see
“Snapshot Viewer Page” in Using End User
Management.

End User - Least Available
Transactions

Displays least available transactions for Business
Process Monitor across all profiles, for the last day.
This portlet displays one graph from the End User
Management Status Snapshot. For details, see
“Snapshot Viewer Page” in Using End User
Management.
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Portlet Name

Description

Real User End Users by
Page Summary

Displays data for a selected Web page configured for
Real User Monitor in End User Management
Administration, broken down by end-user groups.
For details, see “End Users by Page Report” in End
User Management.

Real User End Users by
Transaction Summary

Displays general, availability, total performance, net
performance, or server performance data for each
end-user group that ran the transaction you
selected. For details, see “End Users by Transaction
Report” in End User Management.

Real User Event Analysis
by End User Groups

Displays data for a selected event type, broken
down by end-user groups. For details, see “Event
Analysis Report” in End User Management.

Real User Event Analysis
by Pages

Displays data for a selected event type, broken
down by pages. For details, see “Event Analysis
Report” in End User Management.

Real User Event Analysis
by Servers

Displays data for a selected event type, broken
down by servers. For details, see “Event Analysis
Report” in End User Management.

Real User Monitor - Least
Available Applications

Displays least available applications for Real User
Monitor for the last day. This portlet displays one
graph from the End User Management Status
Snapshot. For details, see “Status Snapshot” in Using
End User Management.

Real User Monitor -
Slowest Applications

Displays slowest applications for Real User Monitor,
for the last day. This portlet displays one graph from
the End User Management Status Snapshot. For
details, see “Status Snapshot” in Using End User
Management.

Real User Monitor
Application Errors
Summary

Displays a summary of application errors in
monitored applications, configured in End User
Management Administration. For details, see “Pages
with Most Errors” in Using End User Management.
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Portlet Name

Description

Real User Monitor Event
Count

Displays data for all events, or sessions with events,
in monitored applications, broken down by time
intervals. For details, see “Event Count Over Time
Report” in Using End User Management.

Real User Monitor HTTP
Errors Summary

Displays a summary of HTTP errors in monitored
applications, configured in End User Management
Administration. For details, see “Pages with Most
Errors” in Using End User Management.

Real User Monitor
Informational Events
Summary

Displays a summary of informational events in
monitored applications, configured in End User
Management Administration. For details, see “End
User Summary Report” in Using End User
Management.

Real User Monitor
Performance Events
Summary

Displays a summary of performance events in
monitored applications, configured in End User
Management Administration. For details, see “Event
Summary Report” in Using End User Management.

Real User Page Availability
Over Time

Displays details of the availability for the selected
Web page over the course of time. For details, see
“Page Over Time Report” in Using End User
Management.

Real User Page Breakdown
Over Time

Displays details of the breakdown for the selected
Web page over time. For details, see “Page Over
Time Report” in Using End User Management.

Real User Page Hits
Availability Over Time

Displays details of the hits availability for the
selected Web page over time. For details, see “Page
Over Time Report” in Using End User Management.

Real User Page
Performance Over Time

Displays details of the performance for the selected
Web page over time. For details, see “Page Over
Time Report” in Using End User Management.

Real User Page Summary

Displays data for specific Web pages that were
configured for Real User Monitor in End User
Management Administration. For details, see “Page
Summary Report” in Using End User Management.
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Portlet Name

Description

Real User Server Over
Time

Displays a graph and table of the server’s page hits
and availability over time. For details, see “Server
Over Time Report” in Using End User Management.

Real User Server Summary

Displays data for specific Web pages on the server
that were configured for Real User Monitor in End
User Management Administration. For details, see
“Page Summary Report” in Using End User
Management.

Real User Transaction
Availability Over Time

Displays details of the availability for the selected
transaction, over time. For details, see “Transaction
Over Time Report” in Using End User Management.

Real User Transaction
Breakdown Over Time

Displays details of the breakdown for the selected
transaction, over time. For details, see “Transaction
Over Time Report” in Using End User Management.

Real User Transaction Hits
Availability Over Time

Displays details of the availability for the selected
transaction, over time. For details, see “Transaction
Over Time Report” in Using End User Management.

Real User Transaction
Performance Over Time

Displays details of the performance for the selected
transaction, over time. For details, see “Transaction
Over Time Report” in Using End User Management.

Real User Transaction
Summary

Displays data for specific transactions that were
configured for Real User Monitor in End User
Management Administration. For details, see
“Transaction Summary Report” in Using End User
Management.

Triage Report - Error
Details

Displays error details for Business Process Monitor.
For details, see “Triage Report” in Using End User
Management.

Triage Report - Error
Summary

Displays a summary of errors organized by error
type for Business Process Monitor. For details, see
“Triage Report” in Using End User Management.

Triage Report - Raw Data

Displays raw data information for Business Process
Monitor. For details, see “Triage Report” in Using
End User Management.
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Portlet Name

Description

Triage Report -
Transaction Breakdown

Displays a breakdown over time of response time
data for Business Process Monitor. For details, see
“Triage Report” in Using End User Management.

Triage Report -
Transaction Group by
Location

Displays an in-depth picture of the performance of
transactions grouped by locations for Business
Process Monitor. For details, see “Triage Report” in
Using End User Management.

General

Portlet Name

Description

HTML Portlet

Displays any HTML content. For details, see “Use an
HTML Portlet” on page 43.

RSS Portlet

RSS (Really Simple Syndication) is an XML-based
format for sharing and distributing Web content,
such as news headlines. For details, see “RSS Portlet”
on page 117.

Welcome to My BAC
Application

Displays an introduction to the My BAC
Application. For details, see “Welcome to My BAC
Application Portlet” on page 124.
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HP TransactionVision Reports Portlets

Portlet Name

Description

Business Transaction Over
Time

Displays over-time numerical or financial metrics
for a selected business transaction from

HP TransactionVision. For details, see “Business
Transaction Over Time Report” in Using Dashboard.

Business Transaction
Summary

Displays numerical and financial metrics for
selected business transactions from

HP TransactionVision. The metrics are shown
broken down by different transaction state
categories, such as failures or delays. For details, see
“Business Transaction Summary Report” in Using
Dashboard.

Report Builders

Portlet Name

Description

Custom Query Builder

Displays a table of data retrieved from the database,
answering to a Generic Reporting Engine API query.
For details, see “Custom Query Builder” in Reports.

Service Report

Displays a personalized table report constructed
over several data sources. For details, see “Service
Report” on page 129.

SLM

Portlet Name

Description

SLA Status Portlet

Displays the SLA forecast status for the end of a
calculation period, compared with the current SLA
status. For details, see “SLA Status Report” in Using
Service Level Management.

SLA Summary Portlet

Displays a list of SLAs and their statuses, filtered by
KPI, time interval, calendar, time period. For details,
see “SLAs Summary Report” in Using Service Level
Management.
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Portlet Name

Description

SLM CI Impact Portlet

Displays the results for a CI across all SLAs in which
the CI is defined, filtered by KPI, time interval,
calendar, time period. For details, see “CI Impact
Report” in Using Service Level Management.

SLM CI Status Portlet

Displays the results for a CI and its descendants. For
details, see “CI Status Report” in Using Service Level
Management.

SLM CI Summary Portlet

Displays a summary of all CIs for a specific SLA. For
details, see “CI Summary Report” in Using Service
Level Management.

SLM Cls Over Time Portlet

Displays Cls over a time period, for a selected SLA.
For details, see “CIs Over Time Report” in Using
Service Level Management.

SLM Cls Over Time vs.
Target Portlet

Displays defined targets superimposed on the data
of CIs for a selected SLA. For details, see “CI Over
Time vs. Target Report” in Using Service Level
Management.

SLM Outage Breakdown
Portlet

Displays breakdown of all outages for selected CIs
for one SLA, for specific calendar. For details, see
“Outage Breakdown Report” in Using Service Level
Management.

SLM Outage Summary
Portlet

Displays the periods of time during which
measurements (transaction, monitor, sample) failed,
that is, did not meet criteria defined in the KPI's
business rule. For details, see “Outage Summary
Report” in Using Service Level Management.

SLM Outages Distribution
Portlet

Displays a distribution of outages for selected ClIs.
For details, see “Outage Distribution Report” in
Using Service Level Management.

SLM Time Range
Comparison Portlet

Displays the status of four levels of CIs: a CI's status
(can be an SLA) and the statuses of the ClI's children,
organized by time range, for a selected KPI and
calendar. For details, see “Time Range Comparison
Report” in Using Service Level Management.

113



Chapter 1 « My BAC

114

Portlet Name

Description

Worst-Performing SLAs -
Current Periods Portlet

Displays the latest status of the ten worst-
performing SLAs. For details, see “Current Periods
Pane” in Using Service Level Management.

Worst-Performing SLAs -
Previous Periods Portlet

Displays the worst-performing SLAs for the past six
months. For details, see “Status Snapshot Report” in
Using Service Level Management.

SOA

Portlet Name

Description

Least Active Web
Service/Operation

Displays the five Web services/operations that
received the lowest number of calls (that is, were
least used), during the selected time frame of the
report. For details, see “Top Metrics Report” in
Solutions and Integrations.

Least Available Web
Service/Operation

Displays the availability of the five Web
services/operations with the lowest availability,
during the selected time frame of the report. For
details, see “Top Metrics Report” in Solutions and
Integrations.

Most Active Web
Service/Operation

Displays the five Web services/operations with the
highest number of calls, during the selected time
frame of the report. For details, see “Top Metrics
Report” in Solutions and Integrations.

Slowest Web
Service/Operation

Displays the five slowest Web services/operations in
the selected time frame of the report. For details, see
“Top Metrics Report” in Solutions and Integrations.

SOA Consumer Summary

Displays specific metrics for all of the consumers
accessing the selected Web services or operations in
a selected view. For details, see “Consumer
Summary Report” in Solutions and Integrations.
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Portlet Name Description

SOA Metrics Over Time Displays the performance, over time, measuring
access to selected Web services or operations, by a
server, or a consumer. For details, see “Metrics Over
Time Report” in Solutions and Integrations.

SOA Server Summary Displays the health metrics for all of the servers on
which the selected Web services or operations are
running. For details, see “Server and Endpoint
Summary Report” in Solutions and Integrations.

SOA Worst Consumers Displays the successful and faulty calls of the worst
five consumers accessing the selected Web services,
operations, or servers. For details, see “Consumer
Summary Report” in Solutions and Integrations.

SOA Worst Servers Displays the successful and faulty calls of the worst
five servers accessing by the selected Web services,
operations, or consumer. For details, see “Server and
Endpoint Summary Report” in Solutions and

Integrations.
Web Service/Operation Displays the five Web services/operations with the
With Most SOAP Faults largest number of received SOAP faults, during the

selected time frame of the report. For details, see
“Top Metrics Report” in Solutions and Integrations

Web Service/Operation Displays the five Web services/operations with the
With Slowest Number of highest number of slow calls, in the selected time
Calls frame of the report. For details, see “Top Metrics

Report” in Solutions and Integrations

Web Services/Operations Displays health metrics for the selected Web
Health Summary services, or operations in a selected view. For details,
see “Health Report” in Solutions and Integrations.
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System Availability Management

Portlet Name Description

Cross-Performance Report | Displays infrastructure machine-related data,
collected by the SiteScope data collector, from more
than one SiteScope server filtered by monitored
servers, monitor types, and measurements. For
details, see “Cross-Performance Report” in Using
System Availability Management.

@ Portlet Privilege Dialog Box

Description Enables you to select the applications for which you
have a license.

To Access: In the pages and dialog boxes of My BAC,
click the privilege button E

Important For details on defining privileges, see “User
Information Management — Overview” in Platform Administration.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Available/Selected Move privileges from the Available area to the Selected
area to select them.

Change Order Click to change the order of the privileges in the
Selected area.

Find Enter the first letters of the privilege name and click
the button to display all the privileges whose name
starts with those letters.

Privilege name starts | Enter the name of the application, or the first letters of
with the application name for which you have a license and
click Find.
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@ RSS Portlet =l 2l o]
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nwvent
Surwey: Business Continuity and Auvailability
Zolutions a High Priotity for Corporate
Spending in 2007
Findings reveal 18 percent of enterprises, 31
percent of small busineszes have no business
continuity plan
HP to Acquire Tabblo, Aims ta Make Printing
from Web Easier

HP today announced it has signed 2 definitive
agreerment to acquire Tabblo Inc, a privately-
held developer of web-based software located
in Cambridge, Mass,

HP Showcases Technalogy to Help Federal
Agencies Transform IT Environrments

HF today announced technolagy solutions
dezigned to help U.S. federal agencies
rnanage and transform their IT environrments
to optimize outcomes, lower costs, increase
security and mitigate risks,
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Description Displays a Real Simple Syndication (RSS) feed: RSS is an
XML-based format for sharing and distributing Web
content, such as news headlines.

The My BAC RSS parser supports RSS versions 1 and 2.
To view RSS portlets, HP Business Availability Center
must have access to the Internet.

To Access: Add the RSS portlet to a page.

Important The procedure for adding an RSS portlet is different

Information than that for adding other portlets. For details, see RSS
Area in “Edit Preferences <portlet_name> Dialog Box”
on page 75.
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@ Status Snapshot Portlet

118
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Description

Displays gauges that indicate the operational status of
business components. Each gauge represents the status
and/or value of the selected KPIs of the selected view’s
CIs.

For example, the portlet offers the capability to show
the most important business processes with all their
KPIs, to display KPIs that are becoming critical.

To Access: Add the Status Snapshot portlet to a page.

Important
Information

The portlet is refreshed automatically every 30 seconds.

Customization: To change the default refresh rate,
select Admin > Platform > Setup and Maintenance >
Infrastructure Settings, choose Applications, select
Dashboard Application, and modify the value of the Ul
Refresh Rate entry in the Dashboard Application -
Refreshers table.

Note:

» KPIs with no status (No data, Info, Downtime) are
not displayed.

» A CI whose KPIs have no status are not displayed.
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The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

<Cl> The icon and name of the selected CI.

The selected KPIs of the selected ClIs are displayed in
the portlet. A horizontal line separates the CIs in the
portlet display.

Note: A vertical scrollbar is automatically displayed in
the portlet if the number of CIs and KPIs you selected
does not fit in the portlet display area. When gauges do
not fit in the portlet frame horizontally, the line is
wrapped.

The location of KPIs in the display may not be
consistent with other CI's KPIs as not all CIs have the
same KPIs. When CIs have the same KPIs, the same
KPIs are aligned vertically in the portlet one under the
other for each CI, but there are no placeholders for
missing KPIs.

For example, when the CI1, CI2, and CI3 CIs are
assigned the KPI1, KP12, and KPI3 KPIs, the portlet
displays the following order:

cn KPI1 KPI2 KPI3
Cl2 KPI1 KPI2 KPI3
CI3 KPI1 KPI2 KPI3
For example, when the CI1 and CI3 CIs are assigned
the three KPIs, while the CI2 CI is assigned only the

KPI1 and KPI3 KPIs, the portlet displays the following
order:

cn KPI1 KPI2Z KPI3
Cl2 KPI1  KPI3
Ci3 KPI1 KPI2 KPI3
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GUI Element (A-Z)

Description

<gauge display>

A status gauge uses a maximum of five colors that
correspond to the KPI statuses: Critical (red), Major
(orange), Minor (yellow), Warning (olive), and OK
(green). Depending on the threshold definition of the
KPI, the gauge might show less than five colors. For
more information about the KPI statuses, see “Colors of
KPI Statuses Used in Dashboard” in Using Dashboard.

The size of the colored sector that corresponds to a
specific status depends on the threshold value relative
to all the thresholds defined for the KPI.

A value gauge has the following characteristics:

» The minimum is always 0.

» The size of each slice (from 0 to 200 degrees) is
proportional to the threshold values except for the
last slice. The color of the last section on the right
corresponds to the threshold with the highest value.
The slice of the last slice is calculated as the <lower
bound of the slice>*110.

If, for example, the thresholds are:

OK< 8000, WARNING<12000, and CRITICAL for any
other value, the OK slice is from 0-8000, the
WARNING slice is from 8000-12000, the CRITICAL
slice is 12000-13200 (the upper bound of the slice is:
calculated as: 12000*110%= 13200).

When the actual value is greater than the calculated
upper bound of the slice, the upper bound is
corrected to the actual value*110. For example, if the
value is 16000 then the upper bound of the gauge is
16000*110%=17600.

» If the KPI's unit is percentages (%), the maximum
value of the KPI is 100% and the maximum possible
upper bound of the gauge is 100*110=110%.

For details about the way gauges display the data, see

“Gauge Calculation Examples” on page 122
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GUI Element (A-Z)

Description

<KPI>

Each KPI status or value is displayed on a gauge.

Default: The Availability and Performance KPIs are

displayed.

The KPIs are ordered, from the left to the right,
according to their Display Order as defined in the
Repositories. For details, see “KPIs Repository Page” in

CI Attribute Customization.

The value or status, name, and unit of the KPI are listed
below the gauge. The needle on the gauge indicates the

value or status of the KPI.

<tooltip>

Move the mouse over a gauge to display a tooltip that
provides more information about value represented by
the needle and other information. The tooltip is similar

to tooltips in the Console tab.

+ % Rum Errors

CI name:
Volume:

Status:
Calculation Rule:
n Held status since:
Major:

31 Minor:

Warning:

OK:

Details - Volume

rum errors

o

Ok

Sum of Volume
1/27/08 05:05:44 AM
<= 6.0

<= 6.0

== 1.0

<= 0.0
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Gauge Calculation Examples

The table below display examples of calculation of a gauge maximum:

Thresholds & KPI Value

Display

Thresholds = {8, 12} where [0,8] is green, [8,12]
is yellow, above 12 is red.
KPI Value = 5

The gauge maximum is calculated as:
12*110% =13.2=>13

Thresholds = {8, 12} where [0,8] is green, [8,12]
is yellow, above 12 is red.

KPI Value = 12.5

The gauge maximum is calculated as:
12*110% =13.2=>13

The KPI value is in the red section but still lower
than the maximum

13
12.5

Thresholds = {8, 12} where [0,8] is green, [8,12]
is yellow, above 12 is red.

KPI Value = 24

The gauge maximum is calculated as:
12x 110% =13.2 =>13

The KPI value exceeds the maximum so the
maximum becomes the value of the KPI + 10%
=>26.4=>26

12

26
24
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Thresholds & KPI Value Display

Thresholds = {25%, 50%)} 50%
KPI Value = 24% 2500

Although the upper threshold is 50%, the
maximum is 100% (and not 50+10% = 55%) 100%
because the units are percentages (%). 24%0

Thresholds = {25%, 50%}

5000
KPI Value = 117%

2500 100%
The KPI value is greater than 100% so we
calculate the gauge maximum as: 12004
117 + 10% => 128.7 => 129 1179

@ Users or Groups Dialog Box

Description Enables you to select users or groups.

To Access: In the pages and dialog boxes of My BAC,
click:

» The users button ﬂ

» The groups button E

Important For details on defining users and groups, select Admin
Information > Platform > Users and Permissions.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Available/Selected Move users or groups from the Available area to the
Selected area to select them.

Change Order Click to change the order of the users or groups in the
Selected area.
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GUI Element (A-Z) Description

Find Enter the first letters of a user or group of users name
and click the button to display all the users or groups
whose name starts with those letters.

Show All Click to display a list of all the available users or
groups.
User Enter the name of the user or the first letters of the user

or group of users name and click Find.

® Welcome to My BAC Application Portlet

Description The Welcome to My BAC Application portlet displays
an introduction to My BAC that explains how to work
with the My BAC application.

To Access: Add the Welcome to My BAC Application
portlet to a page.

Q, Troubleshooting and Limitations

This section includes My BAC troubleshooting and limitations.

HP Software Support

To facilitate diagnosis, customers reporting problems to HP Software
Support are required to provide a simple, reproducible case that
demonstrates the error in the My BAC portal.

CMDB Portlets

To view the CMDB portlets and the CMDB category in the list of available
portlets, you must have performed the procedure described in “Set Up
CMDB Portlets” on page 30.
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Access to a Portlet Definition

Access is given, by default, to all users and all administrators. If you assign
access rights to specific users or security groups, or to specific
administrators, My BAC removes the All Users or All Portlet Definition
Administrators security type from the list and replaces the type with the user,
security group, or administrator you chose.

WSRP Portlets

To be able to view HP Business Availability Center WSRP portlets, a user
must, at least once, login to the HP Business Availability Center application
and open the My BAC application every time HP Business Availability
Center has been restarted.

Troubleshoot the Deployment of External Custom Java
Portlets

I have HP Business Availability Center configured in a cluster. What else do |
need to do to use my custom Java portlet?

“Deploy External Custom Java Portlets” on page 33 describes how to deploy
a custom portlet on a single Gateway server. Multiple Gateway servers must
each have access to the custom portlet code. Therefore, you must repeat the
steps outlined in “Deploy External Custom Java Portlets” on page 33 to
deploy your Java portlet to each distinct Gateway server file system.

Or, as a shortcut, copy your web archive directory to the corresponding
location on each Gateway server, and update each Gateway server's
java_portlets.xml file accordingly.

If | need to make changes to my Java portlet after it is imported into

HP Business Availability Center Dashboard, do | need to re-import it?
Delete the portlet definition from HP Business Availability Center. For
details, see “Configure Portlet Definitions Dialog Box” on page 59. Then,
stop and restart HP Business Availability Center and re-import the portlet
definition. For details, see “Import Portlet Definition Wizard” on page 87.
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> If | need to make changes to my Java portlet after it's imported into
HP Business Availability Center Dashboard, do | need to stop and restart the
Gateway server?
If your portlet uses JSPs, you can make modifications to the JSPs without
needing to restart the Gateway server.

If you change the portlet's Java code, any of the descriptor files, or if you re-
deploy your portlet's war file, you must stop and re-start the Gateway server.

IMPORTANT: JBoss's hot-deploy feature is not compatible with the Pluto
portal. If you hot-deploy the portlet, it stops working for all of your users
until you restart the Gateway server.
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Service Report

This chapter provides information on the Service Report.

This chapter includes:

Concepts

Service Report Overview on page 130
Dimensions and Measurements on page 130
Service Report Formats on page 134

Status Function Automatic Measurements on page 137

Y VY Y VY Y

Tips and Tricks on page 139

Tasks

Configure a Service Report Portlet in My BAC — Workflow on page 142
Configure a Service Report in Report Manager — Workflow on page 147

Configure a Service Report — Scenario on page 149

Y VY VY Y

Create a Customized Measurement on page 157
Reference
» Service Report User Interface on page 160

Troubleshooting and Limitations on page 217
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& Service Report Overview

Service Reports are custom reports that display selected data from data
sources of the Service Level Management, Dashboard, or other applications.

You can create a Service Report by:

Adding the Service Report portlet to a page or a module in My BAC and then
configuring the portlet. For details, see “Configure a Service Report Portlet
in My BAC - Workflow” on page 142.

Creating a Service Report in Report Manager. For details, see “Report
Manager Main Page” in Reports. The Service Report can then be added to a
custom report in Report Manager. For details about adding components to a
custom report, see “Configure a Service Report in Report Manager —
Workflow” on page 147.

Note: Service Reports created in My BAC are independent from Service
Reports created in Report Manager: when you create a custom report, you
see only the Service Reports created in Report Manager.

& Dimensions and Measurements

130

The Service Report uses data from the CMDB and Profile databases
corresponding to the data source of the different applications. These
databases are configured for Online Analytical Processing (OLAP) and
employ a multidimensional data model. The multidimensional data model
creates a matrix of measurements and dimensions (cube) that maps and
links them in a specific way for each application.

This section includes the following topics:

“About Dimensions and Measurements” on page 131

» “Impact of the Dimensions/Measurement Selection on the Report Structure”

on page 132
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» “Impact on the Type of Selection: Single Selection or Multiple Selection” on
page 132

About Dimensions and Measurements

When you configure a Service Report as a portlet in My BAC or as a
component in a custom report, you specify the source of the data, and you
select the data source dimensions and measurements that you want to
display in the report.

For example, when you create an SLA in Service Level Management, you
specify the properties, such as SLA name, customer, and provider, that you
use to get information about the status of the SLA. All the properties can be
used as dimensions in Service Reports for the Service Level Management
application. For details, about the SLA properties, see “Agreement Wizard”
in Using Service Level Management.

The measurements that are available depend on the data source and on the
data source dimensions that you selected. The measurements are the
parameters of the dimensions. For example, the measurements of the SLA
dimension are the attributes of the SLA: Customer, Provider, Value,
Obijectives, and so on.

When you select one or more data sources in the Service Report wizard, the
dimensions and the measurements are linked by a map. Those links have an
impact on the elements that you can select when building the report and on
the possible location of those elements in the report. For details about the
maps, see the “Impact of the Dimensions/Measurement Selection on the
Report Structure” on page 132.

Note: When you select more than one data source in the Service Report
Builder wizard, the dimensions and measurements maps are combined.
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132

Impact of the Dimensions/Measurement Selection on the
Report Structure

Some measurements automatically assume a specified position (row header,
column header, orthogonal) in the Service Report; for example in the
Service Level Management - SLA Status Data data source, the SLA Overall
Status measurement has a one-to-one link to the SLA dimension and is
automatically orthogonal to the SLA dimension in the report. Special maps
provide the relationships between dimensions and measurements. For
details, see the map sections in “Select a Data Source Page” on page 166.

Other measurements (such as Forecast Status, or SLA Breached Date) have a
one-to-many relation with multiple dimensions. In addition they are linked
to the same dimensions (they are in the same box in the map; see “Impact
of the Dimensions/Measurement Selection on the Report Structure” on
page 132). Therefore, they do not have an automatic position in the report,
and you must select where you want them to be displayed by selecting As
column headers or As row headers.

Impact on the Type of Selection: Single Selection or
Multiple Selection

If you select a dimension (SLA) and a measurement (SLA Overall Status) that
are simply linked to each other in the dimensions and measurements map,
the Dimensions Filter displays a multiple-selection for the SLA dimension.
This is because there is only one customer for each SLA. The values you can
select from are the available SLAs.

Mandatory Dimensions:

AL Select Fram: ISLAS vl

SLA=

SLA - all zervices
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If you select a measurement (SLA Forecast Status) that is linked to several
dimensions in the map (Forecast Based on Tracking Period, SLA, and
Tracking Period) and you have selected only one dimension (SLA) in the
Dimensions Selection page, the Dimensions Filter displays all the other
dimensions that are mapped to the measurement. For details about the map,
see “Service Level Management - SLA Status Data Dimensions and
Measurements Map” on page 172.

This is because of the multidimensional data model of the databases where
the data is located. To access the SLA Forecast Status measurement data
relevant to the SLA dimension that you selected, you must also provide the
values for the other dimensions in the data model.

The dimension you selected in the Select Dimensions page (SLA) is multi-
selection and you must make a choice from among the available
dimensions. Each of the other dimensions linked to the selected
measurement is single-selection (fixed dimension).

Mandatory Dimensions:

sLA ' Last Month
Forecast Based On  Last Cay
Tracking Period r
Last Wear
Tracking Period
' Last Quarter
© Last week

7 Manth to date
' vearto date

' Quarter to date
 week to date

Multi-selection is different for each dimension.
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& Service Report Formats

You can format the Service Report by selecting columns and row headers, by
adding different column types in the same table, customizing the report
structure, adding calculated columns, and combining data from multiple
sources, such as SLM and additional data sources.

The Service Report can have the following format:

> Pivot table. You can use dimensions and measurements to create multiple
column or row headers and you can choose where to locate them in the
table. For example, a pivot table can have the following structure:

Status
Tinre Range 1 Exceaeded
CIi
Time Range2 Mo Data
Time Range1 Met
CI2
Time Range2 Minaor Breached

» Deeper hierarchy. You can select several dimensions to be the column
headers and more than one dimension to be the rows header. For example, a
deeper hierarchy table with 3 headers is as follows:

Time Rangel Time Range2

Event Count (#] Status Duration Event Count (#] Status Duration

KPI¥ 435 EL 20:50:00
CI1

KEIE 42 13:03:20 77 11:06:40

KPI1 i3 20:00:00 33 09:26:40

CIz

wnTn - A - e

» Measurements per dimension. For each dimension, you can select what you
want to display: values, status, objectives, background status color, and so
on. An example of such a table is as follows:

Time Rangel Time Rangel
Event Count (#] Status Duration Event Count (#] Status Duration

KPIY 435 L 20:50:00
CI1

KETR 42 13:03:20 77 11:06:40

KPI1 p i’ 20:00:00 55 09:26:40
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Note: In the regular cells of a table, numeric content is right-aligned and
text content is left-aligned. In header cells, the cell content is centered.

Charts. You can display the report as a Line, Pie, Area, Bar, or Stacked Bar
chart. You can also use the 3D and/or Flash technology to format the chart.
For example:

> 3D:

B CI/Servicel, KPI2

S,@g'}r‘ca]age (%) Cl/Servicel, KPI1

B CI/Service2, KPI1
B CI/Service2, KPI2

CI/Servicel, KPI1
B CI/Servicel, KPIZ
B CI/Service2, KPI1
B CI/Service2, KPI2

\\\\h EEEEEE 1 ClfService: 2 ClServiced CliService a

Cl'Service

\\\lér =1 Cl/Servica2 Cl/Servica3 CI/Servic

CI/Service
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Other Possible Structures
A Service Report can display:

» The value of the measurement:

Availability Performance
24x7 Business 24x7 Business
Hours Hours
CI1 90 80 90 70
CI2 10 20 10 30

» The status of the measurement:

Availability Performance
24x7 Business 24x7 Business
Hours Hours
CI1 Breached Minor Met Met
breached
CI2 Exceeded Met Exceeded Met

» Both the value and status of the measurement. You can choose between two
different structures:

» Vertical merge (select As column headers):

Availability Performance
24x7 Business Hours 24x7 Business Hours
Value | Status Value Status Value | Status Value | Status
cn 90 Breached | 80 Minor 90 Met 70 Met
breached
CI2 10 Exceeded | 20 Met 10 Exceeded | 30 Met
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Availability Performance
24x7 Business 24x7 Business
Hours Hours
CI1 Value 90 80 90 70
Status Breached Minor Met Met
breached
CI2 Value 10 20 10 30
Status Exceeded Met Exceeded | Met

& Status Function Automatic Measurements

When you use the Status function to create a calculated measurement, the
following additional measurements are automatically created:

» <Compare_measurement_selection> (<new_measurement_name> as
background). This measurement displays the value of the measurement you
selected in the Compare measurement list and the status of the
measurement when compared to the thresholds you selected in To
threshold as the background color for the cell in the table.

SLA1

SLAZ

CI/Servicel

KPI1
KPIZ

£l fEervice?

KPI1
KPI2

22
24
90

38
47
S1

50
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> <new_measurement_name>. This measurement displays the status of the
measurement you selected in the Compare measurement list when
compared to the thresholds you selected in To threshold as the name of the

threshold.
S5LA1l SLAZ
KPI1 Excesded Failed
CI/Servicel
KPIZ Exceeded Failed
KPI1 Exceeded Exceeded
CI/Service 2
KPI2 Exceeded Exceeded

» <new_measurement_name> (<new_measurement_name> as background).
This measurement displays the status of the measurement you selected in
the Compare measurement list when compared to the thresholds you
selected in To threshold as the name of the threshold and as the background
color for the cell in the table.

SLA1 SLAZ
KPI1 Exceadead Exceaded
CI/Servicel
KPI2 Exceeded (Failed
KPI1 Exceaded Exceaded
CI/Seriice 2

> <new_measurement_name> as background. This measurement displays the
status of the measurement you selected in the Compare measurement list
when compared to the thresholds you selected in To threshold as the
background color for the cell in the table.

SLAL SLAZ
kP11 I
CI/ Service1 KPI2
k11 I R
ol fservice2 KPIZ
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& Tips and Tricks

This section includes tips and tricks that you can use when creating a Service
Report.

General

» Selecting the Enable automatic preview option is very useful to see the
changes you make to the report before you generate the report.

» Click CTRL and use the mouse to perform a multi-selection of dimensions or
measurements.

» When you create a service report based on the Service Level Management
data sources, you can display data for the Targets measurements, only if all
the ClIs included in the same SLA have the same threshold. Data is displayed
if all the thresholds are linked to the SLAs, Cls/Services, and KPlIs
dimensions, and if all the Calendar and Target measurements, are the same.

» After you have created a service report, you can clone it by copying and
pasting it in the tree of pages. For details, see “Edit Page Dialog Box” on
page 71. For an example of why you might clone a service report, see
“Example — Create a Service Report That Displays as a Chart” on page 144.
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Select Dimensions Page

It is recommended, when creating a service report, to distribute the
dimensions between the Rows and the Columns. In the measurement maps,
check the dimensions that are linked to the measurements you are selecting.
Then try to distribute those dimensions between the rows and columns. For
example, if you want to display the KPI Value and All Targets measurements
and you have selected the Calendar, Cl, and SLA dimensions, it is
recommended not to have Cl and SLA both in rows or columns but to have
one of them in rows and one of them in columns.

Calendari Calendar2 All Targets
SiEFRL 23 45 All Targets1
CI1
SLAZ &8 a2 All Targetsz
SLA1 20 =¥ All Targetsz
CIZ2
SLAZ 22 59 All Targets4
o1l CI2

Calendari Calendar2 Calendarl Calendar2

KPI Valua®, Bl Targets | KPI Value | All Targets | KPIValue | All Targets | KPI Value | All Targets
SLA1 is All Targets1 29 All Targets1 &2 All TargetsZ 52 All Targets=
SLAZ =, All Targets2 & All Targets2 0O All Targets4 28 All Targets4

Reports where you have moved the majority of the dimensions to the
Columns box are wide, which might cause printing problems. Reports where
you have moved the majority of the dimensions to the Rows box are long.

If you have selected the SLAs and Calendar dimensions, and you want to
display data for lots of SLAs, it is recommended to set SLAs in Rows and
Calendar in Columns. If vice versa, you want to display data for lots of time
intervals for a limited number of SLAs, it is recommended to set SLAs in
Columns and Calendar in Rows.
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Select Measurements Page

To create a narrower report, move the measurements to the Rows box if you
have moved the majority of the dimensions to the Columns box (or vice
versa). This way, a new measurement adds one more row to the report.

The order of the measurements in the Available Measurements box in the
Select Measurements page is by order of importance and not by alphabetical
order.

If you get the error message: Some of the selections are incompatible and
cause problems in the report structure (or Errors were encountered while
trying to build the report), change the order of the selected dimensions in
the Select Dimensions page or the order of the measurements in the Select
Measurements page. If that does not work, move the order of the selections
in the Rows and Columns boxes in the Select Dimensions page.

If you add a calculated measurement and regular measurements to a report,
the order of appearance of the measurements is always regular
measurements before calculated, independently of the order you selected in
the selection lists.

Calculated Measurement

It is important to add a meaningful description when you create a new
measurement because the description appears as a tooltip in the report and
to describe what the measurement represents: the measurements that are
used, the type of calculation, the dimension on which the calculation is
based, and so on. For example, the difference between the SLA KPI value and
the target Exceeded, compared by Time interval.

To ensure that you are using the Difference calculated measurement in the
correct way, it is recommended to add the measurements you selected in the
First measurement and in the Second measurement boxes to the report and
to verify that the Difference calculation is done in the correct order. If it
does not, switch the measurements you selected from the First
measurement to the Second measurement boxes and vice versa.
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> All dimensions that you did not select in the Select Dimensions page can be

used as the base for an aggregation measurement, but you do not have to
necessarily select multiple values in the Select Dimensions Filter page. For
example, you have selected the SLA and Cl dimensions in rows and the KPIs
in columns; you can perform an aggregation over the Time Interval or the
Calendar dimensions, which were not selected. In the Select Dimensions
Filter page, both dimensions are multi-selection, but you can select multiple
values for one dimension and one value for the other dimension; for
example, Last week and every one week.

Select Dimensions Filter Page

To immediately see the impact of adding other dimensions to a report, click
Preview or select the Enable automatic preview option. A mock-up of the
report is displayed in the page lower box.

T Configure a Service Report Portlet in My BAC - Workflow

142

Y Y Y Y Y

You can add a Service Report to a page or a module in My BAC. You
configure the Service Report using a wizard.

This task includes the following steps:

“Install Flash to Format the Report Using Flash Technology — Optional” on
page 143

“Add a Service Report Portlet to a Page or a Module” on page 143
“Change the First Day of Month Setting — Optional” on page 146
“Edit the Service Report Portlet” on page 143

“Change the First Day of Month Setting — Optional” on page 146
“Display the Service Report” on page 147
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1 Install Flash to Format the Report Using Flash Technology -

Optional

To render the Service Report charts using Flash you must have the
Macromedia Flash Player installed on your local machine. If you do not, the
browser displays a message containing instructions on how to download
Flash Player.

Add a Service Report Portlet to a Page or a Module

You can add a Service Report portlet to a page or to a module in My BAC. For
details, see “Add Portlets to <page_name>/Add Portlets Dialog Box” on
page 435.

Edit the Service Report Portlet

After you have added a Service Report portlet to a page or a module in
My BAC, you must configure the portlet.

In the Service Report portlet in the My BAC page, click the Edit portlet
preferences button to open the Edit Preferences <portlet_name> page. For
details, see “Edit Preferences <portlet_name> Dialog Box” on page 75.

In the page, you can:

Expand Advanced Settings and select the refresh rate for the portlet.

» Click the Change Title button to open the Change Title dialog box where

you can change the Service Report title.

Click Launch Service Report Builder to open the wizard that creates the
Service Report.

Use the Service Report Builder wizard to select the report format, the data
sources, the report format (table or chart), the dimensions and the
measurements, and the dimension filter that are used to create the Service
Report.

While creating the Service Report, you can also create new measurements
that you can immediately use in the report.

For details, see “Service Report Builder Wizard” on page 162.
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Example - Create a Service Report That Displays as a Chart
To create a service report that displays as a chart:

a Add a Service Report to the appropriate page in My BAC.

b In the page, click the Edit button for the Service Report porlet and then click
Launch Service Report Builder in the Filter area of the Edit Preferences page
to open the Service Report Builder wizard.

c In the Select a Display Type page, select Chart, Pie, and Flash chart.
d In the Select a Data Source page, select Dashboard KPIs data and click Next.

e In the Select Dimensions page, move Cl and KPI to the Slices box and click
Preview to display the structure of the report. The data and background
color are for illustration purposes only.

CI1, KPI1
CI1, KPIZ
B CI2, KPI1

//\ mCr2, kPI2
‘ '|

f Click Next to continue.

Status Percentage (%)

g In the Select Measurements page, select Event Count (#), and Status
Duration (hh:mm:ss). Click Preview to display the structure of the report.
The data and background color are for illustration purposes only.

CI1, KPI1
CI1, KPIZ
B CI2, KPI1
W CI2, KPIZ2

Event Count (#)

w

Status Duration (hh:mm:ss)

CI1, KPI1

h In the Dimensions Filter page, click:

» Cl, select the End User Monitor View, and select the relevant CIs.
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» Time Range, select Month to Date.
» Status, select Critical.
» KPI, select Availability and Performance.

Click Preview.

1, Availability

||m 1, Performance

W EPMIukr_galya, Availabi...

W BEPMIukr_galya, Performance
W BacTermplateRurnfpp, Avai..
W BacTermplateRumaApp, Perf...
B EBacTemplateRumApp2, Ava...
W BacTemplateRumapp2, Per...
Default Client QA COAL ..

i Click Finish to display the final report:

1, Awailability

Event Count (#) W 1, Performance

W BEPMIukr_galya, Availabi..,

W EPMIukr_galya, Performance

W BacTemplateRurmApp, Avaio.

M BacTemplateRumapp, Perf...

M BacTemplateRumApp2, Ava...

M BacTemplateRurmAppZz, Per..
Default Client_Qa_CoOaL_...

W Default Client_QA_COAL_...

W Cefault Client_Q4_E-Fin...

W Cefault Client_GA_E-Fin..,

W Cefault Client_Ga_SaP_1...

W Default Client_QA_SAP_1...

W Default Client_Ga_Sisbe...

W Default Client_Ga_Siebe...
Shaow all...

1, Availability

Status Duration Chh:mm:ss) W 1, Perforrmance

W EPMIukr_galya, Availabi..

W EPMIukr_galya, Performance

M BacTernplateRurmApp, Avai.
M BacTermplateRurnapp, Perf...

145



Chapter 2  Service Report

The same report in Bar format displays the following information:

hRimm:ss

450 &day
400 &day
350 Sday
300 4day
#* 250 dday
200 Fday
150 2day
100 1day
50 17haur
o |—|_| IT—|

& e 3N &g & 8 \\° \\° ® ae” \\° & @
3 § @& W& & & F 5 \\ \\b

FeP o
ﬁx&qﬁkoféseéséﬁé&é@é‘i,cé‘ipo O‘Q’\ G‘J’\ G"> 0‘;‘\ o@ o‘i\ g@“ &

CI, KPI

| Event Count Status Duration

4 Change the First Day of Month Setting - Optional

To change the first day of the month setting (Default is 1), select Admin >
Platform > Setup and Maintenance > Infrastructure Settings, choose
Foundations, select Calendar, and locate the First day of month entry in the
Calendar - Calendar Options table. Change the value to any value between 1
and 31.

Note: Changing the First Day of Month setting affects Service Reports and
all other Dashboard components.
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Example

The new first day of the month is reflected in a Service Report, after you
have changed the First day of month entry in the Infrastructure Settings to
2, and after you select in the Dimension Filter, a Time Range setting that
includes Every Month. For example, View=Last Year and Every=1 month
display the following results when First day of month=2:

EFF, Availab...
BFFP, Perform...

C1,KPI

2/5/2007 3/5/2007 4/5/2007 W 5/5/2007 W 6/5/2007 W 7/5/2007
W 5/5/2007 9/5/2007 10/5/2007 W 11/5/2007 W 12/5/2007 1/5/2008

5 Display the Service Report

To display the Service Report, access My BAC and select the page where the
Service Report portlet is located.

For details about the Service Report, see “Service Report” on page 161.

T Configure a Service Report in Report Manager -
Workflow

You can add a Service Report to the Report Manager. You configure the
Service Report using a wizard.

This task includes the following steps:

» “Install Flash to Format the Report Using Flash Technology — Optional” on
page 148

» “Configure a Service Report in Report Manager” on page 148
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148

» “Add a Service Report to a Custom Report” on page 148
» “Change the First Day of Month Setting — Optional” on page 149
» “Display the Service Report” on page 149

1 Install Flash to Format the Report Using Flash Technology -

Optional
To render the Service Report charts using Flash you must have the
Macromedia Flash Player installed on your local machine. If you do not, the

browser displays a message containing instructions on how to download
Flash Player.

2 Configure a Service Report in Report Manager

To configure a Service Report in Report Manager, select Applications > User
Reports > Report Manager and select New Service Report in the New menu,
to open the wizard that creates the Service Report.

Use the Service Report Builder wizard to enter the report information and
select the report format, the data sources, the report format (table or chart),
the dimensions and the measurements, and the dimension filter that are
used to create the Service Report.

While creating the Service Report, you can also create new measurements
that you can immediately use in the report.

For details, see “Service Report Builder Wizard” on page 162.

Add a Service Report to a Custom Report

Once a Service Report is available in Report Manager, you can add it to a
Custom Report. For details, see “Custom Reports Wizard” in Reports.
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Example - Create a Service Report for Online and for Print

If the Service Report portlet displays correctly online, but is too wide to be
printed, you can clone it. In the cloned report, you can change the location
of the dimensions or their order to create a printable report that includes the
same data as the online report.

4 Change the First Day of Month Setting - Optional

To change the first day of the month setting (Default is 1), select Admin >
Platform > Setup and Maintenance > Infrastructure Settings, choose
Foundations, select Calendar, and locate the First day of month entry in the
Calendar - Calendar Options table. Change the value to any value between 1
and 31.

Note: Changing the First Day of Month setting affects Service Reports and
all other Dashboard components.

For an example, see “Change the First Day of Month Setting — Optional” on
page 146.

5 Display the Service Report

To display the Service Report, select Applications > User Reports, click the
relevant Service Report and click .

P Configure a Service Report - Scenario

This scenario explains how to configure a Service Report in My BAC. The
report is based on the Dashboard KPIs data source.

This scenario includes the following steps:

> “Select the Display Type” on page 150
» “Select the Dashboard KPIs Data Source” on page 150

> “Select the Dimensions” on page 151
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> “Select the Measurements”

on page 152

» “Create a New Measurement” on page 152

» “Specify the Dimensions Filter” on page 154

» “Display the Service Report” on page 156

1 Select the Display Type

In My BAC, in the appropriate page, click the Edit button for the Service
Report portlet and then click Launch Service Report Builder in the Filter area
of the Edit Preferences page to open the Service Report Builder wizard.

In the Select a Display Type page, select Pivot Table.

2 Select the Dashboard KPIs Data Source
In the Select a Data Source page, select Dashboard KPIs data and click Next.

Select a Data Source

The Service Report is based on the selected data source dimensions and measurements.

Select at least one of the following data sources:

[~ Service Level Management - SLA KPI data

[~ Service Level Management - SLA Status data

Dashboard KPIs data

[T Business Process Insight data

[~ TransactionVision data

[~ Over Time Additional data

Provides the ClIs, KPIs, SLA, Time, and Calendar dimensions, and the KPI Value,
KFI Status, Additional Values and Objectives measurements.

Frovides the SLA, Tracking Period , "Based On" Tracking Period, and Time
dimensions, and the SLA Status for Previous Periods, SLA Current Status, SLA
Current Status By Time Period and SLA Forecast measurements.

Provides high-level analysis for business-related Cls, based on historical data
from the associated Dashboard KPIs.

Provides Business Process data from HP Business Process Insight.

Provide Business Transcation data from HP TransactionVision.

Provides additional data such as Number of tickets and Number of user
measurements, for Cls and Time range dimensions, from multiple data sources.
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3 Select the Dimensions
In the Select Dimensions page, select Cl and KPI as rows and Time Range as

column.

Select Dimensions
The Available Dimensions area lists the data source dimensions you selected in the Select a Data Source page.

Move the dimensions to the Columns or Rows area.

Dimensions in the Rows area appear as row

Available Dimensions:
Stat CI
=tus = KBL headers.
K]
[ § |
Columns:
Dimensions in the Columns area appear as
column headers.

Time Range

BN

Click Preview to display the structure of the report. The data and
background color are for illustration purposes only.

Time Rangel

Time Rangel
KR 08:03:20 —
CI1
KPI2 23:53:20
KPI1 1 day, 2 hours 15:00:00 -
13 -
b
ATz XN 4

Click Next to continue.
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4 Select the Measurements

In the Select Measurements page, select the measurements as follows

Available Measurements: Selected Measurements:

Status Percentage [%) Event Count (]

Status Percentage (%, Status as background) Status Duration (hh:mm:ss, Status as background)
Status Duration (hh:mm:ss)

Ewvent Count [#, Status as background)

«

HE a7

Click Preview to display the structure of the report. The data and
background color are for illustration purposes only.

Time Rangel Time Rangel
Event Count (#] Status Duration Event Count (#] Status Duration

KPIY 435 § 20 20:50:00
CI1

KETR 42 13:03:20 77 11:06:40
S KPI1 p i’ 20:00:00 55 09:26:40

KPI2 71 16:06:40 42 23:20:00

5 Create a New Measurement

You want to create a measurement that returns the difference between the
number of events at different times in the selected range.

ﬁ In the Select Measurements page, click the Create Measurement button.
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In the Create Measurement dialog box, enter Event Count Difference in the
Measurement name box, enter a description as shown in the graphics
below, select the Calculated Measurement type, select Difference in the
Select function list, select Time Range (Column headers) in the Select
dimension list, select Event Count (#) (Time Range 1) in the First
Measurement list, select Event Count (#) (Time Range 2) in the Second
measurement list, and click OK.

Enables you to add a calculated or aggregated measurement based on the measurements that are
available after you select the dimensions in the Select Dimensions page.

Measurement name: * Event Count Difference

Measurement description: [goryms the difference between the number of events at

different times in the selected range.

Appears as tooltip
for the measurement

Measurement typs: # Calculated (difference, trend, and so forth)

O Aggregated (custom average, status, and so forth)

Select function: * IDiFference - |

Function Parameters

Select dimension: * ITime Range [Column headers) - |
First measurement: * IE\.rentCount::=} [Time Range 1) - |
Second measurement: * IEventCount::=} [Time Range 2] - |

The function returns the difference between the first selected measurement value and the second
selected measurement value.

The new measurement is displayed in the Selected Measurements box in
the Select Measurements page. You may want to add additional
measurements at this stage.

Click Next to continue.
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Click Preview to display the draft of the report.

Time Rangel Time Range2 Event Count Diffe

Event Count (#] Status Duration Event Count (#] Status Duration

el KPIy 45 WBD 20:50:00 45
KEIE 42 13:03:20 77 11:06:40 35
— KPI1 15 20:00:00 55 09:26:40 40
KPIZ 71 16:06:40 42 23:20:00 -29

Specify the Dimensions Filter

The Mandatory Dimensions area in the Dimensions Filter page, lists the
dimensions you selected (Cl), and the dimensions mapped to the
measurements you selected (Status, Time Range and KPI). Select the
appropriate filter for all the listed dimensions.

For the CI dimension, select the view and the CIs you want to display.

Mandatory Dimensions:

CI

Time Range View: |Business Services
Status

KPI o
E 5% Business Services

‘& amit service
& bs_AutoSanity31
@( bs_AutoSanity32
# bs_Autosanity3s
# bugrreso-1

| o B8]
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For the Time Range dimension, select Time Comparison, Week to date, and
Last 1 Week.

Mandatory Dimensions: Dimension Filter:

CI [ Over Time @ Time Comparison

Time Range I W
o view: [k g = 4[¥]
F [Gsttwesk |

View: |Last =1 [ =] [week =]
o

view: [La=t =1 [r=] [Meneh =]
o

For the Status dimension, select Critical.

Mandatory Dimensions:

CI
Time Range L Bl
Status & ~ Warning
KPI ) Minor
[ n Major
“x Critical
“i Info
€ & o Data
e \sé‘ Downtime

For the KPI dimension, select Availability and Performance.

Mandatory Dimensions:

ClfService Awvailability

Tirme Range Performance
Status Systermn
KPI Application

Bandwidth

Camponent Availability
Custorner

DT Failed Irnpact

DT Late Impack

DT Total Impack
Generic

HP Swstern

e e
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Click Preview to display the structure of the report. The data and
background color are for illustration purposes only.

Availa i e
Rum service A

JAericrmance

I:l.\.railal:rilii:'||r
Sanity

Performance

Availability

=]
2
S4
22
93

L A __ Last 1 Week Week to date Event Count D
| Jvent Count (#] Event Count (#] Event Count (#] Event Count (#]

- IRR—L - T——

2 17 . A

S 7 22 5

B amsmssssnismsaiss 75 78 15

Click Next.

7 Display the Service Report

In the Summary page, the Service Report displays the status and value of the
selected dimensions and measurements:

¥ rRemove empty columns and rows from report

Availability
Rum service

Performance

Availability
Sanity

Performance

Availability
ServiceImpact_#

Performance

Availability
Ziv Test

Performance

Last 1 Week Week to date Event Count D

Event Count (#] Event Count (#] Event Count (#] Event Count (#]

[=TRN S I =T ]

o
o
o
o
1
1
o
o

The data displayed in the table is the correct data for the report and the
background colors represent real status.

Click Finish to close the Service Report configuration.
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P Create a Customized Measurement

You can create a customized measurement that performs an aggregation
(Average, Max, Min, Sum, Best, Worst, Count Status, or Status Percentage) or
performs a calculation (Difference, Difference by percentage, Status, or
Trend) based on selected measurement values. After you create the new
measurement, you can use it in the Service Report Builder like a regular
measurement. For details, see “Create Measurement Dialog Box” on

page 207.

Example - Display the Trend Between Values
To display the trend of each instance of the time interval:

1 Access the Service Report wizard.

In the Select a Data Source page, select SLM - SLA KPI Data and click Next.

3 In the Select Dimensions page, move SLA and CI to the Rows box, Time

Interval to the Columns box, and click Next.
In the Select Measurement page, click the Create Measurement button.

In the Create Measurement dialog box, enter Trend on time interval in the
Measurement name box, select the Calculated Measurement type, select
Trend in the Select function list, select Time Range (column’s header) in the
Select Dimension list, KPI Status (Time Interval 1) in the First Measurement
list, and KPI Status (Time Interval 2) in the Second Measurement list in the
Function Parameters area, and click OK.

Add the KPI Status (as text and background) measurement and move it
before the Trend on time interval measurement.

In the Select Measurement page, click Preview. The preview displays the
trend of the SLAs between two time intervals.

Time Rangel Time Rangel Trend on time intervi

KPI Status KPI Status
€h No Data
SLA1
CI12 Exceeded
CI1 Breached
SLA2
CI2 No Data Ereached

¥

W »

8 You can then adjust the appropriate dimension filters and save the report.
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Example - Display How Far an SLA is From Exceeding Its Target
To display how far the SLA is from exceeding its target:

1 Access the Service Report wizard.

In the Select Data source page, select SLM - SLA KPI Data and click Next.

3 In the Select Dimensions page, move Cl and SLA to the Rows box, Time

Range to the Columns box, and click Next.

In the Select Measurement page, click the Create Measurement button.

5 In the Create Measurement dialog box, enter Diff value from target in the

Measurement name box, select the Calculated Measurement type, select
Difference by percentage in the Select function list, select SLA (row headers)
in the Select Dimension list, KPI Value (SLA 1) in the First Measurement list,
and Deviation From Target (SLA 1) in the Second Measurement list in the
Function Parameters area, and click OK.

In the Select Measurement page, click Preview. The preview displays how far
the SLA is from the exceeded value in percentages.

Time Range1 Time Range?
CIi -69,82 -71.68
SLA1
c1z -60.85 -4, 64
CIl -95.42 -77.08
SLAZ
c1z 62,96 -74.,99

You can also display the measurements (KPI Value, or Deviation From
Target, and Exceeded) on which you base the calculation:

Time Rangel Time Range2 Exceeded
KPI Value Deviation From KPI Value Deviation From

Crl 4 5.01 25 10.10 6.43
SLA1

"B V] 54 3.49 24 16.96 8.05

CI1 36 16.92 &8 5.28 5.25
SLAZ

CIz 5 19.57 i3 i7.61 0.36

8 You can then select the appropriate dimension filters and save the report.
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Example - Fine-Tune SLAs

Instead of adjusting the SLA thresholds in the Service Level Management
application directly, create a Service Report based on the appropriate Service
Level Management data sources, and create a new measurement based on
the Status function. Fine-tune the function thresholds to check the SLA over
a specific time-period until you get the required results. You can then use
those thresholds in the Service Level Management application.

Example - Drill Into SLAs Data

The smallest status duration for an SLA is five minutes. If a customer has
multiple SLAs and you want to see when the objective exceeds 98 you can
create a Service Report with the Status function, and set the threshold to 98.
The report displays the status information and not the real SLA
measurement. The tooltip displays the real name of the calculated
measurement.

Example - Simulate a Tracking Period That Starts and Ends on
Mondays

Usually the tracking period is from the first day of the previous month/week
to the first day of the month/week. You can create a report that provides
information from the third day (Monday) of the previous month/week to
the third day of the month/week.

To simulate a tracking period that starts and ends on Mondays:

1 Access the Service Report wizard.

In the Select Datasource page, select SLM - SLA KPI Data and click Next.

3 In the Select Dimensions page, move Cl to the Rows box, SLA to the

Columns box, and click Next.
In the Select Measurement page, click Create Measurement.

In the Create Measurement dialog box, enter My Average Value in the
Measurement name box, select the Aggregated Measurement type, select
Average in the Select function list, select KPI Value in the Select
measurement list, and click OK.

In the Select Measurement page, the My Average Value measurement is
automatically moved to the Selected Measurements box. Click Next.
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7 In the Select Dimension Filters page:
» For the Cl Mandatory Dimension, select a view, and the appropriate Cls.
» For the SLA Mandatory Dimension, select SLA1 IRD and SLA2 IRD.

» For the Time Ranges Mandatory Dimension, select Over Time, Week
where you select the date to be from the 3rd day to the 3rd day and Every
day. The hour is automatically changed to midnight.

» For the KPIs Mandatory Dimension, select Availability and Performance.
» For the Calendar Mandatory Dimension, select 24x7.

8 Click Finish, OK, and Save.

9 Open My BAC and display the report.

@ Service Report 2]zl gl
w
SLA1 S5LA2
Finance Service 79.20 20.17
HR Service 79.20 20,17

T 10 Click the funnel button to display the report filter. It indicates that the
report starts and ends on Mondays.

Service Report
il

Calendar: 24x7

KPI: Availability , Performance
Selected Time: 2/12/07 12:00 AM - 2/15/07 10:42 PM ArnericafLos Angeles Evary 1 Dayl=)

Measurement: My Auverage Value

@ Service Report User Interface

This section describes:
» Service Report on page 161

» Service Report Builder Wizard on page 162
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@ Service Report

i

Event Count (#)

bs_AutoSanity31, Availability
W bs_AutoSanity31, Performance
B bs_AutoSanity32, Availability
W bs_AutoSanity32, Performance
B bs_AutoSanity33, Availability
W bs_AutoSanity33, Performance
Description Displays the Service Report you configured in a Service
Report portlet in My BAC or as a report in Report
Manager.
To access:
» In My BAC, select the page where the Service Report
portlet is located. The portlet the configured Service
Report.
» Select Applications > User Reports, select the relevant
Service Report, and click
Important The report displays the data and the format selected
Information when creating the report using the Service Report Builder
wizard.
Included in Tasks “Configure a Service Report Portlet in My BAC -
Workflow” on page 142
“Configure a Service Report in Report Manager —
Workflow” on page 147
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Report Settings

The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

il

In My BAC, click the button to display the values of the
dimensions selected in the Dimension Filters page that
are not directly displayed in the report.

<Common report
settings>

For details, see “Common Report Elements” in Reports.

<Dimension filter
elements>

In Report Manager, displays the values of the
dimensions selected in the Dimension Filters page that
are not directly displayed in the report.

@ Service Report Builder Wizard

Description

Enables you to configure a Service Report. You select
the data source on which you want to base the Service
Report data, the dimensions and measurements that
are to appear in the report, and the structure of the
report.

To Access:

» In My BAC, click Launch Service Report Builder in
the Filter area of the Edit Preferences page of a
Service Report portlet.

» In Report Manager, add a Service Report.
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Included in Tasks

“Configure a Service Report Portlet in My BAC -
Workflow” on page 142

“Configure a Service Report in Report Manager —
Workflow” on page 147

Wizard Map

Service Report Builder Wizard includes: Welcome >
Service Report Properties Page > Select Report Type
Page > Select a Data Source Page > Select Dimensions
Page > Select Measurements Page > (Create
Measurement Dialog Box) >(Edit Chart Properties
Dialog Box) > Select the Dimension Filters Page >
Summary Page

Service Report Properties Page

Description Enables you to enter the name and description of the
Service Report.

Important This page is displayed only when you access the Service

Information Report from the Report Manager.

Wizard Map Service Report Builder Wizard includes: Welcome >

Service Report Properties Page > Select Report Type
Page > Select a Data Source Page > Select Dimensions

Page > Select Measurements Page > (Create Measurement
Dialog Box) >(Edit Chart Properties Dialog Box) > Select

the Dimension Filters Page > Summary Page
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The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Report description Enter a description of the report. The description appears
in the list of available reports in the Report Manager.

Report name Enter the name of the report. The name appears in the
list of available reports in the Report Manager.

Mandatory.

When you clone a report in the Report Manager, the
name of the cloned report is automatically changed to
Copy of <cloned_report_name>.

Save report as Select one of the following options:

» Private. Only the report organizer can view the report.

» Public. All users with appropriate permission levels can
view the report. This is the default.

Select Report Type Page

Description Enables you to select the type of format you want to use
to display the report. The report can be displayed as a
table or as a chart.

Wizard Map Service Report Builder Wizard includes: Welcome >
Service Report Properties Page > Select Report Type Page
> Select a Data Source Page > Select Dimensions Page >
Select Measurements Page > (Create Measurement Dialog
Box) >(Edit Chart Properties Dialog Box) > Select the
Dimension Filters Page > Summary Page

164



Chapter 2 e Service Report

The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

with a 3-dimensional look.

Example:

Chart Select this option to display the list of the different charts
available to render the report.
Display 3D Select this option to display the selected chart format

» When you select Pie and Display 3D:

N

Cl/Servicel,
B CI/Servicel
B CI/Service2
B CI/Service2

» When you select Pie, Display 3D, and Flash:

., KPI1
. KPIZ
, KPI1
, KPIZ

Stétus Bercentage (%)

CI/Servicel, KPI1
B CI/Servicel, KPI2
B CI/Service2, KPI1
B CI/Service2, KPI2
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GUI Element (A-Z)

Description

Flash

Select this option to display the selected chart format
using Flash technology.

Note: To display the report using Flash technology, you
must have installed Flash.

Example:

CI/Servicel, KPI1
CI/Servicel, KPI12
CI/Service2, KPI1

/ \ B CI/Service2, KPI2

Note: You can select both Display 3D and Flash. See the
description of the Display 3D option for an example.

Stéhis Percentage (%)

Pie, Bar, Line,
Stacked Bar, Area

Select the type of chart you want to use to display the
report.

Note: You can select Area only if you also select Flash.

Pivot table

Select this option to display the report as a pivot table.
This option is selected by default.

Select a Data Source Page

Description Enables you to select one or more data sources on

which you want to base the Service Report data.
Important You can select more than one data source.
Information

For details on the impact of the data source selection,
see “Dimensions and Measurements” on page 130.

Limitations: See the details in “Troubleshooting and
Limitations” on page 217.
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Wizard Map Service Report Builder Wizard includes: Welcome >
Service Report Properties Page > Select Report Type
Page > Select a Data Source Page > Select Dimensions
Page > Select Measurements Page > (Create
Measurement Dialog Box) >(Edit Chart Properties
Dialog Box) > Select the Dimension Filters Page >
Summary Page

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description
Business Process Select to build the report using data from HP Business
Insight Data Process Insight. For details about the data source

dimensions, measurements, and the relations between
time, see “Business Process Insight Data Dimensions
and Measurements Map” on page 176.

Dashboard KPIs data | Select to build the report using business-related ClIs,
based on historical data from the associated Dashboard
KPIs. For details about the data source dimensions,
measurements, and the relations between time, see
“Dashboard KPIs Data Source Dimensions and
Measurements Map” on page 174.

Over Time Additional | Select to build the report using dimensions and

data measurements, such as Number of tickets and Number
of measurements, from multiple data sources. For
details about the data source dimensions,
measurements, and the relations between time, see
“Over Time Additional Data Dimensions and
Measurements Map” on page 182.

Service Level Select to build the report using CIs, KPIs, SLA
Management - SLA dimensions, and the Time and Calendar
KPI data measurements, from Service Level Management. For

details about the data source dimensions,
measurements, and the relations between time, see
“Dashboard KPIs Data Source Dimensions and
Measurements Map” on page 174.
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GUI Element (A-Z)

Description

Service Level
Management - SLA
Status data

Select to build the report using SLAs, Tracking Period,
and Time dimensions, and SLA Status for Previous
Periods, SLA Current Status, and SLA Current Status By
Time Periods, and SLA Forecast measurements. For
details about the data source dimensions,
measurements, and the relations between time, see
“Service Level Management - SLA Status Data
Dimensions and Measurements Map” on page 172.

TransactionVision
data

Select to build the report using data from

HP TransactionVision. For details about the data source
dimensions, measurements, and the relations between
time, see “HP TransactionVision - Data Dimensions
and Measurements Map” on page 183.

Service Level Management - SLA KPI Data Dimensions and

Measurements Map

The dimensions and measurements map for the SLA KPI data source
includes the following elements:

Dimensions and measurements mapping for the
Service Level Management — SLA KPI data

Legend:

@ dimension

:I measurement
group
Time Range

KPI Value and Status Group measurements
Additional Values Group measurements

Targets measurements
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Depending on the dimensions and measurements you select, make either a
single selection or multiple selection for each dimension’s values. For
details, see “Impact on the Type of Selection: Single Selection or Multiple
Selection” on page 132.

The dimensions are:

GUI Element (A-Z)

Description

Calendar The business-day structure. It can be:
» 24hx7d
» Business Hours
Cl The CI you want to display in the report.
KPI The KPI you want to display in the report.
SLA The Service Level Agreement you want to display in the

report.

Time Range

The time range for which you want to see information.

The measurements are:

» KPI Value and Status Group:

GUI Element (A-Z)

Description

KPI Value

The KPI value.

KPI Value (KPI Status
as background)

The KPI value and the KPI status displayed as the
colored background of the report cell. The KPI status is
calculated according to the objectives.

KPI Status (as text
and background)

The KPI status and the KPI status compared to the
objective displayed as the colored background of the
report cell.

KPI Status

The KPI status.

KPI Status as
background

The KPI status compared to the objectives displayed as
the colored background of the report cell.
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» Targets:

GUI Element (A-Z)

Description

All Targets

The percentage of time the value of the selected KPI
was in the range defined for all targets.

Exceeded (Status as

The percentage of time the value of the selected KPI

background) was in the range defined for the Exceeded target, and
the KPI status as the colored background of the report
cell.

Exceeded The percentage of time the value of the selected KPI
was in the range defined for the Exceeded target.

Met The percentage of time the value of the selected KPI

was in the range defined for the Met target.

Met (Status as
background)

The percentage of time the value of the selected KPI
was in the range defined for the Met target, and the KPI
status as the colored background of the report cell.

Minor Breached

The percentage of time the value of the selected KPI
was in the range defined for the Minor Breached target.

Minor Breached

The percentage of time the value of the selected KPI

(Status as was in the range defined for the Minor Breached target,

background) and the KPI status as the colored background of the
report cell.

Breached The percentage of time the value of the selected KPI

was in the range defined for the Breached target.

Breached (Status as
background)

The percentage of time the value of the selected KPI
was in the range defined for the Breached target, and
the KPI status as the colored background of the report
cell.
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» Additional Values Group:

GUI Element (A-Z) Description

All Additional Values | Select to display all the enabled additional
measurements in the report. For details about
additional values, see “Additional Values in Reports” in
Using Service Level Management.

Note: To modify the default list of enabled additional
values displayed per KPI, select Admin > Platform >
Setup and Maintenance > Infrastructure Settings,
choose Applications, select Service Level Management,
and locate the Additional Values entry in the Service
Level Management - SLM Admin table. Set the value to
true for a KPI and an additional value when you want
to display that additional value parameter for the KPI.
If an additional value is not included for a specific KP]I,
it is not available for that KPI.

Note: The PNR KPI appears in the Additional Values
settings for internal purposes. Do not modify it.
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Service Level Management - SLA Status Data Dimensions
and Measurements Map

The dimensions and measurements map for the SLA Status data source
includes the following elements:

Dimensions and measuraments mapping for the
Service Level Management — SLA Status Data

data source
Legend:
orecast Based on . .
Tracking Period SLA SLA Overall Status C:) dimension
measurement
L] group

SLA Forecast Status Time Ran
SLA Breached Date Ime ~ange

Tracking SLA Historical
Period SLA Statue Status
The dimensions are:
GUI Element (A-Z) Description
Forecast Based On The forecast calculated for the analysis period based on
Tracking Period the assumption that the SLA performs in the future as

it did during this analysis period.

SLA The available SLAs that are defined for your site.

For details on single or multiple selection, see “Impact
on the Type of Selection: Single Selection or Multiple
Selection” on page 132.

Time Range The time range for which you want to see information.

Tracking Period The tracking periods that are used to track agreement
status and compile data. The tracking periods define
the granularity available in Service Level Management
reports.
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GUI Element (A-Z)

Description

Forecast Status (as
text and
background)

The status of the forecast, and the Forecast status
compared to the objective as the colored background
of the report cell.

SLA Breached Date

The SLA breached date from the forecast report.

SLA Forecast Status

The status of the forecast.

SLA Forecast Status
as background

The status of the forecast compared to the objective as
the colored background of the report cell.

SLA Historical Status

The historical status for the selected time range.

SLA Historical Status
(as text and
background)

The value of the Historical Status, and the status
compared to the objective as the colored background
of the report cell.

SLA Historical Status
as background

The Historical Status compared to the objective as the
colored background of the report cell.

SLA Overall Status

The status used to compare to the forecast for a selected
SLA and selected time range.

SLA Overall Status
(as text and
background)

The value of the Overall Status, and the status
compared to the objective as the colored background
of the report cell.

SLA Overall Status as
background

The status of the Overall Status compared to the
objective as the colored background of the report cell.

SLA Status

The current status of the SLA fr the selected time range.

SLA Status (as text
and background)

The value of the Status, and the status compared to the
objective as the colored background of the report cell.

SLA Status as
background

The status compared to the objective as the colored
background of the report cell.

Time Comparison

Enter a label for the dimension in the Label box.

Select the tracking range and granularity for the report.
For details, see “Time Range and Granularity Bar” in
Reports.
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Dashboard KPIs Data Source Dimensions and
Measurements Map

The dimensions and measurements map for the Dashboard KPIs data source
includes the following elements:

Dimensions and Measurements Mapping for the
Dashboard KPIs data source

|:| measurement

cl KPI group

Event Count
Status Percentage
Status Duration

The dimensions are:

GUI Element (A-Z) Description

Cl The configuration item you want to display in the
report.

KPI The KPIs you want to display in the report.

Status The status of the KPI.

Time Range The time range for which you want to see information.
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GUI Element (A-Z)

Description

Event Count (#)

The number of events with the selected status that
occurred in the selected time range.

Event Count (#)
(Status as
background)

The number of events with the selected status that
occurred in the selected time range, and the Status as
the colored background of the report cell. The status
represents the status dimension instance (OK, FAILED,
and so on)

Status Duration
(hh:mm:ss)

The length of time in hours, minutes, and seconds,
during which the KPI had the selected status.

Status Duration
(hh:mm:ss) (Status
as background)

The length of time in hours, minutes, and seconds,
during which the KPI had the selected status, and the
status compared to the objective as the colored
background of the report cell.

Status Percentage
(%)

The length of time during which the KPI had the
selected status divided by the selected time range in
percentage.

Status Percentage
(%) (Status as
background)

The length of time during which the KPI had the
selected status divided by the selected time range in
percentage, and the status compared to the objective as
the colored background of the report cell.
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Business Process Insight Data Dimensions and
Measurements Map

The dimensions and measurements map for the Business Process Insight Data
data source are listed in the tables below.

The dimensions are:

GUI Element (A-Z) Description

Cl The configuration item you want to display in the
report.

Time Range The time range for which you want to see information.

The measurements that are relevant for the type of CI you select in the
Select Dimension Filters page are as follows:

Selected Node CIT /

Measurement Group Applicable measurements Sample Type
Business Process See “Health Measurements Group” bpi_process_t
on page 180

See “Common Measurements
Group” on page 177

BPI Duration | See “Duration Measurements bpi_duration_t
Monitor Group” on page 177

See “Common Measurements
Group” on page 177

Value / See “Value Measurements Group” bpi_value_t
Custom on page 178
See “Common Measurements
Group” on page 177
BPI Business Process See “Common Measurements bpi_step_t

Step Group” on page 177

176



Chapter 2 e Service Report

The measurements are relevant for different types of ClIs. Some
measurements are relevant for all types of Cls. The measurements are
described in the next sections.

Common Measurements Group

Measurement

Description

Avg. Backlog Value

The total value of all currently open instances,
divided by the total number of instances.

Avg. Backlog Count (#)

The number of currently open instances divided by
the total number of instances.

Completed Instances (#)

The sum of all completed instances.

Completed Instances Total
Value

The total value of all completed instances.

Completed Instances Avg.
Value

The total value of all completed instances divided
by the total number of completed instances.

Duration Measurements Group

Measurement

Description

Avg. Duration (sec)

The sum of the duration of all completed instances
divided by the number of completed instances.

Weighted Avg. Duration
(sec)

The sum of the duration of all completed instances,
each multiplied by its weight, and divided by the
number of completed instances.

Min. Duration (sec)

The minimum duration of all completed instances.

Max. Duration (sec)

The maximum duration of all completed instances.

Total Duration Critical
Violated Instances (#)

The total duration of all violated samples that
currently have the Critical status.

Total Duration Critical
Violated Instances (#,
Status as background)

The total duration of all samples that currently have
the Critical status, and the status compared to the
objective as the colored background ofn the report
cell.
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Measurement

Description

Total Duration Major
Violated Instances (#)

The total duration of all samples that currently have
the Maijor status.

Total Duration Major
Violated Instances (#,
Status as background)

The total duration of all samples that currently have
the Major status, and the status compared to the
objective as the colored background of the report
cell.

Total Duration Minor
Violated Instances (#)

The total duration of all violated samples that
currently have the Minor status.

Total Duration Minor
Violated Instances (#,
Status as background)

The total duration of all violated samples that
currently have the Minor status, and the status
compared to the objective as the colored
background of the report cell.

Total Duration Non-
Violated Instances (#)

The total duration of all non-violated samples.

Total Duration Non-
Violated Instances (#,
Status as background)

The total duration of all non-violated samples that
currently have the Minor status, and the status
compared to the objective as the colored
background of the report cell.

Total Duration Warning
Violated Instances (#)

The total duration of all violated samples that
currently have the Warning status.

Total Duration Warning
Violated Instances (#,
Status as background)

The total duration of all violated samples that
currently have the Warning status, and the status
compared to the objective as the colored
background of the report cell.

Value Measurements Group

Measurement

Description

Total Monitor Value

The total value of all samples that were sent during
the specified time period.

Avg. Monitor Value

The total value of all samples that were sent during
the specified time period divided by the number of
currently completed samples.
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Measurement Description
Weighted Avg. Monitor The total value of all samples that were sent during
Value the specified time period, each multiplied by its

weight, divided by the number of currently
completed samples.

Min. Value The minimum value of all samples that were sent
during the specified time period.

Max. Value The maximum value of all samples that were sent
during the specified time period.

Total Value Critical The total value of all violated samples that currently

Violated Instances (#) have the Critical status.

Total Value Critical The total value of all samples that currently have

Violated Instances (#, the Critical status, and the status compared to the

Status as background) objective as the colored background of the report
cell.

Total Value Major Violated | The total value of all samples that currently have
Instances (#) the Maijor status.

Total Value Major Violated | The total value of all samples that currently have

Instances (#, Status as the Maijor status, and the status compared to the
background) objective as the colored background of the report
cell.

Total Value Minor Violated | The total value of all violated samples that currently
Instances (#) have the Minor status.

Total Value Minor Violated | The total value of all violated samples that currently
Instances (#, Status as have the Minor status, and the status compared to
background) the objective as the colored background of the
report cell.

Total Value Non-Violated The total value of all non-violated samples.
Instances (#)

Total Value Non-Violated The total value of all non-violated samples that
Instances (#, Status as currently have the Minor status, and the status
background) compared to the objective as the colored
background of the report cell.
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Measurement

Description

Total Value Warning
Violated Instances (#)

The total value of all violated samples that currently
have the Warning status.

Total Value Warning
Violated Instances (#,
Status as background)

The total value of all violated samples that currently
have the Warning status , and the status compared
to the objective as the colored background of the
report cell.

Health Measurements Group

Measurement

Description

Avg. of Blocked Instances

(#)

The sum of the number of all instances that
currently have the Blocked status, divided by the
total number of instances.

Avg. of Blocked Instances
(#, Status as background)

The sum of the number of all instances that
currently have the Blocked status, divided by the
total number of instances, and the status compared
to the objective as the colored background of the
report cell.

Avg. of Healthy Instances
)

The sum of the number of all instances that
currently have the Healthy status, divided by the
total number of instances.

Avg. of Healthy Instances
(#, Status as background)

The sum of the number of all instances that
currently have the Healthy status, divided by the
total number of instances, and the status compared
to the objective as the colored background of the
report cell.

Avg. of At Risk Instances
(#)

The sum of the number of all instances that
currently have the AtRisk status, divided by the total
number of instances.

Avg. of At Risk Instances
(#, Status as background)

The sum of the number of all instances that
currently have the AtRisk status, divided by the total
number of instances, and the status compared to
the objective as the colored background of the
report cell.
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Measurement Description

Avg. Value of Blocked The total cost of all instances that currently have

Instances the Blocked status, divided by the total number of
instances.

Avg. Value of Blocked The total cost of all instances that currently have

Instances (Status as the Blocked status, divided by the total number of

background) instances, and the status compared to the objective

as the colored background of the report cell.

Avg. Value of Healthy The total cost of all instances that currently have

Instances the Healthy status, divided by the total number of
instances.

Avg. Value of Healthy The total cost of all instances that currently have

Instances (Status as the Healthy status, divided by the total number of

background) instances, and the status compared to the objective

as the colored background of the report cell.

Avg. Value of At Risk The total cost of all instances that currently have

Instances the AtRisk status, divided by the total number of
instances.

Avg. Value of At Risk The total cost of all instances that currently have

Instances (Status as the AtRisk status, divided by the total number of

background) instances, and the status compared to the objective

as the colored background of the report cell.
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Over Time Additional Data Dimensions and
Measurements Map

The dimensions and measurements map for the Over Time Additional Data
data source includes the following elements:

Dimensions and Measurements Mapping for the
Over Time Additional Data data source

Legend:
@ dimension
Cl Time Range measurement

1 gomp

Number of Tickets Number of Users

The dimensions are:

GUI Element (A-Z) Description

Cl The configuration item or service.

Time Range The time range for which you want to see information.
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The measurements are:

GUI Element (A-Z) Description

# of tickets The number of tickets (open incidents) that were
opened with the selected severity during the selected
time period.

To specify the severity, you must first specify the rule
that is used to calculate the number of tickets.

To specify the rule, select Admin > Platform > Setup
and Maintenance > Infrastructure Settings, choose
Applications, select Dashboard Application, and locate
the Number of open Incidents rule entry in the
Dashboard Application - Service Impact table. Enter the
value of the rule you want to use. A list of rules and
rule numbers are available in the Repositories (to access
the Repositories, select Admin > Dashboard >
Repositories > Business Rules.

To specity the severity you want to use, edit the rule’s
properties in the Repositories.

# of users The number of users, calculated by Real User Monitor,
using the specified CI during the selected time period.

HP TransactionVision - Data Dimensions and
Measurements Map

The dimensions and measurements map for the HP TransactionVision data
source includes the following elements:

The data is retrieved from the Business Transaction Monitor monitor
sample. For details about the sample, see “Data Sample for
TransactionVision” in Reference Information.
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The dimensions are:

GUI Element (A-Z)

Description

Cl

The configuration item or service.

Time Range

The time range for which you want to see information.

The measurements are:

GUI Element (A-Z)

Description

Total Volume (#)

The total number of transactions that ran in
HP TransactionVision, in the sample. By default, a
sample represents 5 minutes of data.

Avg. Backlog

The number of transactions that are currently running
in HP TransactionVision, divided by the number of
samples sent during the specified time period. By
default, a sample represents 5 minutes of data.

Avg. Duration (sec)

The sum of the response time of the transactions that
ran in HP TransactionVision, divided by the total
number of transactions, in the sample. By default, a
sample represents 5 minutes of data.

Total Value

The total value of the transactions that ran in
HP TransactionVision, in the sample. By default, a
sample represents 5 minutes of data.

Average Backlog
Value

The total financial value of the transactions that are
currently running in HP TransactionVision, divided by
the number of samples sent during the specified time
period. By default, a sample represents 5 minutes of
data.

Average Value

The average financial value of the transactions that ran
in HP TransactionVision, in the sample. By default, a
sample represents 5 minutes of data.
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GUI Element (A-Z) Description

Average Value of The average financial value of the transactions that

Exceptions accessed HP TransactionVision, with an exception, in
the sample. By default, a sample represents 5 minutes
of data.

A transaction with an exception is a transaction that
did not follow the straight-through process defined by

the user.
Average Value of The average financial value of the transactions that
Delays accessed HP TransactionVision, with delays, in the
sample. By default, a sample represents 5 minutes of
data.
Average Value of The average financial value of failed transactionsin
Failures HP TransactionVision, in the sample. By default, a

sample represents 5 minutes of data.

Transactions are classified as "failed" when they match
the attribute or pattern defined as failure in
HP TransactionVision.

Delays (#) The total number of delayed (late) transactions in
HP TransactionVision, in the sample. By default, a
sample represents 5 minutes of data.

Transactions are classified as "late" when their response
time exceeds the defined threshold in
HP TransactionVision.

Exceptions (#) The total number of transactions that accessed
HP TransactionVision, with exceptions, in the sample.
By default, a sample represents 5 minutes of data.

A transaction with an exception is a transaction that
did not follow the straight-through process defined by
the user.

Failures (#) The total number of failed transactions in
HP TransactionVision, in the sample. By default, a
sample represents 5 minutes of data.

Transactions are classified as "failed" when they match
the attribute or pattern defined as failure in
HP TransactionVision.
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GUI Element (A-Z)

Description

Max. Duration (sec)

The maximum response time of the transactions that
ran in HP TransactionVision in the sample. By default,
a sample represents 5 minutes of data.

Min. Duration (sec)

The minimum response time of the transactions that
ran in HP TransactionVision in the sample. By default,
a sample represents 5 minutes of data.

Value of Exceptions

The total financial value of the transactions that
accessed HP TransactionVision, with an exception, in
the sample. By default, a sample represents 5 minutes
of data.

A transaction with an exception is a transaction that
did not follow the straight-through process defined by
the user.

Value of Delays

The total financial value of delayed (late) transactions
in HP TransactionVision, in the sample. By default, a
sample represents 5 minutes of data.

Transactions are classified as "late" when their response
time exceeds the defined threshold in
HP TransactionVision.

Value of Failures

The total financial value of failed transactions in
HP TransactionVision, in the sample. By default, a
sample represents 5 minutes of data.

Transactions are classified as "failed" when they match
the attribute or pattern defined as failure in
HP TransactionVision.
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Select Dimensions Page

Description

Enables you to select the dimensions you want to
display in the report and whether they are to appear in
a column or a row.

Important
Information

The page displays different information depending on
the type of display you selected in the Select a Report
Display page.

Tips and Tricks: Before using this page, see “Tips and
Tricks” on page 139.

Limitations: See the details in “Troubleshooting and
Limitations” on page 217.

Wizard Map

Service Report Builder Wizard includes: Welcome >
Service Report Properties Page > Select Report Type
Page > Select a Data Source Page > Select Dimensions
Page > Select Measurements Page > (Create
Measurement Dialog Box) >(Edit Chart Properties
Dialog Box) > Select the Dimension Filters Page >
Summary Page

When You Use the Pivot Table Format

Description

The elements listed in the table below are displayed
when you select Pivot table in the Select a Display Type

page.

The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

|

Select a dimension in the Available dimensions area
and click the forward arrow to move the dimension to
the Columns or Rows area.

«|

Select a dimension in the Row or Column area and
click the arrow to move the dimension back to the
Available dimensions area.
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GUI Element (A-Z)

Description

2]~

Change the order of the dimensions in the Columns or
Rows area by clicking the up and down arrows. By
default, the dimensions are listed in alphabetical order.

Available Dimensions

Select the appropriate dimension and select where you
want to put it in the report by clicking the forward
arrow to the Columns or Rows area.

Use the following guidelines to select the dimensions:

» If you select only one dimension and move it to the
Rows (Columns) area, the dimension’s
measurements appear as columns (rows) in the
Service Report.

» If you select two dimensions, it is recommended to
move one dimension to the Rows area and the other
dimension to the Columns area.

» If you select more than two dimensions, there is no
restriction to the location of the dimensions.

Clear

Click to return the dimensions in the Columns or Rows
area back to the Available Dimensions area.
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GUI Element (A-Z)

Description

Enable automatic
preview

You can display a preview of the report by selecting
Enable automatic preview.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed.

Any change made to the top part of the page
automatically generates the preview report.

Note: If, after previewing the page, you clear Enable
automatic preview, the automatic preview feature is
disabled on the next wizard page.

Preview

Click to review the page. The preview shows the report
structure with randomly generated data.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed.

Any change made to the top part of the page
automatically generates the preview report.

Note: The preview report displays randomly generated
data and background color for illustration purposes
only, and, when applicable, two placeholder values for
each selected dimension.
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When You Use the Pie Chart Format

Description The elements listed in the table below are displayed
when you select Pie in the Select a Display Type page.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description
Select a dimension in the Available dimensions area
nd and click the forward arrow to move the dimension to

the Slices area.

Select a dimension in the Slices area and click the
- arrow to move the dimension back to the Available
dimensions area.

Change the order of the dimensions in the Slices area
ﬂ ﬂ by clicking the up and down arrows. By default, the
dimensions are listed in alphabetical order.

<legend> Displays the automatically selected colors that
represent each dimension or combination of
dimensions

Available Dimensions | Lists the dimensions you selected in the Select
Dimensions page.

Clear Click to clear all the selections on the page.
Enable automatic You can display a preview of the report by selecting
preview Enable automatic preview.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed.

Any change made to the top part of the page
automatically generates the preview report.

Note: If, after previewing the page, you clear Enable
automatic preview, the automatic preview feature is
disabled on the next wizard page.
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GUI Element (A-Z) Description

Preview Click to review the page. The preview shows the report
structure with randomly generated data.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed.

Any change made to the top part of the page
automatically generates the preview report.

Note: The preview report displays randomly generated
data and background color for illustration purposes
only, and, when applicable, two placeholder values for
each selected dimension.

Sector Data Mandatory: Move at least one dimension to the Slices
area.

For example, if you move:

» One dimension to the Slices box, each sector of the
pie chart represents a different value of the
dimension.

» More than one dimension to the Slices box, each
sector of the pie chart represents a combination of
the values of each selected dimensions. For example,
if you select dimensions CI and KPI, the pie chart
includes sectors for each group of dimensions as
follows: cil, kpil; cil, kpi2; ci2, kpil; ci2; kpi2.

Cl/Servicel, Time Range..
ClI/Servicel, Time Range...
Cl/Servicel, Time Range...
W Cl/Servicel, Time Range...

Shalls Porbentage ()

® Cl/Service2, Time Range...
B Cl/Service2, Time Range...

® Cl/Service2, Time Range...
C1iSennce? Time Ranae e
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When You Use the Bar Chart Format

Description The elements listed in the table below are displayed
when you select Bar in the Select a Display Type page.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description
Select a dimension in the Available dimensions area
nd and click the forward arrow to move the dimension to

the X-Axis or Series area.

Select a dimension in the X-Axis or Series area and click
ﬂ the arrow to move the dimension back to the Available
dimensions area.

Change the order of the dimensions in the X-Axis or
ﬂ ﬂ Series area by clicking the up and down arrows. By
default, the dimensions are listed in alphabetical order.

<legend> Displays the automatically selected colors that
represent each dimension or combination of
dimensions.

Available Dimensions | Lists the dimensions you selected in the Select
Dimensions page.

Clear Click to clear all the selections on the page.
Enable automatic You can display a preview of the report by selecting
preview Enable automatic preview.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed.

Any change made to the top part of the page
automatically generates the preview report.

Note: If, after previewing the page, you clear Enable
automatic preview, the automatic preview feature is
disabled on the next wizard page.
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GUI Element (A-Z)

Description

Preview

Click to review the page. The preview shows the report
structure with randomly generated data.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed.

Any change made to the top part of the page
automatically generates the preview report.

Note: The preview report displays randomly generated
data and background color for illustration purposes
only, and, when applicable, two placeholder values for
each selected dimension.
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GUI Element (A-Z)

Description

Series

The X-axis marks represents the combinations of all

the values of the dimensions you moved to the X-Axis
box.

For each mark, the group of bars represent the
combinations of all the values of the dimensions you
moved to the Series box.

Example: You moved Cl in the X-Axis box, and KPI and
Status to the Series box. The result is as follows:

* M I“ i i

Cgarvicat CliServicaz CliSarvics 2

onemn,

CliService

KPI1,Sta KPI1,Sta KPI1,Sta.. W KPI1,Sta... M KPIZ2,Sta..
B KPI2,Sta W KPI2,Sta KPI2,Sta.. KPI3,Sta... Show All

Note: If you move dimensions to the Series box, you
can select only one measurement in the Select
Measurements page.
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GUI Element (A-Z)

Description

X-Axis

20
gl
1

4
12
10
2
E
4
2
U

Mandatory: Move at least one dimension to the X-Axis
box.

The X-axis marks represents the combinations of all

the values of the dimensions you moved to the X-Axis
box.

Example: If you move:

» One dimension to the X-Axis box, the values of the
dimension are displayed on the X-axis.

Elfsirvicat

CliService

Status
Percentage

0\\\’
—
CliServicel

» More than one dimension to the X-Axis box, each

combination of the dimensions is represented by
one mark in the X-axis.

ClEervice2

CliService:

KPI1

KPI2

KPI3 " k4 |
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When You Use the Line/Stacked Bar/Area Chart Formats

Description The elements listed in the table below are displayed
when you select Line/Stacked Bar/Area in the Select a

Display Type page.

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description
Select a dimension in the Available dimensions area
nd and click the forward arrow to move the dimension to

the X-Axis or Series area.

Select a dimension in the X-Axis or Series area and click
ﬂ the arrow to move the dimension back to the Available

dimensions area.

Change the order of the dimensions in the X-Axis or
ﬂ ﬂ Series area by clicking the up and down arrows. By

default, the dimensions are listed in alphabetical order.
<legend> Displays the automatically selected colors that

represent each dimension or combination of

dimensions

Available Dimensions | Lists the dimensions you selected in the Select
Dimensions page.

Clear Click to clear all the selections on the page.
Enable automatic You can display a preview of the report by selecting
preview Enable automatic preview.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed.

Any change made to the top part of the page
automatically generates the preview report.

Note: If, after previewing the page, you clear Enable
automatic preview, the automatic preview feature is
disabled on the next wizard page.
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GUI Element (A-Z)

Description

Preview

Click to review the page. The preview shows the report
structure with randomly generated data.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed.

Any change made to the top part of the page
automatically generates the preview report.

Note: The preview report displays randomly generated
data and background color for illustration purposes
only, and, when applicable, two placeholder values for
each selected dimension.
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GUI Element (A-Z)

Description

Series

The X-axis marks represents the combinations of all
the values of the dimensions you moved to the X-Axis
box.

For each mark, the group of bars represent the
combinations of all the values of the dimensions you
moved to the Series box.

Example: You moved Cl in the X-Axis box and KPI and
Status to the Series box. The result is as follows, for a
line chart:

CliService

KPI1,5ta... KPI1,5ta... KPI1,5ta... ® KPI1,Sta... W KPI2,Sta...
W KPI2,Sta.. B KPI2,Sta.. KPI2,Sta... KP13,Sta Show All...

Note: If you move dimensions to the Series box, you
can select only one measurement in the Select
Measurements page.
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GUI Element (A-Z)

Description

X-Axis

Mandatory: Move at least one dimension to the X-Axis
box.

The X-axis marks represents the combinations of all
the values of the dimensions you moved to the X-Axis
box.

Example: If you move:

» One dimension to the X-Axis box, the values of the
dimension are displayed on the X-axis.

S

cUgerviget CliSarvica2 CUServicas CliSarvicad

CliService

Status
Percentage

» More than one dimension to the X-Axis box, each
combination of the dimensions is represented by
one mark in the X-axis.

Cliservice, KPI

Time Time Time B Time
Rangel Range2 Range3 Range4
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Select Measurements Page

Description Enables you to select the measurements you want to
display in the report and whether they should appear
in rows or columns.

The measurements that are listed in the Available
Measurements area depend on the dimensions you
selected in the Dimensions Selection page. For details,
see “Dimensions and Measurements” on page 130.

Important You must select at least one measurement.

Information The dimensions and measurements of each application

are mapped differently. For details, see “Dimensions
and Measurements” on page 130 or “Select the
Dimension Filters Page” on page 203.

Tips and Tricks: Before using this page, see “Tips and
Tricks” on page 139.

Limitations: See the details in “Troubleshooting and
Limitations” on page 217.

Wizard Map Service Report Builder Wizard includes: Welcome >
Service Report Properties Page > Select Report Type
Page > Select a Data Source Page > Select Dimensions
Page > Select Measurements Page > (Create
Measurement Dialog Box) > (Edit Chart Properties
Dialog Box) > Select the Dimension Filters Page >
Summary Page

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description
- Select a measurement in the Available Measurements
J area to move the measurement to the Selected

Measurements area.

Select a measurement in the Selected Measurements
ﬂ area and click to move the measurement back to the
Available Measurements area.
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GUI Element (A-Z) Description
e Click to create a customized measurement in the
bl Create Measurement dialog box. For details, see

“Create Measurement Dialog Box” on page 207.

See limitations in “Troubleshooting and Limitations”
on page 217.

Select a customized measurement and click to edit the
@ measurement in the Create Measurement dialog box.
For details, see “Create Measurement Dialog Box” on
page 207.

Click to open the Edit Chart Properties dialog box. For
details, see “Edit Chart Properties Dialog Box” on
page 213.

Note: This button is not available for Pie charts.

Change the order of the measurements in the Selected
ﬂ ﬂ Measurements area by clicking the up and down
arrows. By default, the measurements are listed in
alphabetical order.

Available Select the appropriate measurement and click the right
Measurements arrow to move the measurement to the Selected
Measurements area.

Clear Click to clear all the selections on the page.
Enable automatic You can display a preview of the report by selecting
preview Enable automatic preview. When you edit an existing

Service Report, Enable automatic preview is
automatically selected and the Preview button is
dimmed. Any change made to the top part of the page
automatically generates the preview report.

Note: If, after previewing the page, you clear Enable
automatic preview, the automatic preview is disabled
on the next wizard page.
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GUI Element (A-Z)

Description

Preview

Click to review the page. The preview shows the report
structure with the column and row headers; it does not
display data.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed. Any change made to the
top part of the page automatically generates the
preview report.

Note:

» The preview report displays randomly generated
data and background color for illustration purposes
only, and two placeholder values for each selected
dimension and measurement.

» The preview box displays a chart that represents all
the possible combinations of the selected
dimensions displayed for each measurement that
you select.

Selected
Measurements

The list of measurements you have selected.

Note: For some measurements (like Value, or Status),
select where you want the measurements to be
displayed in the report by selecting As column headers
or As row headers. For details, see “Dimensions and
Measurements” on page 130.

Limitation: You cannot select both a regular
measurement and a measurement with a background
at the same time when selecting to display a Service
Report as a Chart.
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Select the Dimension Filters Page

Description

Enables you to filter the dimensions you want to
display in the report.

Important
Information

» The Available Dimensions area lists both:

» The dimensions you selected in the Dimensions
Selection page

» The dimensions related to the measurements you

selected in the Measurement Selection page
according to the application’s dimensions and
measurements map.

For details, see “Dimensions and Measurements” on

page 130.

» You must select at least one dimension filters for
each dimension listed in the Available Dimension
Filters area. Depending on the links between the
dimensions and measurements you selected in the

previous pages of the wizard, you can select a single

value or multiple values for the dimension. For

details, see “Impact on the Type of Selection: Single

Selection or Multiple Selection” on page 132.

» The dimensions and measurements of each data
source are mapped differently. For details, see the
dimensions and measurement maps for each data

source in “Impact of the Dimensions/Measurement

Selection on the Report Structure” on page 132.
Tips and Tricks: Before using this page, see “Tips and
Tricks” on page 139.

Limitations: See the details in “Troubleshooting and
Limitations” on page 217.

Wizard Map

Service Report Builder Wizard includes: Welcome >
Service Report Properties Page > Select Report Type
Page > Select a Data Source Page > Select Dimensions
Page > Select Measurements Page > (Create
Measurement Dialog Box) > (Edit Chart Properties
Dialog Box) > Select the Dimension Filters Page >
Summary Page
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The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Available Dimensions | Select a dimension in the list.
Filters

Clear Click to clear all selections.
Dimensions Filter Select the required dimension filter.

Select only two values for dimensions that are used as a
base for calculated functions. If you select one value, or
more than two values, an error message is displayed.

For additional information, see “Impact on the Type of
Selection: Single Selection or Multiple Selection” on
page 132.

Note: When working with the Business Process Insight
data source, select the measurements that are
appropriate for the type of CI you select in the Select
Dimension Filters. If the measurements you select have
no connection with the type of CI you select, the
report is empty or the data is meaningless for monitor
ClIs or partial for non-monitor CIs. For details about the
available measurements, see “Business Process Insight
Data Dimensions and Measurements Map” on

page 176.
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GUI Element (A-Z)

Description

Enable automatic
preview

You can display a preview of the report by selecting
Enable automatic preview.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed.

Any change made to the top part of the page
automatically generates the preview report.

Note: If, after previewing the page, you clear Enable
automatic preview, the automatic preview is disabled
on the next wizard page.

Preview

Click to review the page. The preview shows the report
structure with the column and row headers; it does not
display data.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed.

Any change made to the top part of the page
automatically generates the preview report.

Note: The preview report displays randomly generated
data and background color for illustration purposes
only, and two placeholder values for each selected
dimension.
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Summary Page

Description Displays the report you have created with real data and
real background color.

Important For more information, see “Edit Preferences
Information <portlet_name> Dialog Box” on page 75.
Wizard Map Service Report Builder Wizard includes: Welcome >

Service Report Properties Page > Select Report Type
Page > Select a Data Source Page > Select Dimensions
Page > Select Measurements Page > (Create
Measurement Dialog Box) > (Edit Chart Properties
Dialog Box) > Select the Dimension Filters Page >
Summary Page

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

In My BAC, click the button to display the values of
the dimensions selected in the Dimension Filters page
that are not directly displayed in the report.

\Til

<Common report For details, see “Common Report Elements” in Reports.
settings>

<Dimension filter In Report Manager, displays the values of the
elements> dimensions selected in the Dimension Filters page that

are not directly displayed in the report.

Remove empty In My BAC, select to remove, from the report, the
columns and rows columns and rows that do not have data.

from report Note: When you create a Service Report, you can

choose components that are not necessarily related to

other components in the report, therefore some results
of the Service Report may be blank when the report is

generated.

Note: This option is disabled when you select the Chart
display type for the report.
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Create Measurement Dialog Box

Description Enables you to add a calculated or aggregated
measurement based on the measurements you selected
in the Select Measurements page.

To Access: Click New Measurement in the Select
Measurements page in the Service Report Builder

wizard.
Important After you create a new measurement, you are returned
Information to the Select Measurements page where the new

measurement is automatically moved to the Select
Measurements box. Any measurements you selected
before you created the new measurement is discarded,
unless you validated the selection (by clicking the Next
or Back button).

If you want to delete a measurement you created, move
it back to the Available Measurements box. When you
click Finish, new measurements located in the Available
Measurements box (they are not in use) are
automatically deleted.

Note: When you select to display a Service Report with
the Charts format, you can create only Aggregated
measurements; you cannot create Calculated
measurements.

Limitations: See the details in “Troubleshooting and
Limitations” on page 217.

Included in Tasks “Configure a Service Report Portlet in My BAC -
Workflow” on page 142

“Create a Customized Measurement” on page 157
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The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description
Measurement The description of the measurement you are creating.
description Note: The description of the measurement appears as a

tooltip when you move the mouse over the
measurement in the Select Measurements page.

Measurement name The name of the measurement you are creating.

Note: * indicates that the field is compulsory.

Measurement type Select one of the following:

» Calculated to use a calculated function.
» Aggregated to use an aggregated function.

Select function Select the appropriate function. For details, see
“Calculated Functions” on page 208 or “Aggregated
Functions” on page 209.

Calculated Functions

Important The Calculated Functions option is disabled when you
Information select to display the Service Report as a Chart.

The following calculated functions are available:

Function (A-Z) Description

Difference Returns the difference between the measurements
selected in the First measurement list and the Second
measurement list.
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Function (A-Z) Description
Difference by Returns the difference between the measurements
percentage selected in the First measurement list and the Second

measurement list, divided by the measurement
selected in the Second measurement list, and
multiplied by 100 (the result is in percentages).

Note: If the source measurement value is 0, and the
target value is not O, the function cannot calculate the
difference, and the calculation result is "-". For
example: the difference by percentage of 97 from O is

n_n

Percentage Returns the percentage of the selected First
measurement value relative to the selected Second
measurement value.

Status Compares the value of the measurement selected in
Compare measurement box with the specified
thresholds and returns a color. For more details, see
“Status Function Automatic Measurements” on
page 137.

Trend Returns the trend between the measurements selected
in the First measurement list and the Second
measurement list. The trend is indicated in the final
report, using up 4. , down ¥ , or no change arrow
<= . For details, see “My BAC Page” on page 98.

Aggregated Functions

The following aggregated functions are available:

Function (A-Z) Description

Average Returns the average of the values of the measurement
you select in the Select measurement list.

Best Available only for status measurement types. Returns

Note: This function is irrelevant when you select to
display the Service Report as a Chart.

the best status of all the selected measurement statuses.
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Function (A-Z)

Description

Count Status

Available only for status measurement types. Returns
the number of times the status has the value selected in
the Select measurement instance during the selected
period of time.

Note: This function is irrelevant when you select to
display the Service Report as a Chart.

Max Returns the highest value of the measurement you
select in the Select measurement list.
Min Returns the lowest value of the measurement you select

in the Select measurement list.

Status Percentage

Available only for status measurement types. Returns
the percentage of the status with the value selected in
the Select measurement instance.

Note: This function is irrelevant when you select to
display the Service Report as a Chart.

Sum Returns the sum of the values of the measurement you
select in the Select measurement list.
Worst Available only for status measurement types. Returns

the worst status of all the selected measurement
statuses.

Note: This function is irrelevant when you select to
display the Service Report as a Chart.
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Function Parameters

Important Function Parameters are disabled when you select to
Information display the Service Report as a Chart.

The following function parameters are available:

GUI Element (A-Z) Description
Compare Displayed when you create a Status calculated
measurement function.

Select the measurement you want to compare with the
thresholds you specify in To Threshold.

Create measurement | Displayed when you create a Status calculated
function.

Select one of the measurements that is automatically
created when you create a Status calculated function.
For details about those measurements, see “Status
Function Automatic Measurements” on page 137.
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GUI Element (A-Z)

Description

First measurement

Displayed when you create a calculated function.

Select the first measurement to be used in the
calculation.

Note: When you create a calculated measurement, the
names of the measurement in the First measurement
and Second measurement lists are followed by an
expression between parenthesis. For example, Event
Count (Status 1) represents the instance of the
measurement in the report. When the report including
real data is displayed, the calculation occurs between
the first instance of the measurement and the second
instance of the measurement (or vice versa) according
to your selection.

You can perform calculations between:

» Two different instances of the same measurement.
You can select only two instances (values) of the
dimension on which you base the calculation in the
Select Dimensions Filter page.

» Different measurements. There is no limitation in
the number of instances.

Note: When you select to display a dimension in a
specific location (rows or columns), any calculated
measurement based on that dimension and other
selected measurements must also be displayed in the
same location.

Second
measurement

Displayed when you create a calculated function.

Select the second measurement to be used in the
calculation.

For more information, see “First measurement” on
page 212.

Select dimension

Displayed when you create a calculated function.

Select the dimension on which you want to perform
the selected function.
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GUI Element (A-Z)

Description

Select measurement

Displayed when you create an aggregated function.

Select the measurement on which you want to perform
the selected function.

Selected
measurement
instance

Displayed when you create a Count Status or a Status
Percentage aggregated function.

Select: Failed, Breached, Minor Breached, Met,
Exceeded, No Data, or Downtime.

To thresholds

Displayed when you create a Status calculated
function.

Enter the threshold values and select the operator to
specify the status displayed when the comparison
between the value of the measurement you selected in
the Compare measurement list complies with the
thresholds.

Note: The threshold definitions depend on the data
source you selected in the Select a Data Source page.

¥ Edit Chart Properties Dialog Box

Description

Enables you to specify the target lines you want to
display in the Service Report and the scale of the Y-axis.

Note: The capabilities offered in this dialog box are not
available for Pie charts.

To Access: Click Edit Chart Properties in the Select
Measurements page in the Service Report Builder
wizard.

Target Lines Area

The following elements are included (unlabeled GUI elements are shown in

angle brackets):

GUI Element (A-Z)

Description

Add

Click Add to add a label to the list of labels in the table.
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GUI Element (A-Z)

Description

Target Line Type
Manual

Enter the following information:

» Label. The name of the target line. The name of the
target line appears in the chart legend.

» Value. The value of the target line. It indicates the
position of the target line on the Y-axis. The value
appears in a tooltip when you move the mouse over
the target line.

» Color. Select one of the colors (Red, Orange, Yellow,
Khaki, Green, or Black). A line with the selected
color appears next to the target line label in the
chart legend.

Note:

» When two and more labels have the same value but
different colors, the corresponding target lines are
displayed one over the other and the legend displays
each colored line and its label.

» When two or more labels have the same value and
the same color, the legend displays the colored line
followed by the label names separated by slashes (/).




Chapter 2 e Service Report

GUI Element (A-Z) Description

Target Line Type Select one of the measurements in the list. The
Measurement based measurements listed in the box are the measurements
that are not dependant on the dimensions you moved
to the X-Axis box in the Select dimensions page (if all
the measurements available depend on the dimension
you moved to the X-Axis, this option is disabled).

The color of the labels corresponding to regular
measurements (without background) is black. The
color of the labels corresponding to measurements
with background is the color of the background.

Note:

» When two and more labels have the same value but
different colors, the corresponding target lines are
displayed one over the other and the legend displays
each colored line and its label.

» When two or more labels have the same value and
the same color, the legend displays the colored line
followed by the label names separated by slashes (/).

Update Select a label in the table, make the appropriate
changes, and click Update to update the changes.

Note: You can select more than one label in the table,
but you cannot edit more than one label at a time.

Table Area

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Color The color of the target line. A colored line appears next
to the target line label in the chart legend.
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GUI Element (A-Z) Description
Label The name of the target line as it appears in the chart
legend.

The labels are listed in chronological order.

Value The value of the target line. It indicates the position of
the target line on the Y-axis. The value appears in a
tooltip when you move the mouse over the target line.

Scaling Area

The following elements are included (unlabeled GUI elements are shown in
angle brackets):

GUI Element (A-Z) Description

Auto Scale The scale of the Y-axis is evenly distributed between
the minimum and maximum values of the
measurements selected in the Select Measurement

page.
Start Chart at 0 The minimum value on the Y-axis is O and the
maximum value is the maximum value of the
measurements selected in the Select Measurement
page.
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Q, Troubleshooting and Limitations
This section includes the Service Report troubleshooting and limitations.
When creating a Service Report, the following limitations apply:

» General:

» If you are editing a Service Report and you change the data source of the
report, you cannot perform a Clear operation in the Select Dimensions or
the Select Measurement page. Clicking Clear issues an error message.

> Select a Data Source page:

> You cannot use both the Business Process Insight data and the
TransactionVision data data sources.

» You can only use the Service Level Management - SLA Status data data
source with the Service Level Management - SLA KPI data data source.

> Select Dimensions page:

» It is not recommended to move two or more than two elements in the
Rows box, and none to the Columns box in the Select Dimensions page,
or vice-versa. It is recommended to move at least one element in the
Columns box and one in the Rows box.

> Select Measurements page:

» When you select measurements from different measurement groups, the
order of the measurements in the report and in the preview is different
from the selected order. For example: if you select: Value, Targets - All,
and Status, the order of the measurements in the report is: Value, Status,
Targets - All. For details about the measurement groups, see the maps
described in “Impact of the Dimensions/Measurement Selection on the
Report Structure” on page 132.

> You cannot combine, in a report, an aggregated measurement with
calculated measurements, or an aggregated measurement with regular
measurements.

» When you select the Line/Bar/Stacked Bar/Area chart type, and you do
not move a dimension to the Series box in the Select Dimensions page,
you can select more than one measurement in the Select Measurements

page.
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» When you select the Line/Bar/Stacked Bar/Area chart type and two

measurements, the left Y-axis displays the first selected measurement
scale and the right Y-axis displays the second selected measurement scale
if the measurement units are different.

When you select the Line/Bar/Stacked Bar/Area chart type and more
than two measurements, a Line/Bar/Stacked Bar/Area chart is displayed
for each measurement separately.

When you use a Pie chart and you select several measurements , the
report displays a separate pie chart corresponding for each selected
measurement.

» Creating New Measurements:

» If you select all the available dimensions in the Select Dimensions page,

you cannot create a new aggregated measurement. For details about
creating aggregated measurements, see “Create Measurement Dialog
Box” on page 207.

You cannot create a measurement that already exists and give it a
different name.

» You cannot create different measurements with the same name.

» It is not recommended to create a calculated measurement whose

dimensions appear in both the Rows and Columns boxes in the Select
Dimensions page. For example, if you create a Diff calculated
measurement based on the KPI Value and the Targets - Met
measurements, the Cl, SLA, and KPI dimensions participate in the
calculation. It is recommended to move at least one of those dimensions
in the Rows box if the other dimensions are in the Column box or vice-
versa, so the report has the following structure:

CI/Service 1 CI/ Service?
Time Range 1 Tl -8.35
KPI1
Time Range2 4,75 -0.57
SLA1 v
Time Rangel 4,79 -1l6.64
KPLE
Time Range2 5,36 -17.98
Time Range 1 -8.00 6.10
KPI1
Time Range2 -6 0,32
SLRZ
Time Rangel =387 9,05
KPI2
Time Range2 15.91 15.57
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» Select Dimension Filters page:

» In the Select Dimension Filters page, the automatic preview is activated
only after you move to another dimension in the Mandatory Dimensions
list.

» In the Select Dimension Filters page, the automatic preview displays an
error message even when you have selected CIs. Click the Preview button
or move to another dimension in the Mandatory Dimensions list to
activate the preview feature.
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